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CHƯƠNG 1 

Giíi thiÖu chung vÒ Autodesk Inventor 

Autodesk Inventor lµ phÇn mÒm CAD øng dông trong thiÕt kÕ c¬ khÝ víi 

nhiÒu kh¶ n¨ng m¹nh trong thiÕt kÕ m« h×nh Solid, cã giao diÖn ngêi dïng thuËn 

tiÖn vµ trùc quan. 

Ch¬ng nµy cung cÊp c¸i nh×n tæng quan vÒ m«i trêng thiÕt kÕ vµ c¸c chøc 

n¨ng c¬ b¶n cña Autodesk Inventor. 

1.1. Tæng quan vÒ Autodesk Inventor vµ vÒ tµi  liÖu 

CÊu tróc hÖ thèng cña Autodesk Inventor t¹o ra thÕ m¹nh vÒ thiÕt kÕ m« h×nh 

3D, qu¶n lý th«ng tin, hîp t¸c thiÕt kÕ vµ hç trî kü thuËt. Mét sè ®iÓm m¹nh trong 

cÊu tróc hÖ thèng nµy lµ: 

- ThiÕt kÕ m¹ch l¹c, sö dông c«ng nghÖ ph¸t triÓn th«ng dông (nh COM vµ 

VBA). 

- T¬ng tÝch víi phÇn cøng hiÖn ®¹i, nh Card OpenGL vµ Dual  Processors. 

- Cã kh¶ n¨ng xö lý hµng ngµn chi tiÕt vµ c¸c côm l¾p lín. 

- Cung cÊp giao diÖn lËp tr×nh øng dông (Application Program Interface - API) 

vµ cÊu tróc më réng víi c«ng nghÖ COM chuÈn ®Ó t¹o lËp vµ ch¹y c¸c øng dông thø 

ba (Third-party applications). 

- Cã kh¶ n¨ng trao ®æi trùc tiÕp d÷ liÖu thiÕt kÕ víi b¶n vÏ 2D cña AutoCAD
®
, 

m« h×nh 3D cña Mechanical Desktop
®
 hoÆc m« h×nh STEP tõ c¸c hÖ thèng CAD 

kh¸c. 

Autodesk Inventor cÇn cho ai? Autodesk Inventor lµ c«ng cô t¹o m« h×nh solid, 

híng ®èi tîng (Feature-Based1), dïng cho c¸c nhµ thiÕt kÕ thiÕt kÕ c¬ khÝ trong 

m«i trêng 3D. 

                                            
1 Trong c¸c phÇn mÒm CAD 3D, nh Autodesk Mechanical Desktop, Autodesk Inventor 

chóng ta gÆp 3 lo¹i Feature: 

- Sketched Feature lµ ®èi tîng cÊu thµnh chi tiÕt (Part) ®îc t¹o tõ ph¸c häa (Sketch); 

- Placed Feature còng lµ ®èi tîng cÊu thµnh chi tiÕt, nhng ®îc t¹o b»ng c¸c c«ng cô riªng, 

nh lç, ren, v¸t mÐp, vª gãc,... 

- Work Feature lµ c¸c ®èi tîng h×nh häc bæ trî, nh bÓ mÆt, ®êng trôc, ®iÓm mµ ngêi ta 

dùa vµo ®ã ®Ó ®Þnh vÞ, t¹o lËp c¸c ®èi tîng kh¸c. 

Nãi chung, theo tr×nh tù h×nh thµnh c¸c ®èi tîng trong m« h×nh, ta cã Sketch -> Feature -> 

Part -> Sub Assembly -> Assembly. Trong tµi liÖu nµy, chóng cã thÓ ®îc dÞch lµ Ph¸c häa -> §èi 

tîng -> Chi tiÕt -> Côm l¾p con -> Côm l¾p hoÆc ®îc gi÷ nguyªn tõ gèc. "§èi tîng" ë ®©y kh¸c 

víi "Entity" trong AutoCAD. 
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Néi dung cña tµi liÖu: Tµi liÖu nµy cung cÊp th«ng tin vÒ m«i trêng thiÕt kÕ 

cña Autodesk Inventor theo nhiÒu møc, tõ c¬ së ®Õn n©ng cao, ph©n thµnh c¸c 

ch¬ng theo tõng chuyªn ®Ò. Mçi ch¬ng ®Òu cung cÊp c¸c lo¹i th«ng tin sau: 

- C¸c tiÖn Ých: LiÖt kª c¸c tiÖn Ých ®Æc trng cña ch¬ng. 

- Tr×nh tù lµm viÖc: Kh¸i qu¸t c¸c bíc vµ tr×nh tù sö dông c¸c c«ng cô mét 

c¸ch hiÖu qu¶. 

- C¸c phÝm vµ ký hiÖu: B¶ng kª vµ gi¶i thÝch c¸c phÝm vµ ký hiÖu ®Æc trng 

cho mçi ch¬ng. 

- MÑo: MÑo ®Ó thùc hiÖn c«ng viÖc nhanh vµ th«ng minh. 

1.2. C¸c tiÖn Ých 

Díi ®©y lµ tæng quan vÒ mét sè tiÖn Ých dïng trong t¹o m« h×nh, qu¶n lý tµi liÖu, 

c«ng cô hç trî vµ häc tËp. 

1.2.1. TiÖn Ých t¹o m« h×nh 

Kh«ng gièng nh c¸c c«ng cô t¹o m« h×nh solid truyÒn thèng kh¸c, Autodesk 

Inventor ®îc ph¸t triÓn chuyªn cho thiÕt kÕ c¬ khÝ. Nã cung cÊp nh÷ng c«ng cô 

thuËn tiÖn cho thiÕt kÕ m« h×nh chi tiÕt. 

- Derived Parts: T¹o mét chi tiÕt dÉn xuÊt tõ mét chi tiÕt kh¸c. Dïng Derived 

Parts ®Ó kh¶o s¸t c¸c b¶n thiÕt kÕ hay c¸c qu¸ tr×nh s¶n xuÊt kh¸c nhau. 

Xem ch¬ng, 4 "M« h×nh chi tiÕt". 

- Solid modeling: T¹o c¸c ®èi tîng h×nh häc phøc hîp b»ng kh¶ n¨ng t¹o m« 

h×nh lai, tÝch hîp c¸c bÒ mÆt víi c¸c Solid. Autodesk Inventor sö dông c«ng 

cô m« h×nh hãa h×nh häc míi nhÊt ACISTM. Xem ch¬ng 4, "M« h×nh chi 

tiÕt". 

- Sheet Metal: T¹o c¸c ®èi tîng vµ chi tiÕt tõ kim lo¹i tÊm b»ng c¸ch sö dông 

c¸c c«ng cô t¹o m« h×nh chi tiÕt vµ c¸c c«ng cô chuyªn cho thiÕt kÕ chi tiÕt tõ 

kim lo¹i tÊm, nh uèn (Bend), viÒn mÐp (Hem), gê (Flange), mÉu ph¼ng (flat 

pattern). Xem ch¬ng 6 "ThiÕt kÕ chi tiÕt tõ kim lo¹i tÊm". 

- Adaptive Layout: Dïng c¸c Work Feature (mÆt, trôc, ®iÓm) ®Ó l¾p c¸c "chi 

tiÕt" 2D víi nhau. Nã cã thÓ ®îc dïng ®Ó kh¶o s¸t vµ hîp lý hãa côm l¾p 

tríc khi chÝnh thøc chuyÓn thµnh m« h×nh 3D. Xem ch¬ng 7 "L¾p r¸p". 

- Adaptive parts and assemblies: T¹o c¸c chi tiÕt vµ c¸c mèi l¾p thÝch nghi. 

Chi tiÕt thÝch nghi cã thÓ thay ®æi theo chi tiÕt kh¸c. Ta cã thÓ chØnh söa c¸c 

chi tiÕt ë bÊt kú vÞ trÝ nµo trªn m« h×nh vµ theo bÊt kú thø tù nµo chø kh«ng 

nhÊt thiÕt ph¶i theo thø tù t¹o lËp ban ®Çu. Xem ch¬ng 7 "L¾p r¸p". 

- Design Elements: Truy cËp vµ lu tr÷ c¸c ®èi tîng trong mét Catalog ®iÖn 

tö  ®Ó cã thÓ sö dông l¹i ®îc. Cã thÓ ®Þnh vÞ, chØnh söa chóng. Xem ch¬ng 

8 "C¸c phÇn tö thiÕt kÕ". 
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- Collaborative engineering: M«i trêng cho nhãm cã nhiÒu ngêi cïng lµm 

viÖc víi mét côm l¾p. Nã cho phÐp gi¶m thêi gian thiÕt kÕ mµ kh«ng cÇn h¹n 

chÕ n¨ng lùc lµm viÖc cña mçi c¸ nh©n. Xem ch¬ng 11 "Hîp t¸c thiÕt kÕ". 

1.2.2. TiÖn Ých qu¶n lý th«ng tin 

T¹o m« h×nh míi chØ lµ b¾t ®Çu qu¸ tr×nh thiÕt kÕ. Autodesk Inventor cßn cung 

cÊp c¸c c«ng cô giao tiÕp hiÖu qu¶. 

- Projects: Duy tr× sù liªn kÕt gi÷a c¸c files. Tæ chøc c¸c files tríc khi thiÕt kÕ, 

sao cho Autodesk Inventor x¸c ®Þnh ®êng dÉn cña c¸c files vµ cã thÓ tham 

chiÕu ®Õn c¸c file ®ã vµ c¸c file mµ chóng tham chiÕu ®Õn. Xem ch¬ng 11 

"File ®Ò ¸n". 

- Qu¶n lý b¶n vÏ: Cho phÐp t¹o c¸c b¶n vÏ nhê c¸c c«ng cô ®¬n gi¶n hãa qu¸ 

tr×nh. C¸c b¶n vÏ ®îc t¹o vµ qu¶n lý theo c¸c tiªu chuÈn ANSI, BSI, DIN, 

GB, ISO, JIS , kÓ c¶ c¸c tiªu chuÈn riªng cña h·ng. Xem ch¬ng 10 "B¶n 

vÏ". 

- Design Assistant: T×m kiÕm chi tiÕt theo c¸c thuéc tÝnh nh: m· sè chi tiÕt, 

vËt liÖu,… T¹o b¸o biÓu trong vµ ngoµi m«i trêng Autodesk Inventor. Xem 

ch¬ng 11 "Hîp t¸c thiÕt kÕ". 

- Engineer's Notebook: Truy cËp vµ ghi chó th«ng tin thiÕt kÕ vµ g¾n víi c¸c 

®èi tîng, cho phÐp lu gi÷ th«ng tin vÒ qu¸ tr×nh thiÕt kÕ. Xem ch¬ng 11 

"Hîp t¸c thiÕt kÕ". 

1.2.3. HÖ thèng hç trî ngêi dïng 

Autodesk Inventor cã mét hÖ thèng hç trî ngêi dïng phong phó, tiÖn lîi vµ 

hiÖu qu¶. HÖ thèng nµy ®îc nhóng trùc tiÕp trong Autodesk Inventor, gióp cho viÖc 

truy cËp nhanh chãng. Chóng gåm: 

- HÖ thèng hç trî ngêi dïng (Design Support System - DSS): Mét hÖ thèng 

lín, cho phÐp ®¹t ®îc "day-one productivity" trong thiÕt kÕ. 

- Web: Tõ DSS cã thÓ liªn kÕt víi Autodesk Point A vµ RedSpark ®Ó t×m th«ng 

tin bæ sung trªn Web, liªn kÕt víi Site cña c¸c nhµ cung cÊp,... 

- Autodesk Online: Download phiªn b¶n cËp nhËt cña Autodesk Inventor vµ 

t×m th«ng tin vÒ s¶n phÈm, hç trî kü thuËt vµ c¸c th«ng tin kh¸c. 

1.3. Giao diÖn ngêi dïng 

Giao diÖn ngêi dïng cña Autodesk Inventor theo chuÈn chung c¸c øng dông 

trªn Windows. 

Cã 2 thµnh phÇn chÝnh trong giao diÖn cña Autodesk Inventor: 

- Cöa sæ øng dông xuÊt hiÖn mçi khi Autodesk Inventor ®îc më ra. 

- Cöa sæ ®å ho¹ hiÓn thÞ khi mét file ®îc më. NÕu cã nhiÒu file cïng ®îc më 

th× file ®ang lµm viÖc sÏ n»m trªn cöa sæ hiÖn hµnh. 
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H×nh díi ®©y minh ho¹ mét cöa sæ øng dông víi file mÉu chuÈn ®îc hiÓn thÞ 

trªn cöa sæ ®å ho¹.  

 

1.3.1. Cöa sæ duyÖt (Browser) 

Browser hiÓn thÞ kÕt cÊu 

d¹ng nh¸nh c©y cña c¸c chi tiÕt, 

c¸c côm l¾p vµ c¸c b¶n vÏ trong 

file ®ang ho¹t ®éng. Mçi m«i 

trêng cã Browser riªng cña 

m×nh. H×nh bªn minh häa 

Browser trong m«i trêng l¾p r¸p 

vµ thanh c«ng cô cña nã. 

 

1.3.2. C¸c lÖnh vµ c¸c c«ng cô 

Autodesk Inventor sö dông c¸c thanh c«ng cô (Toolbar) kiÓu Windows vµ 

Panel cña Autodesk Inventor. Theo mÆc ®Þnh, Panel hiÓn thÞ phÝa trªn Browser. Ta 

cã thÓ cho hiÖn Toolbar, Panel hoÆc kÕt hîp c¶ hai. C¸c Toolbar cã thÓ dockable, 

nghÜa lµ ®îc kÐo ®Õn c¸c vÞ trÝ kh¸c nhau. Autodesk Inventor chØ cho hiÖn c¸c 

Toolbar thÝch hîp víi m«i trêng ®ang ho¹t ®éng. VÝ dô, nÕu ta ®ang trong m«i 

trêng l¾p r¸p mµ kÝch ho¹t mét chi tiÕt, Autodesk Inventor lËp tøc chuyÓn tõ 

Toolbar l¾p r¸p sang Toolbar cho m« h×nh chi tiÕt. C¸c m«i trêng dïng chung mét 
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sè phÝm hay c«ng cô chung, nh New hoÆc Help, nhng còng cã bé c«ng cô riªng cña 

m×nh. 

Díi ®©y lµ mét vÝ dô vÒ thanh c«ng cô Feature, ®îc hiÓn thÞ trong m«i 

trêng thiÕt kÕ m« h×nh chi tiÕt. 

 

§Ó ®Þnh vÞ thanh c«ng cô, kÐo nã lªn ®Ønh, xuèng ®¸y hay sang c¹nh cña cöa sæ 

øng dông. Ta cã thÓ ®Ó nã tù do ë gi÷a mµn h×nh. Ta cã thÓ kÐo mét gãc cña thanh 

c«ng cô ®Ó thay ®æi h×nh d¹ng cña nã. 

§Ó bËt hoÆc t¾t thanh c«ng cô, chän View -> Toolbar, sau ®ã chän thanh c«ng 

cô cÇn bËt hoÆc t¾t. 

C¸c c«ng cô cña Autodesk Inventor chØ më c¸c hép tho¹i khi cÇn thiÕt.  

VÝ dô: Khi kÝch chuét vµo mét c«ng cô Sketch, ta cã thÓ vÏ ngay. Nhng khi 

kÝch vµo mét c«ng cô trong Feature th× sÏ hiÖn ra hép héi tho¹i. 

KÝch c«ng cô sketch ... KÝch c«ng cô Feature vµ ®iÒn th«ng tin 

 

 ... vµ b¾t ®Çu vÏ 

§Ó kÕt thóc vµ tho¸t mét c«ng cô: Chän c«ng cô tiÕp theo mµ ta cÇn dïng hoÆc 

nhÊn phÝm ESC. Ta còng cã thÓ kÝch chuét ph¶i vµ chän Done tõ menu ng÷ c¶nh. 

Khi lµm viÖc víi Autodesk Inventor ta cã thÓ hoÆc lµ chän ®èi tîng tríc sau 

®ã kÝch chuét ®Ó chän c«ng cô cÇn t¸c ®éng lªn ®èi tîng chän hoÆc lµ chän c«ng cô 

tríc, sau ®ã chän ®èi tîng. 

Chän c«ng cô tríc ... HoÆc Chän ®èi tîng tríc ... 
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... råi chän ®èi tîng  ... råi chän c«ng cô 

1.3.3. Menu ng÷ c¶nh 

Menu ng÷ c¶nh ®îc hiÓn thÞ khi kÝch 

chuét ph¶i. Tïy thuéc vµo kÝch chuét ë ®©u 

vµ vµo lóc nµo mµ ta cã thÓ thÊy c¸c tuú 

chän, x¸c ®Þnh c«ng viÖc ®ang thùc hiÖn. 

H×nh bªn lµ mét vÝ dô vÒ menu ng÷ c¶nh 

trong m«i trêng sketch. 

 

1.3.4. Sketch vµ c¸c chÕ ®é lùa chän. 

Ta sö dông chÕ ®é Select hay chÕ ®é Sketch ®Ó th«ng b¸o cho Autodesk 

Inventor biÕt, ta muèn chän ®èi tîng hay muèn t¹o biªn d¹ng ph¸c th¶o. Khi më 

file chi tiÕt lÇn ®Çu Autodesk Inventor tù ®éng kÝch ho¹t chÕ ®é Select vµ chÕ ®é t¹o 

ph¸c th¶o 2D. Ta cã thÓ ®iÒu khiÓn chÕ ®é Sketch vµ c¸c chÕ ®é Select b»ng c¸c nót 

trªn thanh nót lÖnh. 

  

Nót chÕ ®é sketch më réng Nót chÕ ®é select më réng 

1.3.5. C¸c biÓu tîng con trá 

Khi chóng ta dïng Autodesk Inventor c¸c biÓu tîng nhá thêng hiÓn thÞ bªn 

c¹nh con trá. Nh÷ng biÓu tîng nµy chØ cho ta biÕt ta cã thÓ lµm g× ®ã víi m« h×nh 

hay thùc hiÖn c¸c thao t¸c liªn quan ®Õn nã. 

 VÝ dô, biÓu tîng nµy xuÊt hiÖn khi ta vÏ c¸c ®êng th¼ng song song. 

1.3.6. C¸c file mÉu (Templates) 

Autodesk Inventor cung cÊp c¸c mÉu cho 4 kiÓu file trong Autodesk Inventor: 

Part, Assembly, Presentation vµ Drawing. C¸c file Part còng cã thÓ ®îc sö dông 

cho c¸c  Catalog vµ c¸c chi tiÕt tõ kim lo¹i tÊm (Sheet Metal). 
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PhÇn më réng vµ biÓu tîng cña cña c¸c file nµy ®îc m« t¶ nh díi ®©y. 

 

MÉu cho c¸c kiÓu file kh¸c nhau nµy n»m trong hép tho¹i cña Autodesk 

Inventor, nã ®îc hiÓn thÞ  khi ta kÝch chuét vµo tuú chän ®Ó më mét file míi. C¸c 

thÎ Default, English vµ Metric chøa ®ùng c¸c mÉu file víi ®¬n vÞ ®o vµ tiªu chuÈn vÏ 

t¬ng øng. §¬n vÞ ®o vµ tiªu chuÈn dïng trong mÉu Default ®îc chän khi cµi ®Æt 

Autodesk Inventor. 

Autodesk Inventor New File Templates 

VÞ trÝ cña file Template Tªn file Template M« t¶ 

Default tab Sheet Metal.ipt Default Sheet Metal Part 

 Standart.iam Default Assembly 

 Standart.idw Default Drawing 

 Standart.ipn Default Presentation 

 Standart.ipt Default Part 

English tab Catalog (in).ipt Part Catalog (in) 

 Sheet Metal (in).ipt Sheet Metal Part (in) 

 Standart (in).iam Assembly (in) 

 ANSI (in).idw Drawing (in) 

 Standart (in).ipn Presentation (in) 

 Standart (in).ipt Standard part (in) 

Metric tab Catalog (mm).ipt Part Catalog (mm) 

 Sheet Metal 

(mm).ipt 

Sheet Metal Part (mm) 

 Standart (mm).iam Assembly (mm) 

 BSI.idw Drawing (tiªu chuÈn BSI) 

 DIN.idw Drawing (tiªu chuÈn DIN) 

 GB.idw Drawing (tiªu chuÈn GB) 

 ISO.idw Drawing (tiªu chuÈn ISO) 

 JIS.idw Drawing (tiªu chuÈn JIS) 

 Standart (mm).ipt Presentation (mm) 

 Standart (mm).ipn Standard part (mm) 
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1.4. HÖ thèng file ®Ò ¸n (Projects). 

Trong Autodesk Inventor ta dïng Projects ®Ó qu¶n lý c¸c File. Mét Project bao 

gåm mét Folder x¸c ®Þnh, mét hoÆc vµi Project Home Folder, vÞ trÝ vïng lµm viÖc 

(Workspace Loaction) vµ c¸c Folder chøa c¸c File ®îc liªn kÕt tíi Project. 

- Projects Folder: Chøa c¸c Shortcut tíi c¸c file trong Project Home Folder. Ta 

chØ cã mét Projects Folder duy nhÊt. 

- Project Home Folder: Chøa ®ùng mét file (.ipj), x¸c ®Þnh ®êng dÉn tíi c¸c 

Folder chøa ®ùng tÊt c¶ c¸c file liªn kÕt tíi Project. Ta cã mét Project Home 

Folder cho mçi Project ®îc Setup. C¸c Shortcut tíi c¸c Project Home Folder 

nµy chøa ®ùng trong Projects Folder. 

- Workspace: X¸c ®Þnh vÞ trÝ ®Çu tiªn ta lµm viÖc víi Project. Mçi mét Project 

cã mét Workspace. Ta thêng ghi c¸c File míi vµo trong Workspace.  

- C¸c file liªn kÕt tíi Project: Cã thÓ lµ c¸c File côc bé hoÆc trªn m¹ng, ®îc liªn 

kÕt tíi hoÆc ®ù¬c tham chiÕu tíi Project. C¸c ®êng dÉn tíi c¸c File nµy ®îc 

chøa ®ùng trong file .ipj trong Project Home Folder. 

Khi sö dông c¸c Project, Autodesk Inventor lu«n lu«n cã thÓ t×m tÊt c¶ c¸c file 

vµ c¸c file tham chiÕu ®Õn. Sö dông Project ta cã thÓ: 

- ThiÕt ®Æt Project bÊt kú khi nµo. 

- ThiÕt ®Æt chÕ ®é ®a Project. 

- Lµm viÖc víi c¸c bé phËn kh¸c nhau cña mét côm l¾p trong cïng mét thêi 

®iÓm. 

- Chia sÎ th viÖn chuÈn vµ th viÖn ngêi dïng. 

- Chia sÎ c¸c file víi mét nhãm lµm viÖc. 

1.4.1. ThiÕt  ®Æt Projects Folder 

MÆc dï ta cã thÓ t¹o c¸c File mµ kh«ng thiÕt ®Æt Project Folder, tuy nhiªn ta 

nªn thiÕt ®Æt Project tríc. Tríc khi t¹o mét nhãm c¸c File ta cÇn tæ chøc chóng 

vµo trong mét Project vµ t¹o c¸c Folder cÇn thiÕt. 

§Ó thiÕt ®Æt mét Project Folder: kÝch chuét vµo Tools -> Application Options. 

Trong General Tab cña hép tho¹i Projects Folder, chän mét vÞ trÝ. VÞ trÝ nµy, sau khi 

thiÕt ®Æt ta thêng kh«ng thay ®æi. 

1.4.2. T¹o Project míi 

Cã 2 ph¬ng ph¸p më mét cöa sæ Projects trong hép tho¹i Startup cña 

Autodesk Inventor. Khi më mét m«i trêng lµm viÖc cña Autodesk Inventor, hép 

tho¹i Startup ®a ra c¸c tïy chän cho Project. Khi kÝch vµo môc Projects, cöa sæ 

Projects ®îc më. Ta còng cã thÓ chän menu File -> Projects ®Ó cöa sæ Projects. 

Ta dïng hép tho¹i New Project Wizard ®Ó t¹o mét Project míi. 
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§Ó t¹o mét Project míi: Trong hép tho¹i Startup, kÝch chuét vµo Projects hoÆc 

chän menu File -> Projects. KÝch ph¶i vµo cöa sæ Project, chän New hoÆc kÝch phÝm 

New. Sau ®ã thùc hiÖn c¸c bíc do hép tho¹i New Project Wizard híng dÉn, nh x¸c 

®Þnh2: 

- §ã lµ Project míi hay mét Workspace riªng cña nhãm project cã tríc? 

- Project sÏ sö dông c¸c File cña Autodesk Inventor s½n cã hay c¸c File míi? 

Ta cßn ph¶i x¸c ®Þnh: 

- Tªn Project 

- VÞ trÝ cu¶ Project Home Folder. 

- VÞ trÝ cña File cho Workspace. 

- VÞ trÝ File cña nhãm Projects nÕu ®ã lµ mét nhãm c¸c Project. 

- C¸c th viÖn tiªu chuÈn vµ c¸c th viÖn ngêi dïng chøa trong Project. 

FIle Shortcut dÉn ®Õn Project (.ipj) sÏ ®îc tù ®éng ghi vµo Ptoject Home 

Folder. 

1.4.3. Më Project cã s½n  

Dïng cöa sæ Select a project file ®Ó më mét project cã s½n. Khi më hép tho¹i 

StartUp sÏ cung cÊp c¸c tuú chän Project cÇn më vµ chän  file project trong cöa sæ. 

Vïng phÝa trªn cña cöa sæ Project liÖt kª c¸c Folder Project cã s½n. C¸c folder 

Project chøa c¸c ®êng dÉn tíi tÊt c¶ c¸c file cña Project. 

Vïng thÊp h¬n cña cöa sæ chøa ®ùng c¸c th«ng tin vÒ ®Þnh vÞ cña Project ®· 

®îc lùa chän trong phÇn  phÝa trªn cña cöa sæ. ë ®©y ta cã thÓ chän mét kiÓu ®Þnh 

vÞ sau ®ã kÝch  ®óp chuét vµo ®êng dÉn cña ®Þnh vÞ ®ã ®Ó t×m file Project.       

- HiÓn thÞ c¸c Project - Chän mét file Project trong cöa sæ: 

Trong hép tho¹i StartUp kÝch ®óp chuét vµo Projects hoÆc chän File > Projects. 

- Më mét file Project cã s½n: Chän mét project trong vïng phÝa trªn cña cöa sæ 

Project sau ®ã chän mét ®êng dÉn trong vïng phÝa díi cña cöa sæ. KÝch ®óp vµo 

mét ®êng dÉn file project. C¸c file trong vïng ®Þnh vÞ nµy sÏ ®îc liÖt kª trong hép 

tho¹i Open, kÝch ®óp vµo tªn file cÇn më.    

                                            
2 Hép tho¹i New Project chØ cã thÓ ®îc më sau khi tÊt c¶ c¸c File cña Autodesk Inventor ®· 

®ãng. 
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- Thay ®æi c¸c project: Trong cöa sæ Select a project file chän mét project kh¸c 

vµ kÝch chuét vµo nót Apply. Khi thay ®æi tõ mét Project tíi mét Project kh¸c 

ta còng cã thÓ thay ®æi n¬i mµ Autodesk Inventor  t×m c¸c file. Ta kh«ng thÓ 

thay ®æi project khi file ®ang më. 

 

- X¸c ®Þnh c¸c kiÓu ®êng dÉn: Autodesk Inventor  sö dông c¸c ®êng dÉn t¾t 

trong c¸c Project Folder ®Ó ®Þnh vÞ vµ kÝch ho¹t c¸c file Project kh¸c nhau, theo mét 

giao thøc nhÊt ®Þnh. Khi më mét file Project (.ipj), Autodesk Inventor  sö dông c¸c 

®êng dÉn  x¸c ®Þnh file Project hiÖn hµnh ®Ó t×m c¸c file thµnh phÇn. §èi víi mçi 

file thµnh phÇn hÖ thèng sÏ dùa trªn ®êng dÉn ®Ó t×m kiÕm cho ®Õn khi t×m thÊy nã. 

Ta cã thÓ u tiªn c¸c ®êng dÉn t×m kiÕm ®Ó t¨ng nhanh qu¸ tr×nh t×m kiÕm c¸c file.  

Mét Project cã thÓ ®îc chØ  râ qua 4 kiÓu ®êng dÉn t×m kiÕm: Work space, 

Local, Workgroup vµ Library. Mét file Project nhÊt thiÕt ph¶i cã ®êng dÉn t×m 

kiÕm Workspace vµ cã thÓ cã mét vµi ®êng dÉn t×m kiÕm kh¸c trong sè c¸c ®êng 

dÉn t×m kiÕm cßn l¹i. 

+ Workspace: §Þnh vÞ mÆc ®Þnh cho c¸c file. NÕu tÊt c¶ c¸c file cña Project ®· 

®îc ®Þnh vÞ trong mét vÞ trÝ, vÞ trÝ nµy chØ cã thÓ lµ ®êng vµo cña file Project. NÕu 

ta lµm viÖc trong mét nhãm thiÕt kÕ, Workspace nhËn ra vïng lµm viÖc riªng cña 

tõng ngêi. 
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+ Local: Vïng file bæ sung. C¸c vïng nµy cã thÓ ë trªn m¸y tÝnh c¸ nh©n  hoÆc 

trªn mét Network. 

+ Workgroup: Dïng chung c¸c vïng  trªn m¹ng ®Ó tham chiÕu c¸c file. C¸c 

vïng Workgroup ®îc dïng chñ yÕu khi ta lµm viÖc trong c¸c nhãm thiÕt kÕ.       

+ Library: C¸c vïng cho c¸c chi tiÕt chuÈn hoÆc c¸c th viÖn ®îc ®Æt tªn kh¸c. 

§êng dÉn nµy sÏ ®îc Autodesk Inventor t×m tríc tiªn.  

C¸c chi tiÕt tiªu chuÈn nh ®inh èc hoÆc c¸c chi tiÕt ®ßn bÈy cã thÓ chiÕm 50-

60% cña mét l¾p r¸p. Khi c¸c chi tiÕt nµy kh«ng thay ®æi mét c¸ch thêng xuyªn th× 

chóng nªn ®Æt trong c¸c th viÖn. ChØ cã mét yÕu tè ®Ó nhËn ra mét chi tiÕt trong 

th viÖn hay mét chi tiÕt kh¸c ®ã lµ vïng mµ file ®ã ®îc x¸c ®Þnh lµ ®êng dÉn tíi 

th viÖn. File l¾p r¸p  nhËn ra khi chÌn mét chi tiÕt lÊy tõ trong th viÖn vµ kiÓm tra 

cho lÇn më file tiÕp theo.  

NÕu hÖ thèng kh«ng t×m thÊy file th× nã sÏ hiÓn thÞ hép tho¹i Resolve Link khi 

®ã ta cã thÓ chØ dÉn tíi file ®ã. Tõ ®ã hÖ thèng sÏ kiÓm tra vïng th viÖn tríc tiªn, 

cã thÓ t¨ng nhanh qu¸ tr×nh më file b»ng c¸ch chuyÓn c¸c chi tiÕt tiªu chuÈn ®Õn 

®êng dÉn th viÖn. 

§èi víi nh÷ng chi tiÕt kh¸c, tríc tiªn hÖ thèng sÏ kiÓm tra Workspace sau ®ã 

®Õn c¸c ®êng dÉn tíi vïng c¸c file kh¸c (Local  path), tiÕp ®Õn c¸c ®êng dÉn 

workgroup. 

 NÕu file kh«ng ®îc t×m thÊy th× Autodesk Inventor sÏ t×m nh÷ng folder mµ 

chøa file Project sau ®ã hiÓn thÞ hép tho¹i Resolve Link  khi ®ã ta cã thÓ t×m file nµy. 

- T×m c¸c file: Hép tho¹i Resolve Link cã mét trêng ®Ó x¸c ®Þnh ®êng dÉn 

t×m kiÕm. Khi t×m mét file ®¬n gi¶n ta chØ cÇn kÝch chuét vµo Path name sau ®ã 

®êng dÉn tíi file ®îc nhËp vµo trêng Look in. NÕu kh«ng t×m thÊy file kÝch chuét 

vµo Skip ®Ó tiÕp tôc n¹p c¸c rµng buéc. NÕu kÝch chuét vµo Skip All  hÖ thèng sÏ 

kh«ng n¹p nh÷ng rµng buéc víi c¸c file bÞ lçi. 

 

 

 

   

1.5. XuÊt nhËp d÷ liÖu 

Cã thÓ nhËp c¸c file d¹ng SAT, STEP vµ c¸c file AutoCAD, Mechanical 

Desktop ®Ó dïng trong Autodesk Inventor. Ta còng cã thÓ ghi c¸c file Part vµ file 

Assembly trong Autodesk Inventor thµnh mét vµi d¹ng file kh¸c. Cã thÓ ghi c¸c file 

b¶n vÏ cña Autodesk Inventor nh lµ c¸c file DXF hoÆc c¸c file(DWG) cña 

AutoCAD. 

Ghi chó: C¸c file Mechanical Desktop cã thÓ ®îc liªn kÕt tíi c¸c côm l¾p mµ kh«ng 

cÇn nhËp vµo m«i trêng Autodesk Inventor.  
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1.5.1. C¸c file AutoCAD: 

Cã thÓ nhËp mét b¶n vÏ AutoCAD (.dwg) thµnh mét  ph¸c th¶o cña chi tiÕt, 

mét b¶n vÏ, hoÆc mét b¶n vÏ ph¸c th¶o. Ta còng cã thÓ xuÊt mét b¶n vÏ cña 

Autodesk Inventor thµnh mét b¶n vÏ cña AutoCAD vµ cã thÓ chØnh söa ®îc. 

- NhËp b¶n vÏ AutoCAD (.dwg) thµnh mét sketch: Më Autodesk Inventor 

part file hoÆc drawing file vµ kÝch ho¹t chÕ ®é sketch. KÝch chuét vµo File->Open 

sau ®ã chän file b¶n vÏ AutoCAD (*. dwg) tõ danh s¸ch c¸c kiÓu file (Files of Type 

list). DuyÖt vµ chän file sau ®ã kÝch chuét vµo Open. Trong hép tho¹i chän AutoCAD 

Drawing Data sau ®ã chän ®¬n vÞ ®o thÝch hîp. KÝch chuét vµo nót >> ®Ó chän thªm 

c¸c tuú chän cho nhËp file vµ kÝch chuét vµo OK.  C«ng cô chuyÓn ®æi sÏ thùc hiÖn 

chuyÓn c¸c ®èi tîng (entity) tõ mÆt ph¼ng XY cña kh«ng gian m« h×nh vµ ®Æt 

chóng trong m«i trêng sketch. Mét vµi ®èi tîng nh splines kh«ng thÓ chuyÓn ®æi 

®îc. 

- NhËp b¶n vÏ AutoCAD (*.dwg) thµnh mét b¶n vÏ trong Autodesk Inventor : 

Më Autodesk Inventor Drawing file. Chän File->Open sau ®ã chän file b¶n vÏ 

AutoCAD Drawing (*. dwg) tõ danh s¸ch c¸c kiÓu file (Files of Type list). DuyÖt vµ 

chän file cÇn nhËp, sau ®ã kÝch chuét vµo Open. 

- XuÊt d÷ liÖu ra m«i trêng AutoCAD: Chän  File -> Save Copy As sau ®ã 

chän AutoCAD Drawing (*. dwg) tõ  Save as Type list (danh s¸ch c¸c d¹ng file ghi 

ra).. NhËp tªn file vµ kÝch chuét vµo Option ®Ó chän c¸c tuú chän thÝch hîp khi ghi 

sau ®ã kÝch chuét vµo Save. C«ng cô chuyÓn ®æi sÏ t¹o ra mét b¶n vÏ AutoCAD míi 

vµ chuyÓn toµn bé vµo chÕ ®é paper space cña file DWG. NÕu trong b¶n vÏ cña 

Autodesk Inventor cã nhiÒu Sheet th× mçi sheet ®îc ghi thµnh mét file Dwg riªng. 

C¸c ®èi tîng ®îc xuÊt ra dwg trë thµnh c¸c ®èi tîng cña AutoCAD, bao gåm c¶ 

c¸c kÝch thíc.  

1.5.2. C¸c file Mechanical Desktop: 

Autodesk Inventor cã thÓ hiÓu c¸c chi tiÕt hoÆc c¸c côm l¾p trong Mechanical 

Desktop. Ta cã thÓ nhËp mét file Mechanical Desktop díi d¹ng mét ACIS body 

hoÆc lµ  chuyÓn ®æi hoµn toµn. C¸c feature mµ ®îc hç trî trong Autodesk Inventor 

th× sÏ ®îc nhËn d¹ng. C¸c feature kh«ng ®îc hç trî trong Autodesk Inventor th× 

sÏ kh«ng ®îc nhËn d¹ng. NÕu Autodesk Inventor kh«ng thÓ nhËn ra mét feature th× 

nã sÏ bá qua feature ®ã ®ång thêi ®a ra th«ng b¸o trong Browser vµ hoµn thµnh 

viÖc nhËn d¹ng. 

- NhËp mét file Mechanical Desktop: Chän File->Open sau ®ã chän AutoCAD 

Drawing(*.dwg) tõ danh s¸ch c¸c kiÓu file. DuyÖt vµ chän file sau ®ã kÝch 

chuét  

vµo Open. Trong hép tho¹i Open DWG File chän tuú chän Mechanical Desktop 

Part/assembly sau ®ã chän ®¬n vÞ ®o thÝch hîp. KÝch chuét vµo nót >> ®Ó lùa chän 
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thªm c¸c tuú chän kh¸c cho viÖc nhËp file. KÝch chuét vµo OK Autodesk Inventor sÏ 

chuyÓn ®æi vµ më mét file Autodesk Inventor. 

Ghi chó: §Ó nhËp d÷ liÖu m« h×nh tõ c¸c chi tiÕt hoÆc c¸c côm l¾p trong Mechanical 

Desktop th× Mechanical Desktop ph¶i ®îc cµi ®Æt vµ ®ang ch¹y trªn hÖ thèng.   

1.5.3. C¸c file SAT: 

 C¸c file SAT chøa c¸c solid kh«ng tham sè. Chóng cã thÓ lµ c¸c Boolean solid 

hoÆc nh÷ng solid tham sè víi c¸c mèi quan hÖ ®· bÞ lo¹i bá. Mét SAT file cã thÓ ®îc 

dïng trong mét côm l¾p. Cã thÓ bá sung c¸c feature tham sè  tíi solid c¬ së. 

- NhËp mét file SAT (*.sat): Chän File -> Open vµ sau ®ã chän c¸c SAT file tõ  

danh s¸ch d¹ng file ( File of Type list). DuyÖt vµ chän file sau ®ã kÝch chuét vµo nót 

Option ®Ó ®Æt ®¬n vÞ ®o cho file ®ã. KÝch chuét vµo Open, Autodesk Inventor sÏ 

chuyÓn ®æi vµ më file míi. NÕu mét file SAT chøa mét thùc thÓ ®¬n th× nã sÏ xuÊt ra 

mét file chi tiÕt Autodesk Inventor víi mét chi tiÕt ®¬n. NÕu file chøa ®ùng nhiÒu 

thùc thÓ nã sÏ xuÊt ra mét file l¾p r¸p cã côm l¾p víi nhiÒu chi tiÕt. 

- §Ó xuÊt ra mét file SAT: Chän  File->Save Copy As sau ®ã chän SAT file tõ 

danh s¸ch c¸c kiÓu file (Save as Type list). 

1.5.4. C¸c file STEP: 

C¸c file STEP lµ mét ®Þnh d¹ng chuÈn quèc tÕ ®îc ph¸t triÓn vµ kh¾c phôc 

mét vµi h¹n chÕ cña c¸c chuÈn chuyÓn ®æi  d÷ liÖu. Nh÷ng cè g¾ng trong viÖc 

ph¸t triÓn c¸c chuÈn ®· mang l¹i kÕt qu¶ trong viÖc ph©n chia c¸c ®Þnh d¹ng nh  

IGES (Mü), VDAFS (§øc) hoÆc IDF ( cho c¸c b¶ng m¹ch). Nh÷ng chuÈn ®ã 

kh«ng thÝch øng víi nhiÒu sù ph¸t triªn trong c¸c hÖ thèng CAD. C«ng cô chuyÓn 

®æi STEP cho Autodesk Inventor ®îc thiÕt kÕ cho viÖc giao tiÕp, chuyÓn ®æi  mét 

c¸ch tin cËy cho c¸c hÖ thèng CAD kh¸c. 

- §Ó nhËp mét file STEP (*.stp,*.ste,*.step): Chän File-> Open sau ®ã chän file  

STEP trong danh s¸ch c¸c d¹ng file (File of Type). Chän file cÇn nhËp sau ®ã 

kÝch chuét vµo Open. Autodesk Inventor sÏ chuyÓn ®æi vµ më file míi. C«ng cô 

chuyÓn ®æi STEP chØ chuyÓn ®æi c¸c solid 3D, Part vµ c¸c côm l¾p. C¸c b¶n vÏ, text, 

wireframe vµ c¸c d÷ liÖu bÒ mÆt kh«ng ®îc xö lý b»ng c«ng cô chuyÓn ®æi STEP. 

NÕu mét file STEP chøa mét part nã sÏ xuÊt sang Autodesk Inventor mét file part. 

NÕu nã chøa côm l¾p  nã sÏ xuÊt ra mét file Assembly cã nhiÒu chi tiÕt. 

- §Ó xuÊt mét file STEP: Chän File->Save Copy As vµ sau ®ã chän STEP file tõ  

danh s¸ch c¸c d¹ng file (Save as Type list). Chi tiÕt vµ côm l¾p sÏ ®îc chuyÓn ®æi 

thµnh d¹ng STEP. B¶n vÏ vµ c¸c thuéc tÝnh nh vËt liÖu sÏ kh«ng ®îc xö lý qua 

c«ng cô chuyÓn ®æi  STEP. 
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1.5.5. C¸c file IGES:  

    C¸c file IGES lµ chuÈn cña Mü. RÊt nhiÒu bé phÇn mÒm NC/CAM yªu cÇu ®Þnh 

d¹ng file theo chuÈn IGES. V× IGES kh«ng th©n thuéc trong ®Þnh d¹ng cho c¸c d÷ 

liÖu m« h×nh solid, Autodesk Inventor chØ hç trî cho viÖc xuÊt ra c¸c file IGES. 

- §Ó xuÊt ra file IGES (*.igs,*.ige,*.iges): Chän File -> Save Copy As sau ®ã 

chän d¹ng file IGES tõ danh s¸ch c¸c d¹ng file (Save as Type list). KÝch chuét vµo 

Option sau ®ã chän Solid or Surface data. §Þnh vÞ trÝ cho file vµ nhËp vµo tªn file sau 

®ã kÝch chuét vµo Save.    

1.6. HÖ thèng hç trî thiÕt kÕ: 

 

T C«ng cô hç 

trî 

Sö dông…. T×m ë ®©u…. Ghi chó 

1

1 

Help Nh÷ng néi dung 

trî gióp thiÕt kÕ 

Trªn menu Help 

 

2

2 

DesignExper

t 

Nh÷ng th«ng tin  

cung cÊp trong 

qu¸ tr×nh thiÕt kÕ 

vÒ lçi, c¸ch söa…  

Tuú theo dßng nh¾c 

néi dung sÏ tù ®éng 

kÕt nèi 

 

3 QuickStart Xem nhanh c¸c 

phÇn kh¸c nhau 

cña Autodesk 

Inventor  

Tõ menu Tools, 

chän Application 

Option. Chän c¸c 

tuú chän khi b¾t 

®Çu mét phÇn míi 

cña Autodesk 

Inventor   
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3

3 

What’ s 

New 

Xem, ®äc vµ 

nghiªn cøu nh÷ng 

®Æc tÝnh míi. 

Menu Help chän 

What’ s New  

 

4

4 

Visual 

Syllabus 

Xem c¸c nhiÖm vô 

cô thÓ ®îc thùc 

hiªn nh thÕ nµo 

Nót trªn thanh c«ng 

cô chuÈn 

 

5

5 

Design  

Doctor 

Söa c¸c lçi cña c¸c 

chi tiÕt vµ c¸c côm 

l¾p 

Nót trªn thanh c«ng 

cô hoÆc trªn menu 

ng÷ c¶nh 

 

6

6 

Tutorials Híng dÉn thiÕt 

kÕ theo tõng bíc 

cã minh ho¹ c¸c vÝ 

dô vµ c¸c ®o¹n 

phim 

Menu Help 

 

7

7 

AutoDesk 

Online 

T×m c¸c th«ng tin 

vÒ s¶n phÈm, ®µo 

t¹o vµ c¸c th«ng 

tin hç trî trªn 

trang web. 

Download c¸c 

phÇn mÒm update 

cña Autodesk 

Inventor  

Menu Help 
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1.6.1. C¸ch häc Autodesk Inventor  

Díi ®©y lµ nh÷ng gîi ý vÒ c¸ch häc Autodesk Inventor sö dông viÖc th¨m dß 

cho c¸c cÊp ®é kinh nghiÖm kh¸c nhau. 

NÕu b¹n lµ..... C¸c bíc gîi ý 

Lµm quen víi c¸c 

ch¬ng tr×nh  CAD 

2D nhng cha quen 

víi c¸c ch¬ng tr×nh 

CAD 3D  

§äc tµi liÖu nµy, chó ý ®Õn phÇn tr×nh tù lµm viÖc cña mçi 

ch¬ng. 

Tõ menu Help chän What’ s New, Tutorials xem l¹i híng 

dÉn c¸c bíc ®Ó t¹o chi tiÕt, l¾p r¸p, lËp b¶n vÏ. 

Chän File -> Getting Started. Tõ trang Quickstart. 

§· cã kinh nghiÖm 

trong thiÕt kÕ c¸c m« 

h×nh chi tiÕt 3D 

§äc tµi liÖu nµy.  

Tõ menu Help chän What’ s New, Tutorials xem l¹i híng 

dÉn c¸c bíc ®Ó t¹o chi tiÕt, l¾p r¸p, lËp b¶n vÏ. BÊt ®Çu t¹o 

dùng c¸c chi tiÕt cña riªng b¹n. NÕu cÇn híng dÉn Ên F1, 

kÝch chuét ph¶i vµ chän How To tõ menu ng÷ c¶nh, tõ thanh 

c«ng cô chuÈn, hoÆc kÝch chuét vµo nót Visual Syllabus 

§· cã kinh nghiÖm 

trong Mechanical 

Desktop 

§äc tµi liÖu nµy. Tõ thanh c«ng cô chuÈn kÝch vµo Visual 

Syllabus ®Ó xem c¸c nhiÖm vô cô thÓ ®îc thùc hiÖn nh thÕ 

nµo. Tõ menu Help chän What’ s New, Tutorials xem l¹i 

híng dÉn c¸c bíc ®Ó t¹o chi tiÕt, l¾p r¸p, lËp b¶n vÏ. 

Trong Help xem phÇn c¸ch chuyÓn ®æi d÷ liÖu víi 

Mechanical Desktop. 

NÕu cßn bì ngì víi 

c¸c c«ng cô CAD 

CÇn qua ®µo t¹o vÒ c¸c m« h×nh CAD 2D vµ 3D tríc khi sö 

dông Autodesk Inventor . §äc tµi liÖu nµy vµ chó ý tíi phÇn 

tr×nh tù lµm viÖc trªn c¸c ch¬ng. Tõ menu Help chän 

What’ s New, Tutorials xem l¹i híng dÉn c¸c bíc ®Ó t¹o 

chi tiÕt, l¾p r¸p, lËp b¶n vÏ. Tõ thanh c«ng cô chuÈn kÝch vµo 

Visual Syllabus ®Ó xem c¸c nhiÖm vô cô thÓ ®îc thùc hiÖn 

nh thÕ nµo. 

 

  1.6.2. Cã thÓ xem thªm th«ng tin trî gióp vµ ®¹o t¹o ë ®©u: 

 §Ó cã thªm th«ng tin trî gióp, tµi liÖu ®µo t¹o t×m trªn ®Þa chØ 

www.autodesk.com 

- Trung t©m ®µo t¹o cña Autodesk gÇn nhÊt. 

- C¸c th«ng tin bæ sung vÒ Autodesk Inventor vµ c¸c s¶n phÈm kh¸c cña 

Autodesk. 

- Cung cÊp c¸c th«ng tin ®µo t¹o vÒ Autodesk Inventor  

- Tµi liÖu Autodesk Inventor Getting Started trong file d¹ng. Pdf. 

http://www.autodesk.com/
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CHƯƠNG 2 

Sketch 
Sketch (ph¸c ph¶o) lµ bíc ®Çu tiªn ®Ó t¹o dùng chi tiÕt. Ch¬ng nµy sÏ tr×nh 

bµy tæng quan vÒ m«i trêng Sketch, c«ng cô Sketch vµ tr×nh tù t¹o Sketch. Nh÷ng 

th«ng tin tham kh¶o nhiÒu h¬n, c¸c thÝ dô tr×nh diÔn, vµ chØ dÉn tõng bíc cô thÓ 

xem thªm trong phÇn trî gióp trùc tuyÕn (OnlineHelp) vµ Tutorial. 

3.1. Giíi thiÖu chung 

3.1.1. C«ng dông cña Sketch 

M« h×nh mµ ta t¹o ra trong Autodesk Inventor ®îc liªn kÕt víi Sketch c¬ së 

(Underlying) cña nã. Khi söa ®æi  Sketch, m« h×nh sÏ ®îc tù ®éng cËp nhËt. 

Khi muèn t¹o hoÆc chØnh söa Sketch, ph¶i vµo m«i trêng Sketch. M«i trêng 

nµy bao gåm Sketch vµ c¸c c«ng cô ®Ó t¹o vµ chØnh söa nã. 

Sketch lµ biªn d¹ng cña Feature3 vµ c¸c ®èi tîng h×nh häc kh¸c (vÝ dô ®êng 

dÉn hoÆc ®êng t©m quay) cÇn thiÕt ®Ó t¹o Feature. Ta t¹o m« h×nh 3D tõ  Sketch 

b»ng c¸ch kÐo mét biªn d¹ng theo mét ®êng dÉn hoÆc quay mét biªn d¹ng quanh 

®êng t©m nµo ®ã (H×nh 3.1). 

 

 

 

H×nh 3.1: T¹o chi tiÕt 3D b»ng 

c¸ch quay Sketch quanh mét ®êng 

t©m.   

 

 

 

M« h×nh 3D cña chi tiÕt ®îc t¹o trªn c¬ së th«ng tin trong Sketch vµ c¸c c«ng 

cô t¹o Feature. Gi÷a Sketch vµ Feature ®îc t¹o thµnh lu«n lu«n cã mèi liªn kÕt. 

Mçi khi söa ®æi Sketch th× Feature ®îc tù ®éng cËp nhËt. §iÒu nµy lµm ®¬n gi¶n  

qu¸ tr×nh thiÕt kÕ vµ chØnh söa chi tiÕt. 

3.1.2. Khëi ®éng m«i trêng Sketch 

Mçi khi  më mét file chi tiÕt míi, m«i trêng Sketch ®îc tù ®éng kÝch ho¹t. 

Nót 2D Sketch ®îc chän vµ thanh c«ng cô 2D Sketch hiÖn s½n. Khi mét file chi tiÕt 

                                            
3 Feature lµ mét bé phËn cña chi tiÕt, cã thÓ söa ®æi ®îc khi cÇn thiÕt. Chi tiÕt vÒ Feature, 

xem ch¬ng 3.   
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®· më, cã thÓ kÝch ho¹t Sketch trong Browser (cöa sæ duyÖt) ®Ó kÝch ho¹t c¸c c«ng 

cô trong m«i trêng Sketch. Sau khi t¹o m« h×nh tõ Sketch ta cã thÓ trë l¹i m«i 

trêng Sketch ®Ó chØnh söa hoÆc bæ sung thªm Sketch míi cho Feature. 

Sau khi Sketch ®îc t¹o ra, biÓu tîng Sketch xuÊt hiÖn trong Browser. Khi 

t¹o Feature tõ Sketch, biÓu tîng Feature xuÊt hiÖn trong Browser, bªn trªn biÓu 

tîng Sketch t¬ng øng. Khi trá vµo biÓu tîng Sketch trong Browser, Sketch t¬ng 

øng trong cöa sæ ®å ho¹ sÏ ®æi mµu. §Ó chØnh söa Sketch, kÝch ®óp vµo biÓu tîng 

cña nã trong Browser. 

3.2. C¸c tiÖn Ých t¹o Sketch 

Dynamic 

inference 

 

Autodesk Inventor t×m kiÕm, hiÓn thÞ vµ tù ®éng g¸n 

nh÷ng rµng buéc khi t¹o Sketch. 

Shared Sketch Ta cã thÓ sö dông mét Sketch ®Ó t¹o nhiÒu Feature hoÆc 

nhiÒu biªn d¹ng (Profile) trong mét m« h×nh chi tiÕt. 

Constrained 

Drag 

Ta cã thÓ g¸n c¸c rµng buéc, thay ®æi kÝch thíc cña 

Sketch vµ t¹o c¸c rµng buéc míi b»ng c¸ch kÐo c¸c ®èi 

tîng h×nh häc. 

General 

Dimension 

Ta cã thÓ t¹o c¸c kÝch thíc mét c¸ch nhanh chãng vµ 

trùc quan b»ng nót trong thanh c«ng cô.   

Auto Dimension  Ta cã thÓ ®ång thêi ghi nhiÒu kÝch thíc, t¹o c¸c rµng 

buéc cho c¸c Sketch trong cïng mét bíc víi sè thao t¸c 

Ýt nhÊt. 

Hatching Ta cã thÓ g¹ch  mÆt c¾t cho c¸c vïng trong b¶n vÏ. 

Direct Edge 

Referencing. 

Ta cã thÓ chiÕu c¸c c¹nh cña chi tiÕt lªn mÆt ph¼ng 

Sketch ®Ó t¹o ra Sketch míi. 

 3.3. Tr×nh tù thùc hiÖn 

PhÇn nµy giíi thiÖu tæng quan vÒ c¸ch t¹o c¸c Sketch. Trong trî gióp trùc 

tuyÕn (onLine) Help vµ Tutorials sÏ cung cÊp  ®Çy ®ñ th«ng tin, thÝ dô tr×nh diÔn vµ 

c¸c bíc cô thÓ. 

3.3.1. Ph¸c th¶o biªn d¹ng 

Mçi mét chi tiÕt ®Òu ®îc khëi t¹o tõ mét Sketch. M«i trêng Sketch ®îc thiÕt 

lËp ®Ó cã thÓ vÏ, chØnh söa vµ hoµn thiÖn c¸c Sketch mét c¸ch dÔ dµng. 

§Ó t¹o Sketch cho chi tiÕt míi  ta cÇn thùc hiÖn c¸c bíc sau: 

1. Më file chi tiÕt míi (Part). 

2. Chän c«ng cô (lÖnh vÏ) trªn thanh c«ng cô Sketch. 
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3. KÝch vµo cöa sæ ®å ho¹ ®Ó ph¸c th¶o biªn d¹ng. Chó ý r»ng c¸c biÓu tîng  

(nh c¨n vu«ng gãc hay c¨n th¼ng ®øng) sÏ xuÊt hiÖn ®Ó gîi ý c¸c rµng buéc cã thÓ 

®îc g¸n.  

4. §ãng kÝn ®èi tîng h×nh häc b»ng c¸ch chän ®iÓm ®Çu. Khi di chuyÓn chuét 

®Õn gÇn ®iÓm cã thÓ truy b¾t (Snap) th× con trá t¬ng øng sÏ ®æi mµu. 

5. NhÊn phÝm ESC  hoÆc kÝch SELECT ®Ó kÕt thóc lÖnh. 

3.3.2. Thay ®æi kiÓu ®èi tîng h×nh häc 

 Cã 3 kiÓu (Style) ®èi tîng h×nh häc Sketch: Normal, Construction vµ 

CenterLine. Normal lµ kiÓu mÆc ®Þnh. Nã ®îc dïng ®Ó t¹o c¸c Feature. KiÓu 

Construction ®îc dïng ®Ó t¹o c¸c ®èi tîng h×nh häc bæ trî cho ph¸c th¶o biªn 

d¹ng nhng kh«ng ®îc dïng ®Ó t¹o Feature hoÆc ®êng dÉn, Sweep  vµ Loft. KiÓu 

CenterLine chØ cã thÓ ¸p dông cho c¸c ®êng (line). VÝ dô lÖnh Revolve nhËn ®êng 

Centerline nh mét trôc quay.  

§Ó thay ®æi kiÓu ®èi tîng h×nh häc, ta kÝch chuét vµo mòi tªn bªn c¹nh hép 

danh s¸ch Style vµ chän Normal hoÆc Construction. §èi tîng h×nh häc míi t¹o ra 

sÏ mang kiÓu nµy. §èi víi nh÷ng ®èi tîng h×nh häc cã s½n tríc hÕt ph¶i chän ®èi 

tîng, sau ®ã míi chän kiÓu. NÕu ta chän mét ®o¹n th¼ng th× kiÓu CenterLine sÏ 

hiÖn ra trong danh s¸ch Style. 

3.3.3. NhËp chÝnh x¸c c¸c gi¸ trÞ 

Ta cã thÓ nhËp gi¸ trÞ chÝnh x¸c (Precise Input) cho c¸c ®èi tîng h×nh häc khi 

t¹o Sketch. §iÒu ®ã cã thÓ ®îc thùc hiÖn víi c¸c c«ng cô Sketch cÇn nhËp täa ®é 

®iÓm. Cöa sæ nhËp täa ®é cã hai trêng X vµ Y. Ta cã thÓ nhËp c¶ hai gi¸ trÞ ®Ó ®Þnh 

nghÜa mét ®iÓm hoÆc chØ nhËp mét gi¸ trÞ X hoÆc Y ®Ó h¹n chÕ vÞ trÝ cña ®iÓm trªn 

®êng th¼ng ®øng hoÆc n»m ngang. 

§Ó sö dông Precise Input, chän  VIEW ->Toolbar->Precise Input. 

3.3.4. ChØnh söa c¸c Sketch 

Khi mét Sketch ®· ®îc t¹o ra, ta cã thÓ thùc hiÖn nhanh c¸c hiÖu chØnh ®Ó 

hoµn thiÖn nã tríc khi t¹o Feature. NÕu ®èi tîng h×nh häc cña Sketch cha bÞ rµng 

buéc hoµn toµn, ta cã thÓ chØnh söa nã b»ng c¸ch kÐo rª. Ta cã thÓ ®Þnh d¹ng c¸c 

c¹nh cña m« h×nh còng nh c¸c ®êng cña Sketch. 

§Ó söa l¹i c¸c ®èi tîng h×nh häc b»ng c¸ch kÐo, ta chän ®èi tîng h×nh häc vµ 

kÐo sang vÞ trÝ míi. C¸c ®èi tîng h×nh häc kh¸c cã liªn kÕt víi ®èi tîng nµy sÏ tù 

®éng di chuyÓn theo.  

§Ó söa nhiÒu ®èi tîng b»ng c¸ch kÐo, gi÷ phÝm CTRL trong khi chän c¸c ®èi 

tîng cÇn söa ®æi. KÐo ®èi tîng ®îc chän sau cïng th× c¸c ®èi tîng kh¸c còng di 

chuyÓn cïng víi nã. 
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                   H×nh 3.2: ChØnh söa Sketch b»ng c¸ch kÐo 

3.3.5. Thªm bít c¸c rµng buéc 

Ta cã thÓ ®Þnh d¹ng  Sketch b»ng c¸ch thªm vµo ®ã nh÷ng rµng buéc h×nh häc. 

Nh÷ng rµng buéc sÏ h¹n chÕ kh¶ n¨ng biÕn ®æi cña ®èi tîng vµ x¸c ®Þnh h×nh d¹ng 

cña Sketch. VÝ dô khi ®êng th¼ng bÞ rµng buéc n»m ngang, khi ta kÐo ®iÓm cuèi 

cña nã th× hoÆc chiÒu dµi cña nã thay ®æi hoÆc nã sÏ dÞch chuyÓn th¼ng ®øng nhng 

gãc nghiªng cña nã sÏ kh«ng thay ®æi.  

MÆc dï ta cã thÓ sö dông nh÷ng Sketch kh«ng bÞ rµng buéc ®Çy ®ñ, nhng 

nh÷ng Sketch ®îc rµng buéc ®Çy ®ñ khi cËp nhËt sÏ cho h×nh d¹ng mong muèn. 

MÆc dï c«ng cô tù ®éng ghi kÝch thíc h¹n chÕ dïng cho Sketch nhng vÉn cã thÓ 

sö dông nã ®Ó g¸n rµng buéc. Nhng qu¸ tr×nh sÏ kÕt thóc khi Sketch bÞ rµng buéc 

hoµn toµn. 

§Ó thªm mét rµng buéc, ta kÝch chuét vµo c«ng cô Constraint trªn thanh c«ng 

cô Sketch, sau ®ã chän ®èi tîng h×nh häc cÇn thªm rµng buéc. Ta còng cã thÓ t¹o ra 

nh÷ng rµng buéc b»ng c¸ch kÐo ®èi tîng h×nh häc cho ®Õn khi t¹i vÞ trÝ con trá xuÊt 

hiÖn ký hiÖu cña rµng buéc mong muèn. Autodesk Inventor sÏ tù ®éng nhËn biÕt 

rµng buéc ®ã lµ rµng buéc g× khi ta kÐo rª ®èi tîng h×nh häc vµo vÞ trÝ t¬ng øng 

(h×nh 3.3).  
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H×nh 3.3. Tù nhËn biÕt rµng buéc 

§Ó xem hoÆc xo¸ bá rµng buéc, ta kÝch Show->Delete Constraints trªn thanh  

 

 

 

c«ng cô Sketch vµ di con trá lªn Sketch. C¸c rµng buéc sÏ hiÓn thÞ trong hép 

rµng buéc. Dõng con trá vµo mét ký hiÖu rµng buéc th× ®èi tîng h×nh häc t¬ng 

øng sÏ ®æi mµu. Muèn xo¸ mét rµng buéc, kÝch ph¶i chuét vµo biÓu tîng t¬ng øng 

vµ chän Delete hoÆc di con trá vµo biÓu tîng rµng buéc vµ Ên phÝm DELETE. 

§Ó di chuyÓn hép rµng buéc, ta kÝch vµo Grip vµ kÐo hép rµng buéc tíi vÞ trÝ 

mong muèn . 

 §Ó xem tÊt c¶ rµng buéc cïng mét lóc, ta kÝch chuét ph¶i vµ chän Show All 

Constraints trªn menu ng÷ c¶nh. Chän Hide All Constraints còng trªn menu nµy ®Ó 

®ãng toµn bé c¸c hép rµng buéc hoÆc chän nót Close trªn hép rµng buéc. 

3.3.6. G¸n kÝch thíc 

KÝch thíc x¸c ®Þnh ®é lín cña Sketch. Sau khi mét ®èi tîng ®îc g¸n kÝch 

thíc, ta kh«ng thÓ thay ®æi ®é lín cña nã b»ng c«ng cô kÐo. Autodesk Inventor 

kh«ng cho phÐp g¸n trïng kÝch thíc cho mét ®èi tîng. 

Ta cã thÓ g¸n gi¸ trÞ sè cô thÓ cho mét kÝch thíc. Nh÷ng kÝch thíc nh vËy 

®îc gäi lµ kÝch thíc tham sè. Khi söa ®æi kÝch thíc tham sè, ta cã thÓ nhËp biÓu 

thøc gåm mét hoÆc nhiÒu tham sè. 

Ta cã thÓ g¸n kÝch thíc suy diÔn (Driven Dimension). KÝch thíc suy diÔn hiÓn 

thÞ ®é lín cña ®èi tîng h×nh häc nhng ta kh«ng thÓ thay ®æi trùc tiÕp gi¸ trÞ cña 

nã. KÝch thíc suy diÔn ®îc sö dông ®Ó hiÓn thÞ c¸c kÝch thíc dÉn ®Õn rµng buéc 

thõa vµ ®iÒu khiÓn tÝnh thÝch nghi cña Sketch. Xem thªm ch¬ng 6 “ L¾p r¸p”  ®Ó 

biÕt thªm chi tiÕt vÒ thÝch nghi. 

§Ó g¸n kÝch thíc, ta kÝch vµo General Dimension trªn thanh c«ng cô Sketch. 

Chän ®èi tîng cÇn ghi kÝch thíc vµ di chuyÓn con trá tíi vÞ trÝ ®Æt kÝch thíc. 

KÝch chuét lÇn n÷a ®Ó ®Æt vÞ trÝ ghi kÝch thíc. Ta cã thÓ kÝch chän 2 ®iÓm vµ di 

chuyÓn con trá ®Ó t¹o kÝch thíc ngang, ®øng hoÆc nghiªng. Chän 2 ®o¹n th¼ng ®Ó 

ghi kÝch thíc gãc.  
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§Ó chuyÓn mét kÝch thíc thµnh kÝch thíc suy diÓn, ta kÝch vµo c«ng cô 

General Dimension hoÆc chän kÝch thíc cã s½n. Sau ®ã kÝch  vµo hép danh s¸ch 

Style vµ chän  Driven. Gi¸ trÞ cña kÝch thíc nµy sÏ hiÓn thÞ trong ngoÆc ®¬n. 

§Ó tù ®éng g¸n kÝch thíc rµng buéc thõa, ta chän Tool->Application Options. 

Sau ®ã chän thÎ Sketch, ®¸nh dÊu Apply Driven Dimension. NÕu ®¸nh dÊu vµo hép 

Warn of Overconstrained Condition th× mét hép tho¹i sÏ xuÊt hiÖn, hái cã muèn cËp 

nhËt c¸c kÝch thíc thõa nh lµ c¸c kÝch thíc Driven hay kh«ng hoÆc huû bá lÖnh. 

§Ó cµi ®Æt chÕ ®é cho phÐp nhËp gi¸ trÞ khi ghi kÝch thíc, kÝch Tools -> 

Application Options. TiÕp theo chän thÎ Sketch vµ ®¸nh dÊu vµo Edit Dimension 

When Created. Khi g¸n kÝch thíc ta nhËp gi¸ trÞ cña nã vµo hép Edit Dimension. 

NhÊn phÝm CTRL trong khi g¸n kÝch thíc sÏ bá qua cµi ®Æt nµy. 

 

     Tham sè kÝch thíc 

 

 

 

 

    §¬n vÞ ®o kÝch thíc 

    Gi¸ trÞ kÝch thíc 

H×nh 3.4: Thay ®æi kÝch thíc 

§Ó thay ®æi kÝch thíc, kÝch vµo kÝch thíc nÕu c«ng cô General Dimension 

®ang ho¹t ®éng hoÆc kÝch ®óp vµo kÝch thíc cÇn thay ®æi trong chÕ ®é Select. Ta 

nhËp gi¸ trÞ míi hoÆc nhËp biÓu thøc to¸n häc trong hép tho¹i Edit Dimension. 
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3.4. C¸c c«ng cô vµ biÓu tîng cña SKETCH 

Bé c«ng cô Sketch bao gåm c¸c c«ng cô Sketch  vµ c¸c biÓu tîng rµng buéc. 

3.4.1. C¸c c«ng cô Sketch 

 Mét sè c«ng cô Sketch  cã nhiÒu lùa chän. NÕu cã mòi tªn xuÊt hiÖn bªn c¹nh 

c«ng cô Sketch th× ta kÝch chuét vµo mòi tªn ®Ó më menu lùa chän. 

 

C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 
 

HiÖu chØnh c¸c to¹ ®é cña 

Sketch 

Quay líi (grid) 

 

Line 

 

VÏ ®o¹n th¼ng 

 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 
Spline 

VÏ ®êng Spline  

 

 

 

Circle 

VÏ ®êng trßn biÕt t©m vµ 

b¸n kÝnh. 

VÏ ®êng trßn tiÕp xóc víi 3 

®èi tîng. 

VÏ Ellipse 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 

 

 

Arc 

VÏ cung trßn: 

- §i qua 3 ®iÓm 

- BiÕt t©m vµ 2 ®iÓm cuèi 

- TiÕp xóc víi ®o¹n th¼ng 

hoÆc ®êng cong t¹i ®iÓm 

cuèi cña ®o¹n th¼ng. 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 

 

Rectangle 

VÏ h×nh ch÷ nhËt : 

- qua 2 gãc ®èi diÖn. 

- qua 3 ®Ønh 

 

 
Fillet 

Vª trßn gãc cña Sketch Hép tho¹i nh¾c nhËp b¸n 

kÝnh. 

 
Chamfer 

V¸t gãc cña Sketch §Þnh nghÜa kiÓu v¸t trong 

hép tho¹i. 
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C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 

Point, 

Hole 

Center 

T¹o t©m lç hoÆc mét ®iÓm 

Sketch. 

Chän t©m lç  (mÆc ®Þnh) 

hoÆc ®iÓm Sketch tõ 

menu Style. 

 

Mirror 

§èi xøng ®èi tîng vµ g¸n 

c¸c rµng buéc ®èi xøng. 

 

 

Offset 

T¹o ®êng th¼ng hoÆc cong 

song song vµ c¸ch mét 

kho¶ng cho tríc.  

 

 

General 

Dimension 

G¸n kÝch thíc cho Sketch  

 

Auto 

Dimension 

G¸n kÝch thíc tù ®éng 

®ång thêi rµng buéc hoµn 

toµn mét Sketch. 

Tríc hÕt ph¶i g¸n kÝch 

kh«ng muèn ghi tù ®éng.  

 

Extend 

KÐo dµi ®o¹n th¼ng hoÆc 

®êng cong tíi giao víi 

®o¹n th¼ng, cong hoÆc ®iÓm 

gÇn nhÊt. 

NhÊn phÝm SHIFT ®Ó 

t¹m thêi chuyÓn sang chÕ 

®é TRIM (c¾t). KÝch ho¹t 

chÕ ®é TRIM tõ menu 

ng÷ c¶nh. 

 

Trim 

C¾t bá mét phÇn ®èi tîng. NhÊn phÝm SHIFT ®Ó 

t¹m thêi chuyÓn sang chÕ 

®é EXTEND. KÝch ho¹t 

chÕ ®é EXTEND tõ menu 

ng÷ c¶nh. 

 

Move 

Di chuyÓn hoÆc copy c¸c ®èi 

tîng ®îc nhËp tõ 

AutoCAD hoÆc c¸c ®èi 

tîng Sketch. 

 

 

Rotate 

Quay hoÆc Copy c¸c ®èi 

tîng ®îc nhËp tõ 

AutoCAD hoÆc ®èi tîng 

Sketch. 
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C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 

Add 

Constraint 

T¹o rµng buéc vu«ng gãc  

 
 

T¹o rµng buéc song song  

 
 

T¹o rµng buéc tiÕp xóc cña 

®o¹n th¼ng (cong) víi 

®êng cong. 

 

 
 

T¹o rµng buéc trïng khíp 

gi÷a c¸c ®o¹n th¼ng, cong 

hoÆc c¸c ®iÓm. 

 

 
 

T¹o rµng buéc ®ång t©m 

gi÷a 2 ®êng cong. 

 

 

 

T¹o rµng buéc th¼ng hµng 

gi÷a hai ®o¹n th¼ng hoÆc 2 

trôc. 

 

 
 

T¹o rµng buéc n»m ngang 

cña c¸c ®o¹n th¼ng, c¨n c¸c 

®iÓm theo ph¬ng ngang. 

 

 

 

T¹o rµng buéc th¼ng ®øng, 

c¨n c¸c ®iÓm theo ph¬ng 

th¼ng ®øng 

 

 
 

T¹o rµng buéc chiÒu dµi 

b»ng nhau cña c¸c ®o¹n 

th¼ng hoÆc b¸n kÝnh.  

 

 
 

T¹o rµng buéc cè ®Þnh cho 

c¸c ®iÓm, ®o¹n th¼ng hoÆc 

®êng cong trong hÖ to¹ ®é 

cña Sketch.  

 

 

Show 

Constraint

s 

HiÓn thÞ c¸c rµng buéc ®· 

g¸n. 

§a con trá ®Õn rµng 

buéc, Ên phÝm DELETE 

®Ó xo¸. 

 

Project 

Geometry 

ChiÕu ®èi tîng h×nh häc 

lªn Sketch kh¸c. 
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C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 

Project 

Cut Edges 

ChiÕu tÊt c¶ c¸c c¹nh cña 

chi tiÕt ®· chän lªn mÆt 

ph¼ng Sketch. C¸c c¹nh nµy 

ph¶i giao víi mÆt ph¼ng 

Sketch.  

 

 

Project 

Flat 

Pattern 

ChiÕu m¶ng ®èi tîng 

ph¼ng lªn mÆt ph¼ng 

Sketch 

 

 

Insert 

AutoCAD 

file 

  

3.4.2. C¸c biÓu tîng rµng buéc 

 

BiÓu 

tîng 

Rµng buéc Nh÷ng chØ dÉn ®Æc biÖt 

 

Horizontal  

 

Vertical  

 

Parallel  

 

Perpendicular  

 

Coincident Con trá truy b¾t ®iÓm sÏ ®æi mµu khi 

rµng buéc nµy kÝch ho¹t 

 

Aligned §êng nÐt ®øt hiÓn thÞ ®êng n»m 

ngang hoÆc th¼ng ®øng. 

 

Tangent  
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MÑo 

Ta cã thÓ thùc hiÖn nhanh c¸c lÖnh  cña Autodesk Inventor b»ng c¸c mÑo díi 

®©y: 

Ph¸c th¶o nhanh 

+ Cè g¾ng t¹o Sketch ®¬n gi¶n:  

VÝ dô ®Ó vª trßn c¹nh cña chi tiÕt, kh«ng nªn vª trßn gãc cña Sketch mµ thùc 

hiÖn ®iÒu ®ã sau khi chuyÓn Sketch sang m« h×nh 3D (tøc lµ ta kh«ng fillet sketch mµ 

ta fillet Feature). 

+ Cè g¾ng t¹o Sketch gÇn gièng víi biªn d¹ng mong muèn. 

Sö dông líi ®Ó vÏ. 

+  Hoµn thiÖn vÒ h×nh d¹ng tríc khi g¸n kÝch thíc  

KÐo c¸c ®iÓm mót ®Ó ch¾c ch¾n c¸c rµng buéc cÇn thiÕt ®· ®îc g¸n. ChØnh söa 

®èi tîng h×nh häc sao cho nã cã h×nh d¸ng vµ tû lÖ thÝch hîp. 

+ Sö dông c¸c Style 

Autodesk Inventor t×m c¸c ®èi tîng h×nh häc cã kiÓu Normal khi nã nhËn  mét 

biªn d¹ng hoÆc ®êng dÉn ®Ó t¹o mét Feature. Trong c¸c Sketch phøc t¹p qu¸ tr×nh 

lùa chän biªn d¹ng sÏ nhanh h¬n vµ chÝnh x¸c h¬n nÕu ta chuyÓn toµn bé c¸c ®èi 

tîng tham chiÕu thµnh Construction. 

- C¸c phÝm t¾t khi t¹o Sketch: 

+ B¾t ®Çu ®o¹n th¼ng b»ng c¸ch kÐo mét cung trßn hoÆc mét ®êng trßn.  

KÐo híng kÝnh ®Ó t¹o ®êng vu«ng gãc, kÐo tiÕp tuyÕn ®Ó t¹o ®êng tiÕp 

tuyÕn. 

 + B¾t ®Çu ®äan th¼ng b»ng c¸ch kÐo mét ®iÓm bªn trong ®êng th¼ng kh¸c 

(kh«ng ph¶i lµ c¸c ®iÓm mót). §êng th¼ng míi sÏ ®îc rµng buéc vu«ng gãc víi 

®êng th¼ng cã s½n. 

 + T¹o mét cung trßn b»ng c¸ch kÐo ®iÓm cuèi cña ®o¹n th¼ng.  

§a con trá vÒ ®iÓm cuèi cña ®o¹n th¼ng ®Ó thay ®æi híng cña cung trßn. 

 + B¾t ®Çu mét ®êng Spline tiÕp xóc víi mét ®o¹n th¼ng b»ng c¸ch kÐo ®o¹n  

th¼ng. Chän ®iÓm cuèi cña ®o¹n th¼ng, sau ®ã kÐo nã theo ph¬ng tiÕp tuyÕn ®Ó kÕt 

thóc Spline tiÕp xóc víi ®o¹n th¼ng. 

 + T¹o c¸c rµng buéc trïng nhau. 

 Khi ta b¾t ®Çu mét ®êng th¼ng, mét cung trßn hoÆc mét ®êng trßn míi tõ 

mét ®êng th¼ng cã s½n, Autodesk Inventor cã thÓ suy ra c¸c rµng buéc trïng khíp 

víi ®iÓm gi÷a, ®iÓm cuèi hoÆc ®iÓm bªn trong cña ®o¹n th¼ng. 
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 + Bæ sung c¸c ®iÓm gi÷a (Midpoint) tíi ®o¹n th¼ng.  

KÝch vµo c«ng cô Point vµ chän kiÓu Sketch. ChØ thÞ b¾t dÝnh ®æi mµu khi ta 

kÝch vµo ®iÓm gi÷a cña ®o¹n th¼ng. Ta còng cã thÓ kÐo mét ®iÓm cã s½n tíi ®iÓm 

gi÷a cña ®o¹n th¼ng. 

 - C¸c phÝm t¾t ®Ó chØnh söa c¸c ®èi tîng h×nh häc:   

 + Dïng phÝm SHIFT ®Ó kÐo.  

TÊt c¶ c¸c tiÖn Ých kÐo, trõ Spline tiÕp tuyÕn ®îc kÝch ho¹t b»ng c¸ch nhÊn vµ 

gi÷ phÝm SHIFT trong khi di chuyÓn con trá. 

 + KÐo nhiÒu ®êng th¼ng, cung trßn hoÆc c¸c ®iÓm cïng mét lóc.  

Chän c¸c ®èi tîng h×nh häc trong khi gi÷ phÝm CTRL sau ®ã kÐo ®èi tîng 

chän cuèi cïng. 

 + ChuyÓn ®æi gi÷a c«ng cô Trim vµ c«ng cô Extend:  

NhÊn phÝm SHIFT hoÆc chän c«ng cô kh¸c tõ menu ng÷ c¶nh ®Ó chuyÓn ®æi 

c«ng cô Trim vµ Extend. 

 - C¸c kü thuËt xö lý rµng buéc n©ng cao.    

  + T¾t c¸c rµng buéc tù ®éng.  

NhÊn vµ gi÷ phÝm CTRL trong khi ph¸c th¶o. 

 + Chän ®êng cong cho rµng buéc. 

DÞch chuyÓn con trá trªn ®èi tîng h×nh häc ta cÇn rµng buéc trong khi ph¸c 

th¶o.  

+ §Þnh nghÜa c¸c kÝch thíc b»ng c¸c biÓu thøc:  

KÝch ®óp kÝch thíc ®Ó më hép tho¹i Edit Dimension. KÝch vµo ®èi tîng h×nh 

häc cÇn tham chiÕu vµ kÝch thíc cña nã sÏ hiÖn trªn hép tho¹i. Ta cã thÓ ®Þnh nghÜa 

kÝch thíc b»ng biÓu thøc to¸n häc ( vÝ dô D1*2). 

+ Ghi ®Ì ®¬n vÞ ®o cña mét kÝch thíc ®¬n lÎ.  

 VÝ dô, trong file part ®· ®Æt kÝch thíc theo hÖ mÐt, ta cã thÓ nhËp vµo 1 inch 

trong hép tho¹i Edit Dimension. 
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CHƯƠNG 3 

3D Sketch 
 

Ch¬ng nµy giíi thiÖu vÒ m«i trêng vÏ 3D Sketch, c¸c c«ng cô vµ thø tù thùc 

hiÖn khi vÏ Sketch 3D cho c¸c chi tiÕt d¹ng ®êng dÉn. Xem nh÷ng th«ng tin tham 

kh¶o ®Çy ®ñ h¬n, c¸c vÝ dô tr×nh diÔn, c¸c chØ dÉn tõng bíc trong trî gióp trùc 

tuyÕn (online Help) hoÆc Tutorial.    

3.1. Giíi thiÖu chung 

C¸c chi tiÕt d¹ng ®êng dÉn ®îc sö dông ®Ó t¹o c¸c ®êng èng, c¸p, vµ c¸c 

lo¹i d©y ch¹y qua c¸c chi tiÕt trong côm l¾p r¸p. M«i trêng 3D Sketch trong 

Autodesk Inventor t¹o ra c¸c chi tiÕt d©y trong côm l¾p r¸p ®îc thùc hiÖn ®¬n gi¶n 

vµ dÔ dµng. Ta cã thÓ lµm viÖc víi mét l¾p r¸p ®Ó t¹o ra ®êng dÉn (path) cho c¸c 

Feature d¹ng 3D  Sweep hoÆc 3D Loft  vµ dÔ dµng tham chiÕu ®Õn  ®èi tîng l¾p r¸p 

®· cã ®Ó ®Þnh vÞ cho nã. 

 

- T¹i sao l¹i sö dông m«i trêng Sketch 3D     

Ta cã thÓ tiÕt kiÖm thêi gian, t¨ng hiÖu qu¶ lµm viÖc khi ta lµm viÖc trong mét 

l¾p r¸p ®Ó t¹o c¸c ®êng dÉn 3D m« t¶ c¸c chi tiÕt d¹ng khung d©y, c¸c ®êng èng, 

c¸c ®êng c¸p vµ ®Þnh vÞ chóng b»ng c¸ch sö dông c¸c ®iÓm lµm viÖc(Work Point) 

thÝch nghi tõ c¸c thµnh phÇn l¾p r¸p cã s½n. Ta còng cã thÓ ®Þnh nghÜa mét ®êng 

dÉn 3D cho c¸c Feature d¹ng èng bªn trong mét chi tiÕt ®¬n lÎ.  

 

- Ta cã thÓ t×m c¸c c«ng cô t¹o 3D Sketch ë ®©u.  

Khi t¹o 3D Sketch mét biÓu tîng Sketch sÏ ®îc hiÓn thÞ trong cöa sæ duyÖt. 

Sau khi t¹o ®îc chi tiÕt tõ 3D Sketch, mét biÓu tîng chi tiÕt sÏ ®îc xuÊt hiÖn 

vµ phÝa díi lµ biÓu tîng cña 3D Sketch.   

3.2. C¸c tiÖn Ých 

Díi ®©y lµ mét sè tiÖn Ých quan träng cã s½n trong m«i trêng 3D Sketch. 

3D Sketch:  

Cã thÓ ph¸c th¶o mét ®êng 3D hoÆc c¸c ®o¹n 3D riªng biÖt theo bÊt kú tr×nh 

tù nµo sau ®ã hîp nhÊt chóng víi  ®èi tîng h×nh häc 2D Sketch ®îc chÌn. 

Include Geometry:  

Cã thÓ chiÕu mét ®èi tîng h×nh häc 2D Sketch tõ mét m« h×nh ®îc khëi t¹o 

tríc thµnh 3D Sketch. 
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AutoBend:  

Cã thÓ t¹o uèn gi÷a c¸c ®o¹n kÒ nhau mét c¸ch tù ®éng khi t¹o Sketch. 

 

Adaptive work Feature:  

Cã thÓ tham kh¶o ®èi tîng h×nh häc trªn c¸c chi tiÕt kh¸c khi ®Æt c¸c ®iÓm 

thÝch nghi cho c¸c ®êng 3D  dïng trong c¸c ®êng dÉn. 

 

3.3. Tr×nh tù lµm viÖc. 

Díi ®©y lµ tæng quan vÒ c¸ch khëi t¹o vµ chØnh söa mét Feature d¹ng ®êng 

èng 3D vµ c¸c bíc thùc hiÖn. 

- LËp tr×nh tù thùc hiÖn. 

§Ó t¹o mét Sweep Feature, cÇn ®Þnh nghÜa 2D Sketch, ®Þnh nghÜa ®êng dÉn 

3D (3D path), sau ®ã dïng lÖnh Sweep ®Ó Sweep biªn d¹ng 2D theo ®êng dÉn 3D 

®ã. 

Ph¬ng ph¸p t¹o ®êng dÉn 3D  thêng phô thuéc chñ yÕu vµo chi tiÕt cÇn t¹o 

ra. §èi víi d¹ng èng ta cã thÓ dïng c¸c ®o¹n th¼ng hoÆc c¸c cung trßn kÕt nèi víi 

nhau ®Ó t¹o ®êng dÉn 3D, ®èi víi d¹ng chi tiÕt khung d©y th× sö dông c¸c ®êng 

spline mµ thêng ®îc ®Þnh nghÜa bëi c¸c ®iÓm trªn mét sè mÆt ph¼ng lµm viÖc. Chi 

tiÕt d¹ng c¸p th× rÊt gièng d¹ng khung d©y vµ còng cã thÓ ®Þnh nghÜa  bëi mét ®êng 

spline trõ trêng hîp nã ®· cã mét c¹nh spline. 

Sö dông  lÖnh 3D Line, cã thÓ t¹o sè lîng bÊt kú c¸c ®o¹n th¼ng qua 2 ®iÓm 

hoÆc ®êng dÉn 3D liªn tôc ®¬n kÕt nèi c¸c ®iÓm lµm viÖc ®Ó t¹o 3D Sketch. 

Cã thÓ gép c¸c ®èi tîng h×nh häc cã s½n vµo 3D Sketch vµ cã thÓ tæ hîp mét 

®êng dÉn 2D vµo ®êng dÉn 3D vµ b»ng c¸ch chiÕu 2D Sketch lªn bÒ mÆt cña chi 

tiÕt 3D. C¸c ®o¹n uèn sÏ ®îc thªm vµo ë c¸c gãc b»ng tay hoÆc tù ®éng. 

Cã thÓ sö dông c¸c ®iÓm lµm viÖc bï thÝch nghi ®· ®îc khëi t¹o trªn c¸c chi 

tiÕt kh¸c ®Ó ®Þnh vÞ c¸c ®êng dÉn 3D. 

§iÒu nµy cho thÊy r»ng cã thÓ t¹o c¸c Feature d¹ng 3D Sweep theo c¸c bíc 

díi ®©y: 

1. T¹o bÊt kú c¸c bé phËn vµ c¸c ph¸c th¶o 2D  cÇn thiÕt mµ ta sÏ cÇn cã ®Ó 

chÌn vµo 3D Sketch, vÝ dô nh biªn d¹ng 2D ®Ó Sweep biªn d¹ng 2D theo ®êng dÉn 

3D. 

2. G¸n b¸n kÝnh uèn cña 3D Sketch vµ c¸c gi¸ trÞ b¾t dÝnh 3D trong Tools-

>Document Settings. 

3. T¹o c¸c ®iÓm lµm viÖc thÝch nghi trªn c¸c chi tiÕt kh¸c ®Ó ®Þnh vÞ  ®êng 3D. 
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4. NÕu cÇn bao gåm  ®èi tîng h×nh häc tõ c¸c thµnh phÇn l¾p r¸p cã s½n kh¸c 

cho c¸c bé phËn cña h×nh d¸ng ®êng dÉn th× chiÕu nã lªn 3D Sketch. 

5. Ph¸c th¶o h×nh d¹ng ®êng dÉn, b¾t dÝnh tíi c¸c ®iÓm lµm viÖc, c¸c ®iÓm 

th¼ng ®øng vµ c¸c ®iÓm nót cña c¸c ®o¹n ®èi tîng h×nh häc ®îc bao gåm.  

6. G¸n c¸c ®o¹n uèn ë gãc tiÕp tuyÕn b»ng c¸ch sö dông c«ng cô Bend ë chÕ ®é 

3D Sketch. 

7. KÝch chuét ph¶i chän Finish 3D Sketch. 

8. T¹o biªn d¹ng 2D  trªn mÆt ph¼ng vu«ng gãc víi ph¸c th¶o ®êng dÉn. 

9. Sö dông c«ng cô Sweep ®Ó chän biªn d¹ng 2D  vµ 3D Sketch. 

10. §Þnh nghÜa c¸c tham sè Sweep cßn l¹i vµ kÝch OK ®Ó t¹o Sweep Feature.     

 

3.4. Ph¸c th¶o c¸c ®êng dÉn 3D 

B»ng c¸c c«ng cô trong thanh c«ng cô 3D Sketch ta cã thÓ ph¸c th¶o ®êng dÉn 

3D vµ ®Þnh vÞ chóng trong l¾p r¸p. NÕu ta cã ý ®Þnh gép ®èi tîng 2D vµo 3D Sketch 

ta cã thÓ t¹o ®èi tîng 2D tríc khi t¹o 3D Sketch. 

§Ó t¹o ®êng dÉn 3D:  

B¾t ®Çu trong file l¾p r¸p. KÝch vµo menu Insert->New Component. Trong file 

chi tiÕt míi, ph¸c th¶o vµ ®ïn mét biªn d¹ng. Trªn thanh Command më réng nót 

Sketch vµ chän 3D Sketch. T¹o c¸c Work Feature vµ ®èi tîng 3D Sketch cho ®êng 

dÉn , gép c¸c ®èi tîng 2D cÇn thiÕt. 

T¹o ®êng 3D:  

KÝch 3D Sketch trªn thanh Command. KÝch chän c«ng cô 3D Line trªn thanh 

c«ng cô 3D Sketch. KÝch ph¶i chuét vµ g¸n tuú chän Auto-Bend ®Ó tù ®éng t¹o uèn 

cong t¹i c¸c gãc. Ph¸c th¶o ®êng dÉn vµ chän c¸c ®iÓm lµm viÖc, c¸c ®iÓm th¼ng 

®øng vµ c¸c ®iÓm 3D Sketch trong 3D Sketch hiÖn hµnh. NÕu ta cÇn ®Ëp g·y mét 

®êng  kÝch chuét vµo ®iÓm cuèi cña nã. KÝch chuét ph¶i vµ chän Restart sau ®ã 

kÝch chän ®iÓm phï hîp ®Ó b¾t ®Çu mét ®êng kh¸c. 

Gép ®èi tîng h×nh häc vµo 3D Sketch:  

KÝch chuét vµo c«ng cô Include Geometry, tiÕp theo kÝch vµo c¸c c¹nh cña m« 

h×nh vµ ®èi tîng h×nh häc cña 2D Sketch ®Ó chÌn. §Ó kÕt thóc kÝch chuét ph¶i chän 

Done. 

ChØnh söa 3D Sketch:  

KÝch chuét ph¶i vµo Sketch trong cöa sæ duyÖt vµ chØnh söa c¸c ®êng vµ  ®o¹n 

uèn cong nÕu cÇn.  NÕu chØnh söa c¸c chi tiÕt cã s½n vµ lo¹i bá ®èi tîng h×nh häc 

hoÆc chi tiÕt mµ cã rµng buéc víi ®êng dÉn, ta sö dông Redefine Point  ®Ó rµng 

buéc l¹i c¸c ®êng th¼ng 3D Sketch  tíi c¸c ®iÓm phï hîp (valid) hoÆc c¸c ®iÓm 

th¼ng ®øng. 
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3.5. T¹o uèn cong trong c¸c ®êng dÉn 3D 

Ta cã thÓ t¹o uèn cong trong c¸c ®êng 3D b»ng tay hoÆc tù ®éng b»ng ®Æc 

tÝnh Auto-Bend. §Ó g¸n uèn cong b»ng tay, ta b¾t ®Çu tõ ®èi tîng 3D Sketch cã 

s½n. Khi ta sö dông Auto-Bend, c¸c ®o¹n uèn  ®îc t¹o ra tù ®éng trong khi ph¸c 

th¶o ®èi tîng h×nh häc 3D. 

§Ó  g¸n ®o¹n uèn cong trªn ®êng 3D b»ng tay:  

§Ó  g¸n ®o¹n uèn cong trªn ®êng 3D b»ng tay th× hoÆc lµ t¹o c¸c  ®èi tîng 3D 

Sketch  hoÆc lµ kÝch chän  biÓu tîng 3D Sketch trong cöa sæ duyÖt vµ chän Edit. Sö 

dông c«ng cô Bend ®Ó g¸n b¸n kÝnh cong vµ ®Þnh nghÜa c¸c ®o¹n uèn cong. Chän 

c¸c ®êng 3D, c¸c ®iÓm ph¸c th¶o hoÆc gép ®èi tîng 2D mµ xuÊt hiÖn t¹i gãc. 

§Ó tù ®éng t¹o c¸c ®o¹n uèn cong trªn ®êng th¼ng 3D:  

Tríc hÕt ta ®Æt 2 tham sè Auto-Bend. §èi víi c¸c tham sè hÖ thèng, kÝch chän 

Tools->Document Settings->Sketch Tab, ®¸nh dÊu vµo hép kiÓm Auto-Bend with 3D 

Line Creation. §Ó ®Æt tham sè cho file hiÖn hµnh kÝch chuét vµo Tools->Document 

Settings->Sketch tab. Trong hép 3D Sketch, nhËp b¸n kÝnh Auto-Bend  vµ chän OK. 

Khi ta dïng c«ng cô 3D Line ®Ó t¹o ®êng th¼ng 3D, c¸c ®o¹n uèn cong sÏ tù ®éng 

t¹o ra bæ sung vµo c¸c gãc. 

 

Chó ý: NÕu ta xo¸ mét ®o¹n uèn  cong hoÆc b¸n kÝnh cña ®o¹n uèn cong 

qu¸ lín ®Ó ®iÒu chØnh c¸c ®o¹n cho võa th× gãc trong ®êng 3D  bÞ trë l¹i. 

 

3.6. §Þnh vÞ trÝ cho c¸c ®êng dÉn 3D  

Ta t¹o Sketch 3D b»ng c¸ch liªn kÕt c¸c ®iÓm lµm viÖc víi nhau. C¸c ®iÓm lµm 

viÖc nµy cã thÓ ®îc offset tõ c¸c thµnh phÇn cã s½n cña l¾p r¸p sö dông  c¸c ®iÓm 

offset gãc mµ ®· ®îc thÝch nghi. Sau khi c¸c ®iÓm ®· ®îc t¹o ra, ta cã thÓ sö dông 

c«ng cô AutoHide ®Ó che khuÊt tÊt c¶ trõ Work Feature hiÖn hµnh. 
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3.7. C¸c c«ng cô 3D  Sketch 

C¸c c«ng cô 3D Sketch th× t¬ng tù víi mét vµi c«ng cô cã s½n trong 2D Sketch 

vµ trong m« h×nh chi tiÕt. 

 

3D Sketch Tools 

Nót C«ng cô Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc 

biÖt 

 

§êng th¼ng 

3D  

T¹o c¸c ®o¹n th¼ng 

3D ®i qua c¸c ®iÓm lµm 

viÖc ®îc lùa chän s½n, c¸c 

®iÓm th¼ng ®øng vµ ®èi 

tîng h×nh häc  

KÝch chän ®Ó 

bÎ g·y ®êng 

th¼ng, kÝch ph¶i 

chuét vµ chän 

Restart ®Ó b¾t ®Çu 

®êng th¼ng míi. 

 

MÆt cong( 

Bend)  

G¸n b¸n kÝnh vµ kÝch 

thíc mÆc ®Þnh cña mÆt 

cong cho c¸c gãc ®· chän.  

 

 

bæ sung ®èi 

tîng h×nh häc 

ChÌn 2D Sketch vµo 

3D Sketch 

 

 

MÆt ph¼ng 

lµm viÖc 

T¹o mÆt ph¼ng lµm 

viÖc 

 

 

§êng trôc 

lµm viÖc 

T¹o ®êng trôc lµm 

viÖc 

 

 

§iÓm lµm 

viÖc 

C¸c ®iÓm ®Þnh vÞ cã 

liªn hÖ víi ®èi tîng h×nh 

häc trªn c¸c Feature kh¸c.  

 

 

MÑo: 

Ta cã thÓ n©ng cao hiÖu qu¶ vµ tèi u viÖc thùc hiÖn cña Autodesk Inventor 

b»ng c¸c kü n¨ng sau ®©y: 

- Khi ta cã ý ®Þnh gép ®èi tîng h×nh häc 2D vµo 3D Sketch, ta t¹o ®èi tîng 

h×nh häc 2D  tríc khi t¹o 3D Sketch. 

- T¹o biªn d¹ng 2D sau khi t¹o 3D Sketch. 

- Khi lµm viÖc trong m«i trêng l¾p r¸p, ta t¹o file chi tiÕt riªng cho Feature 3D 

Sweep. 
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- Sö dông c¸c Work Feature  thÝch nghi tham chiÕu  tõ c¸c chi tiÕt kh¸c ®Ó dÞnh 

vÞ c¸c ®iÓm cho c¸c ®êng 3D. 

- §Ó ®¬n gi¶n khi hiÓn thÞ 3D Sketch, dïng tuú chän Auto-Hide  trªn 

Application Tools->Part tab. 
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CHƯƠNG 4 

ThiÕt kÕ m« h×nh chi tiÕt 

(Part model) 

 

Ch¬ng nµy sÏ giíi thiÖu tæng quan vÒ c¸c kh¸i niÖm, c¸ch sö dông c¸c c«ng 

cô t¹o c¸c Feature vµ tr×nh tù thùc hiÖn trong m«i trêng thiÕt kÕ m« h×nh chi tiÕt ( 

Part Model). §Ó tham kh¶o thªm vÒ c¸c vÝ dô tr×nh diÔn, chØ dÉn tr×nh tù c¸c bíc ta 

cã thÓ sö dông trî gióp trùc tuyÕn (onlin Help), Tutorials vµ Visual SyllabusTM. 

3.1. Giíi thiÖu chung: 

M« h×nh chi tiÕt (Part Model) lµ tËp hîp c¸c Feature, hÇu hÕt c¸c Feature nµy 

®îc t¹o ra tõ  ph¸c th¶o (Sketch). C¸c Feature liªn kÕt víi mét Feature kh¸c theo 

tr×nh tù chóng t¹o ra.  Cã rÊt nhiÒu c¸ch ®Ó t¹o m« h×nh chi tiÕt. LËp kÕ ho¹ch lµm 

viÖc tèt sÏ gióp ta t¹o lËp vµ chØnh söa m« h×nh tèt h¬n. 

- M« h×nh chi tiÕt 3D (3D Part Model) lµ g× ?  

M« h×nh chi tiÕt 3D cã thÓ ®îc t¹o b»ng c¸ch Extrude, Sweep hoÆc Project mét 

®èi tîng h×nh häc ph¸c th¶o (Sketch) theo mét ®êng dÉn hoÆc quay nã quanh mét 

trôc. C¸c m« h×nh nµy thêng ®îc gäi lµ c¸c Solid (vËt ®Æc) bëi v× chóng cã bao 

gåm khèi lîng, kh«ng gièng nh m« h×nh khung d©y (Wireframe Model) nh÷ng m« 

h×nh chØ ®îc ®Þnh nghÜa b»ng c¸c c¹nh.  

C¸c m« h×nh Solid trong Autodesk Inventor lµ Feature-based vµ Persistent.   

+ Feature-based cã nghÜa lµ chi tiÕt lµ tæ hîp cña c¸c Feature nh lµ: C¸c Hole 

(lç), Flange (Gê mÐp), Fillet (vª trßn), Boss (vÊu låi). Víi Autodesk Inventor ta cã thÓ 

t¹o c¸c chi tiÕt dùa trªn c¸c chøc n¨ng cña chóng. 

+ Persistent cã nghÜa lµ ta cã thÓ thay ®æi c¸c ®Æc ®iÓm cña Feature b»ng c¸ch trë 

l¹i thay ®æi Sketch cña Feature ®ã hoÆc thay ®æi gi¸ trÞ c¸c tham sè ®îc sö dông 

trong lÖnh t¹o ra Feature ®ã. VÝ dô, ta cã thÓ thay ®æi chiÒu dµi cña mét Extruded 

Feature b»ng c¸ch nhËp vµo gi¸ trÞ míi cho trêng Extent cña lÖnh Extrude Feature 

nµy. Ta còng cã thÓ dïng c¸c biÓu thøc ®Ó lÊy ra gi¸ trÞ kÝch thíc tõ kÝch thíc 

kh¸c.  

 

- Feature lµ g× ? 

Feature lµ mét bé phËn riªng cña chi tiÕt mµ cã thÓ ®îc chØnh söa bÊt kú khi 

nµo. Cã 4 lo¹i Feature: Sketched Feature, Placed Feature, Pattern Feature vµ Work 

Feature. 
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+ Sketched Feature ®îc t¹o ra dùa trªn mét ph¸c th¶o h×nh häc(Sketch) vµ ®îc 

®Þnh nghÜa bëi c¸c gi¸ trÞ tham sè ta nhËp vµo khi thùc hiÖn lÖnh t¹o Feature. Ta cã 

thÓ thay ®æi gi¸ trÞ c¸c tham sè cña Feature vµ cña ph¸c th¶o h×nh häc. 

+ Placed Feature, vÝ dô nh Fillet ( vª trßn gãc) hoÆc Chamfer (v¸t gãc)... lµ c¸c 

Feature  kh«ng ®ßi hái mét ph¸c th¶o cña riªng nã. §Ó t¹o mét Fillet ta cã thÓ nhËp 

vµo b¸n kÝnh vª trßn vµ chän mét c¹nh. C¸c Placed Feature  chuÈn gåm cã: Shell, 

Fillet hoÆc Round, Chamfer vµ Face draft. 

+ Pattern Feature lµ mét m¶ng c¸c Feature hoÆc mét nhãm c¸c Feature. Cã thÓ 

Èn sù xuÊt hiÖn cña c¸c thµnh phÇn riªng trong Pattern nÕu cÇn thiÕt. 

+ Work Feature lµ Work Plane, Work Axis, Work Point. Work Feature cã thÓ 

x¸c ®Þnh vÞ trÝ vµ híng cña c¸c Feature. VÝ dô, ta cã thÓ t¹o mét Work Plane t¹o víi 

mét mÆt cña chi tiÕt (mÆt A) mét gãc nhÊt ®Þnh. NÕu mÆt A thay ®æi th× Work Plane 

vµ c¸c Feature liªn quan tíi Work Plane còng sÏ bÞ thay ®æi. NÕu ta thay ®æi gãc 

gi÷a Work Plane víi mÆt A th× c¸c Feature liªn quan sÏ thay ®æi t¬ng øng víi 

híng míi. 

- Khi nµo ta sö dông m«i trêng Part Model? 

 M«i trêng Part Model ®îc kÝch ho¹t bÊt kú khi nµo ta t¹o hoÆc chØnh söa chi 

tiÕt. Ta sö dông m«i trêng Part Model ®Ó t¹o hoÆc chØnh söa c¸c Feature, ®Þnh 

nghÜa c¸c Work Feature, t¹o c¸c Pattern vµ kÕt hîp c¸c Feature ®Ó t¹o thµnh chi 

tiÕt. Dïng Browser (cöa sæ duyÖt) ®Ó chØnh söa c¸c Sketch hoÆc c¸c Feature, Èn hoÆc 

hiÖn c¸c Feature, t¹o c¸c ghi chó thiÕt kÕ, t¹o c¸c Feature thÝch nghi vµ truy cËp vµo 

c¸c thuéc tÝnh. 

- Ta cã thÓ t×m Part Model ë ®©u ? 

Khi më file Part, Part lµ môc trªn ®Ønh trong Browser. Khi më file Assembly mçi 

chi tiÕt ®îc liÖt kª riªng. 

Ta cã thÓ t×m c¸c Feature ®îc liÖt kª díi biÓu tîng Part trong Browser. §Ó 

chØnh söa mét Feature, kÝch chuét ph¶i trong Browser hoÆc cöa sæ ®å ho¹. Tõ menu 

ng÷ c¶nh ta cã thÓ chän Edit Feature ®Ó ®a ra c¸c tham sè t¹o Feature hoÆc chän  

Edit Sketch ®Ó ®a ra c¸c tham sè t¹o Sketch. 

3.2. C¸c tiÖn Ých: 

Danh s¸ch díi ®©y nªu mét vµi tiÖn Ých dïng trong m«i trêng t¹o m« h×nh chi 

tiÕt ®Ó t¹o chi tiÕt. 

- Feature preview: xem tríc Feature tríc khi t¹o. 

- Feature Editing: ChØnh söa h×nh d¸ng bªn ngoµi cña Feature. 

- Work Features: Chän trùc tiÕp ®èi tîng h×nh häc ®Ó t¹o c¸c Work Feature 
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- Derived parts: T¹o mét chi tiÕt dÉn xuÊt tõ mét chi tiÕt c¬ së hoÆc mét thµnh 

phÇn trong l¾p r¸p. 

- Component color: gµn mµu vµ chÊt lîng t« bãng cho chi tiÕt vµ g¸n mµu 

trong suèt nh thuû tinh khi cã mét chi tiÕt kh¸c Èn sau nã. 

- Surface design: Dùng c¸c h×nh phøc t¹p cña c¸c chi tiÕt chÊt dÎo vµ t¨ng ®é 

chÝnh x¸c vµ n¨ng suÊt. 

3.3. Tr×nh tù thùc hiÖn: 

Sketch ban ®Çu ®Ó t¹o chi tiÕt cã thÓ cã h×nh d¸ng ®¬n gi¶n ®Ó dÔ t¹o dùng. Sau 

®ã ta bæ sung c¸c Feature, chóng ta cã thÓ chØnh söa sao cho ta cã thÓ hoµn thiÖn 

thiÕt kÕ nhanh. Toµn bé qu¸ tr×nh thiÕt kÕ gåm cã bæ sung c¸c ®èi tîng h×nh häc, 

c¸c chi tiÕt vÒ kÝch thíc, c¸c rµng buéc ®Ó hoµn chØnh m« h×nh. §¸nh gi¸ thiÕt kÕ 

b»ng c¸ch thay ®æi c¸c quan hÖ vµ c¸c rµng buéc hoÆc bæ sung vµ lo¹i bá c¸c 

Feature. 

3.4. LËp kÕ ho¹ch lµm viÖc: 

Feature ®Çu tiªn t¹o dùng lµ Feature c¬ së. Sau ®ã ta cã thÓ t¹o c¸c Feature bæ 

sung ®Ó hoµn thiÖn thiÕt kÕ. V× c¸c Feature nµy phô thuéc trªn Feature c¬ së nªn lËp 

kÕ ho¹ch lµm viÖc tèt cã thÓ gi¶m râ rÖt thêi gian thiÕt kÕ mét chi tiÕt. 

 

 

 

 

 

 

 

 

 

 

 

 

Chi tiÕt hoµn chØnh C¸c Feature con bÞ c¾t bá 

 

 Mét sè ®iÓm cÇn lu ý tríc khi t¹o lËp m« h×nh chi tiÕt: 

- CÇn chØ râ ®iÓm nh×n nµo lµ tèt nhÊt:  

Lµ ®iÓm nh×n mµ Feature c¬ së thêng lµ Feature næi bËt nhÊt trong ®iÓm nh×n 

nµy. 

- ChØ ra nh÷ng Feature quan träng nhÊt trong m« h×nh chi tiÕt:  
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Nh÷ng Feature nµy  t¹o lËp tríc trªn c¬ së ®ã t¹o lËp c¸c chi tiÕt cßn l¹i. 

- ChØ ra nh÷ng Feature nµo yªu cÇu cã ph¸c th¶o, nh÷ng Feature nµo cã thÓ 

thay thÕ:  

C¶ m« h×nh mÆt vµ m« h×nh solid ®Òu cã thÓ ®îc ®ïn tõ mét ph¸c th¶o. Tuy 

nhiªn c¸c Feature nh fillet, chamfer th× hoµn toµn kh«ng ®ßi hái ph¸c th¶o. 

- Cã thÓ dïng c¸c mÆt ph¼ng to¹ ®é vµ gèc to¹ ®é cho thuËn tiÖn kh«ng? 

VÝ dô, nÕu ta t¹o mét trôc cã ®êng t©m t¹i gèc to¹ ®é, ta cã thÓ sö dông 

mét 

trong c¸c mÆt ph¼ng to¹ ®é tõ browser ®Ó ph¸c th¶o    

- Lîi Ých cña viÖc g¸n c¸c kiÓu mµu kh¸c nhau cho c¸c chi tiÕt kh¸c nhau: 

  Mµu s¾c vµ ®é s¸ng cã thÓ gióp ph©n biÖt chi tiÕt nµy víi chi tiÕt kh¸c. 

 

 

 3.5. T¹o lËp c¸c chi tiÕt míi 

Khi ta t¹o mét chi tiÕt míi ta cã thÓ chän tõ mét sè biÓu mÉu (template) cã s½n 

víi ®¬n vÞ ®o ®îc ®Þnh nghÜa tríc. Mét biÓu mÉu cã thÓ chøa c¸c th«ng tin vÒ 

thuéc tÝnh cã s½n nh c¸c thuéc tÝnh vÒ vËt liÖu,  c¸c th«ng tin vÒ ®Ò ¸n. 

C¸c biÓu mÉu ®îc lu tr÷ trong th môc Autodesk\Inventor4\Templates hoÆc 

trong c¸c th môc con  English hoÆc Metric. C¸c th môc con trong th môc 

Templates ®îc hiÓn thÞ nh c¸c nót Tabs trong hép tho¹i New.  

- §Ó t¹o mét chi tiÕt míi:  

Chän mét biÓu mÉu t¹o chi tiÕt tõ hép tho¹i New hoÆc kÝch chuét vµo mòi tªn 

c¹nh nót New sau ®ã chän Part tõ menu më réng. §Ó më hép tho¹i New cã thÓ chän 

New tõ cöa sæ Getting Started hoÆc kÝch vµo nót New trªn thanh c«ng cô chuÈn hoÆc 

chän File sau ®ã chän New. 

Chó ý:  

NÕu chän Part tõ menu më réng bªn trong nót New biÓu mÉu Part chuÈn sÏ 

®îc më. NÕu file Standard.ipt kh«ng cã trong th môc 

Autodesk\Inventor\Templates th× mét hép tho¹i th«ng b¸o lçi sÏ xuÊt hiÖn. 

- C¸ch t¹o mét biÓu mÉu (Template):  

Më mét file chi tiÕt (Part) vµ söa l¹i nh÷ng th«ng tin cÇn thiÕt sau ®ã chän File, 

chän Save Copy As ®Ó ghi vµo trong th môc Autodesk\Inventor4\Templates. NÕu 

t¹o mét Folder míi trong th môc Templates th× th môc ®ã sÏ xuÊt hiÖn nh lµ mét 

nót Tab trong hép tho¹i New. 

- §Þnh nghÜa c¸c thuéc tÝnh cho chi tiÕt: 
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 Chän File ->Properties. NhËp c¸c th«ng tin diÔn t¶ ®Þnh nghÜa chi tiÕt nh c¸c 

d÷ liÖu vÒ ®Ò ¸n vµ chi tiÕt, c¸c thuéc tÝnh vÒ vËt liÖu, ®¬n vÞ ®o, t×nh tr¹ng chi tiÕt... 

Nh÷ng th«ng tin trªn c¸c Tab Summary, Project, Status vµ Custom còng cã  ë bªn 

ngoµi Autodesk Inventor th«ng qua Design Assistant hoÆc Microsoft  Windows  

Explorer. 

Chó ý: ®Ó biÕt thªm th«ng tin vÒ Design Assistant xem “ Design Assistant”   

 

 

 

- Bæ sung mµu cho Feature :  

Trong cöa sæ duyÖt kÝch chuét ph¶i vµo mét Feature vµ chän Properties. Trong 

Feature Color chän mét mµu míi. 

3.6. T¹o c¸c Feature c¬ së: 

Sau khi lËp kÕ ho¹ch thø tù c¸c bíc, ta quyÕt ®Þnh c¸ch t¹o chi tiÕt c¬ së.  Cã 

thÓ dïng hai c¸ch c¬ b¶n lµ Extrude vµ Revolve. Ta cã thÓ dïng Extrude ®Ó t¹o c¸c 

mÆt nh lµ khi ta dïng nã ®Ó t¹o c¸c solid. Ta còng cã thÓ dïng Loft, Sweep hoÆc lµ 

Coil. 

- Extrude lµ ®ïn mét tiÕt diÖn däc theo mét ®êng th¼ng. 

- Revolve lµ quay liªn tôc mét tiÕt diÖn quanh 1 trôc. 

- Loft t¹o dùng Feature b»ng c¸ch ®ïn qua c¸c thiÕt diÖn thay ®æi. Ta cã 

thÓ t¹o c¸c ph¸c th¶o trªn nhiÒu mÆt lµm viÖc. Loft t¹o ra m« h×nh ®îc ®ïn tõ mét 

biªn d¹ng tíi mét biªn d¹ng tiÕp theo. Loft cã thÓ ®ïn theo mét ®êng cong. 

- Sweep ®ïn mét tiÕt diÖn kh«ng ®æi theo mét ®êng cong. 

- Coil ®ïn mét tiÕt diÖn kh«ng ®æi theo mét ®êng xo¾n èc. 

§Ó t¹o mét Feature c¬ së: 

1. Më trùc tiÕp mét file Part míi hoÆc t¹o mét Part trong file l¾p r¸p. 

2. T¹o mét ph¸c th¶o bao gåm ph¸c th¶o tiÕt diÖn vµ ®êng dÉn (nÕu cÇn). 

3. Chän c«ng cô t¹o Feature thÝch hîp. Hép tho¹i yªu cÇu nhËp c¸c tham sè ®Þnh 

nghÜa cho Feature. Autodesk Inventor chän biªn d¹ng kÝn. NÕu cã nhiÒu biªn d¹ng 

kÝn kÝch chän biªn d¹ng m« t¶ tiÕt diÖn cÇn ®ïn. NÕu kh«ng thùc hiÖn lÖnh Extrude 

th× cÇn chän thªm ®êng dÉn hoÆc trôc quay. 

4. KÝch OK ®Ó kÕt thóc viÖc t¹o m« h×nh. Thay ®æi chÕ ®é hiÓn thÞ tõ 2D sang  

m« h×nh 3D. 
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Ta cã thÓ t¹o Work Feature khi t¹o chi tiÕt c¬ së. 

-  T¹o c¸c Work Feature:  

KÝch chuét vµo nót Work Plane, Work Axis hoÆc Work Point.  Chän mét ®èi 

tîng h×nh häc hoÆc hÖ to¹ ®é mÆc ®Þnh. Autodesk Inventor cã thÓ t¹o ra Work 

Feature tõ ®èi tîng h×nh häc ®· chän. 

VÝ dô nÕu muèn t¹o mét trôc lµm viÖc chØ cÇn chän mÆt ®Çu cña mét h×nh trô 

khi ®ã trôc lµm viÖc ®îc t¹o ra qua ®êng t©m cña h×nh trô. 

Chó ý: Th«ng tin chi tiÕt vÒ work Feature xem trªn Online Help vµ Tutorials. 

3.7. Quan s¸t c¸c chi tiÕt: 

Cã mét sè c¸ch quan s¸t chi tiÕt, c¸ch quan s¸t chi tiÕt mÆc ®Þnh lµ vu«ng gãc 

víi biªn d¹ng ph¸c th¶o. Khi kÝch chuét ph¶i vµo cöa sæ ®å ho¹ vµ chän Isometric 

View tõ menu th× vÐc t¬ quan s¸t sÏ thay ®æi theo híng ®ã. Ta còng cã thÓ chän 

Previous View tõ menu hoÆc Ên phÝm F5 ®Ó trë l¹i m« h×nh cña lÇn quan s¸t tríc.  

C¸c lÖnh dïng ®Ó quan s¸t ®îc ®Æt trªn thanh c«ng cô chuÈn. Xem “ Viewing 

Tools”  . 

Ta cã thÓ xoay híng quan s¸t theo 3 chiÒu, quanh mét hoÆc c¸c trôc to¹ ®é. 

C«ng cô Common View lµ mét “ glass box”  (hép trong suèt) vµ c¸c vector quan s¸t 

trªn mçi mÆt vµ gãc. 

- Sö dông c«ng cô quay:  

Trªn thanh c«ng cô chuÈn kÝch chuét vµo Rotate. BiÓu tîng quay 3D ®îc 

hiÓn thÞ trªn m« h×nh. KÝch chuét vµo m« h×nh ®Ó chän ®iÓm quay cho vÐc t¬ quan 

s¸t. Di chuyÓn chuét bªn trong biÓu täng quay ®Ó quay theo 3 chiÒu, di chuyÓn 

chuét bªn ngoµi biÓu tîng quay ®Ó quay theo mét trôc. KÝch chuét ra bªn ngoµi 

vïng biÓu tîng ®Ó kÕt thóc lÖnh quay. Ta còng cã thÓ Ên phÝm F4 ®Ó kÝch ho¹t lÖnh 

nµy. 

- Sö dông c«ng cô Common View:  

Trªn thanh c«ng cô chuÈn kÝch chuét vµo Rotate ®Ó kÝch ho¹t lÖnh Common 

View Ên phÝm  SPACEBAR. Khi Rotate ®îc kÝch ho¹t kÝch chuét vµo mét mòi tªn 

m« h×nh sÏ quay cho ®Õn khi gãc th¼ng híng quan s¸t. 

3.8. ChØnh söa c¸c Feature  

- §Ó chØnh söa mét Feature :  

Thay ®æi c¸c tham sè trong lÖnh t¹o Feature hoÆc biªn d¹ng ph¸c th¶o. KÝch 

chuét ph¶i vµo Feature cÇn söa trong tr×nh duyÖt sau ®ã chän Edit Feature , Edit 

Sketch hoÆc Show Dimensions. Edit Feature sÏ më hép tho¹i cña lÖnh t¹o Feature 

®ã. Edit Sketch kÝch ho¹t Sketch cña Feature . Show Dimensions hiÓn thÞ kÝch thíc 

Sketch . Tõ ®ã ta cã thÓ chØnh söa chóng trong m«i trêng m« h×nh chi tiÕt. 

- §Ó tho¸t khái chÕ ®é Sketch:  
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KÝch chuét vµo nót Update. Feature ®îc cËp nhËt vµ ch¬ng tr×nh tho¸t khái 

chÕ ®é Sketch.               

3.9. Bæ sung Sketched Features: 

Mèi quan hÖ cha con gi÷a c¸c Feature nghÜa lµ mét Feature ®iÒu khiÓn c¸c 

Feature kh¸c. Feature c¬ së lµ cha cña tÊt c¶ c¸c Feature kh¸c. Cã nhiÒu cÊp ®é liªn 

hÖ cha/con. Feature con  t¹o ra sau Feature cha vµ Feature cha ph¶i cã s½n tríc. VÝ 

dô ta cã thÓ t¹o mét vÊu nåi trªn vËt ®óc, cã thÓ cã hoÆc kh«ng cã lç khoan(Feature 

con) trªn nã tuú theo tõng øng dông. VÊu nåi (Feature cha) cã thÓ cã s½n kh«ng cã lç 

khoan ( Feature con), nhng lç khoan th× kh«ng tån t¹i nÕu kh«ng cã vÊu nåi. 

- Bæ sung mét Sketch Feature :  

Còng gièng nh khi t¹o Feature c¬ së. Nhng ë ®©y cã 2 ®iÓm kh¸c lµ:  

+ Thø nhÊt ta ph¶i chØ ra Sketch. 

+ Tthø 2 lµ ë trêng hîp nµy sè lîng tuú chän ®Ó t¹o Feature nhiÒu h¬n.   

- T¹o mét ph¸c th¶o míi:  

KÝch chuét vµo nót Sketch vµ kÝch chuét vµo mét mÆt trªn m« h×nh chi tiÕt. 

Biªn d¹ng ph¸c th¶o ®îc ®Þnh nghÜa trªn mÆt líi. NÕu muèn dùng Feature trªn 

mÆt cong hoÆc mét mÆt nghiªng tríc tiªn ta ph¶i dùng mét mÆt lµm viÖc(Work 

Plane). 

3.10. Bæ sung c¸c Placed Feature: 

C¸c Placed Feature kh«ng yªu cÇu Sketch cho riªng nã. VÝ dô ta chØ cÇn x¸c 

®Þnh mét c¹nh ®Ó bæ sung mét Chamfer (v¸t gãc). Dïng c«ng cô t¹o Chamfer ®Ó 

®Þnh nghÜa c¸c tham sè cho Chamfer. 

C¸c Placed Feature chuÈn lµ: Shell, Fillet hoÆc Round, Chamfer vµ Face 

draft. 

- Shell: T¹o chi tiÕt rçng víi ®é dµy x¸c ®Þnh cña thµnh chi tiÕt. 

- Fillet: Vª trßn c¸c c¹nh. 

- Chamfer: V¸t mÐp c¸c gãc. 

- Face Draft: T¹o mÆt v¸t trªn c¸c mÆt. Ta cÇn chän mÆt c¬ së vµ híng v¸t. 

- Bæ sung Placed Feature:  

KÝch chuét vµo nót Placed Feature sau ®ã chän Feature cÇn bæ sung. 

 + Bæ sung mét lç (Hole):  

T¹o c¸c ®iÓm t©m lç. Ta cã thÓ dïng ®iÓm cuèi cña ®êng th¼ng lµm t©m 

lç.Trªn thanh c«ng cô Feature kÝch chuét vµo c«ng cô Hole sau ®ã chän t©m lç, dïng 

hép tho¹i Hole  ®Ó ®Þnh nghÜa lç. 
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C¸c gãc vµ ®iÓm t©m ®îc chän  

       lµm t©m cña c¸c lç                                    C¸c tham sè ®Þnh nghÜa lç 

 

3.11. T¹o m¶ng c¸c Feature (Pattern of Feature):  

Mét Feature ®¬n hoÆc mét nhãm c¸c Feature cã thÓ ®îc nh©n b¶n hoÆc s¾p 

xÕp trong c¸c m¶ng. C¸c c«ng cô t¹o m¶ng yªu cÇu cã mét ®èi tîng h×nh häc tham 

chiÕu ®Ó ®Þnh nghÜa m¶ng. Ta cã thÓ t¹o c¸c m¶ng b»ng c¸ch sö dông c«ng cô 

Rectangular vµ Circular Pattern hoÆc c«ng cô Mirror Feature. 

VÝ dô dïng c«ng cô Rectangular Pattern ®Ó t¹o mét m¶ng gåm 3 hµng 4 cét  

 

3.12. C¾t c¸c mÆt hoÆc c¸c chi tiÕt: 

C«ng cô Split dïng  ph¸c th¶o c¸c ®èi tîng h×nh häc ®Ó c¾t  c¸c mÆt  

hoÆc c¸c chi tiÕt. Sö dông c¸c ®èi tîng h×nh häc ph¸c th¶o ®Ó t¹o c¸c ®êng 

c¾t ®øt. Khi c¾t mét mÆt, hÖ thèng sÏ chia mÆt cã s½n theo ®êng c¾t ®øt. Khi c¾t 

mét chi tiÕt, hÖ thèng sÏ c¾t qua chi tiÕt theo ®êng c¾t ®øt vµ lo¹i bá mét nöa chi 

tiÕt.   

 - C¾t c¸c mÆt: 

 T¹o mÆt ph¸c th¶o vµ ph¸c th¶o ®êng c¾t ®øt. Ta cã thÓ dïng c¸c ®èi tîng 

h×nh häc cã nhiÒu phÇn  ®Ó t¹o ®êng c¾t ®øt. KÝch chuét vµo c«ng cô Split trªn 

thanh c«ng cô Feature. Sau ®ã kÝch chuét vµo  nót Split Face. Chän ®êng c¾t vµ c¸c 

mÆt cÇn c¾t. NÕu muèn c¾t tÊt c¶ c¸c mÆt trªn chi tiÕt kÝch chuét vµo nót Part. NÕu 
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®êng c¾t kh«ng hoµn toµn c¾t c¸c mÆt cÇn c¾t th× hÖ thèng sÏ tù ®éng kÐo dµi ®Õn 

giao nhau. 

 

- C¾t chi tiÕt:  

T¹o mÆt ph¼ng ph¸c th¶o vµ ph¸c th¶o ®êng c¾t. Ta cã thÓ dïng c¸c ®èi 

tîng h×nh häc cã nhiÒu phÇn ®Ó t¹o ®êng c¾t. KÝch chuét vµo c«ng cô Split trªn 

thanh c«ng cô Feature. KÝch chuét vµo nót Split Part. Chän ®êng c¾t vµ phÇn c¾t 

bá. NÕu ®êng c¾t kh«ng giao víi c¸c mÆt cÇn c¾t th× hÖ thèng sÏ tù ®éng kÐo dµi ®Õn 

giao nhau.        

 

3.13. C¸c c«ng cô t¹o m« h×nh chi tiÕt 

TËp hîp c¸c c«ng cô t¹o m« h×nh chi tiÕt bao gåm c¸c c«ng cô t¹o Feature 

trªn thanh c«ng cô Feature vµ c¸c c«ng cô quan s¸t trªn thanh c«ng cô chuÈn. 

- C¸c c«ng cô t¹o Feature 

Mét sè c«ng cô Feature cã nhiÒu lùa chän. Mòi tªn bªn c¹nh nót c«ng cô chØ 

cho ta cã thÓ më réng nót ®Ó cã thÓ nh×n thÊy nhiÒu lùa chän h¬n. 

T

T 
Nót C«ng cô Chøc n¨ng Ghi chó 

1 
 

Extrude 

§ïn mét biªn d¹ng 

theo ph¬ng vu«ng gãc víi 

ph¸c th¶o ®Ó t¹o mét khèi 

r¾n hoÆc m« h×nh mÆt 

Cã thÓ dïng t¹o 

Feature c¬ së 

Nót c¾t mÆt 

Chän c¸c mÆt c¾t riªng 

phÇn 

Chän híng c¾t bá 

vËt liÖu 

Nót c¾t chi tiÕt 
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2 

 

Revolve 
Quay liªn tôc mét biªn 

d¹ng quanh 1 trôc 

Cã thÓ dïng t¹o 

Feature c¬ së 

3 

 

Hole T¹o mét lç trong chi tiÕt 

Dïng ®iÓm cuèi 

cña mét ®êng 

th¼ng hoÆc t©m lç 

lµm ®êng t©m lç 

4 

 

Shell KhoÐt rçng chi tiÕt Placed Feature  

5 

 

Rib T¹o mét g©n cho chi tiÕt Placed Feature  

6 

 

Loft 

T¹o mét Feature cã tiÕt 

diÖn thay ®æi, cã thÓ theo 

mét ®êng dÉn cong 

Yªu cÇu cã nhiÒu 

mÆt ph¼ng lµm 

viÖc  

7 

 

Sweep 

§ïn mét ph¸c th¶o biªn 

d¹ng theo mét ®êng dÉn 

cong 

Cã thÓ dïng ®Ó 

t¹o chi tiÕt c¬ së 

8 

 

Coil 
§ïn mét biªn d¹ng theo 

mét ®êng dÉn xo¾n èc 

Cã thÓ dïng ®Ó 

t¹o Feature c¬ së 

9 

 

Thread 
T¹o ®êng ren trong hoÆc 

ren ngoµi trªn chi tiÕt 
 

1

0 
 

Fillet Vª trßn c¸c c¹nh Placed Feature  

1

1 
 

Chamfer V¸t mÐp c¸c c¹nh Placed Feature  

1

2 
 

Face Draft 
T¹o khèi v¸t trªn c¹nh ®· 

chän 
Placed Feature  

1

3 
 

Split 

 

 

 

C¾t c¸c mÆt theo ®êng c¾t 

hoÆc c¾t chi tiÕt theo 

®êng c¾t.  
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1

4 
 

View 

Catalog 

- Më mét mÉu phÇn 

tö thiÕt kÕ 

- ChÌn mét phÇn tö 

thiÕt kÕ. 

- T¹o phÇn tö thiÕt kÕ 

tõ Feature cã s½n. 

 

1

5 
 

Derived 

Componen

t 

T¹o mét chi tiÕt míi tõ chi 

tiÕt c¬ së 
 

1

6 
 

Rectangul

ar Pattern 

T¹o mét ma trËn ch÷ nhËt  

Feature  
 

1

7 
 

Circular 

Pattern 

T¹o lo¹t Feature theo 

®êng trßn 
 

1

8 
 

Mirror 

Feature  

T¹o mét ¶nh ®èi xøng qua 

mét mÆt, mét ®êng th¼ng, 

mét trôc 

 

1

9 
 

Work 

Plane 
T¹o mét mÆt lµm viÖc  

2

0 

 

Work Axis T¹o mét trôc lµm viÖc  

2

1 
 

Work 

Point  
T¹o mét ®iÓm lµm viÖc  

2

2 
 

Parameter

s 

HiÓn thÞ c¸c tham sè cho 

c¸c Feature söa ®æi c¸c 

ch÷ sè trong equations. 

T¹o c¸c tham sè bæ sung  

 

 

- C¸c c«ng cô quan s¸t 

B¶ng nµy diÔn t¶ c¸c c«ng cô dïng ®Ó thay ®æi híng quan s¸t. Cã thÓ dïng 

c¸c c«ng cô nµy trong tÊt c¶ c¸c m«i trêng. 
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TT 

Nút 

lệnh 
C«ng cô Chøc n¨ng Ghi chó 

1 

 

Zoom All 
HiÓn thÞ toµn bé c¸c chi tiÕt trong cöa sæ 

®å ho¹ 
 

2 

 

Zoom 

Window 
HiÓn thÞ kÝn mµn h×nh vïng  ®îc chän  

3 

 

Zoom Di chuét ®Ó phßng to hoÆc thu nhá  

4 

 

Pan 
Di chuyÓn vÞ trÝ m« h×nh trong cöa sæ ®å 

ho¹ 
 

4 

 

Zoom 

selected 

HiÓn thÞ kÝn mµn h×nh ®èi tîng h×nh 

häc  ®îc chän 
 

5 

 

Rotate Thay ®æi híng quan s¸t m« h×nh  

6 

 

Look At 

Thay ®æi híng quan s¸t sao cho nã 

vu«ng gãc víi ®èi tîng h×nh häc ®îc 

chän 

 

7 

 

Shaded 

Display 
T« bãng m« h×nh   

 
 

Hidden 

Edge 

Display  

T« bãng m« h×nh  nhng nh×n thÊy c¸c 

c¹nh Èn 
 

8 

 

Wirefram

e Display 
T« bãng m« h×nh  d¹ng khung  

MÑo: 

- Sö dông hÖ to¹ ®é mÆc ®Þnh:  

NÕu ta t¹o trôc víi ®êng t©m t¹i gèc t¹o ®é ta cã thÓ tham chiÕu mét trong 

c¸c mÆt ph¼ng to¹ ®é khi ph¸c th¶o biªn d¹ng cña c¸c Feature bæ sung.  

- Bæ sung c¸c Work Feature trong qu¸ tr×nh t¹o chi tiÕt:  
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Ta cã thÓ t¹o c¸c l¾p r¸p mét c¸ch dÔ dµng h¬n nÕu cã s½n c¸c Work Feature 

trong file part. 

 

- Dïng chung c¸c Sketch gi÷a c¸c Feature:  

C¸c Sketch dïng chung cã thÓ dïng cho nhiÒu Feature. Sketch dïng chung 

xuÊt hiÖn t¹i ®Ønh cña cöa sæ duyÖt. Mét biÓu tîng Sketch ®îc hiÓn thÞ díi mçi 

Feature mµ sö dông chóng. 

- Sö dông c¸c ®iÓm giíi h¹n To Next vµ Through All:  

C¸c Feature t¹o ra cã ®iÓm giíi h¹n sÏ tù ®éng cËp nhËt sù thay ®æi tíi c¸c 

Feature kh¸c. 

- §Æt chÕ ®é chän: 

 ChØ ra kiÓu ®èi tîng h×nh häc ta muèn chän ®Ó läc bá c¸c ®èi tîng h×nh häc 

kh¸c. 

- Sö dông bé läc trong cöa sæ duyÖt:  

Èn c¸c thµnh phÇn kh¸c trong cöa sæ duyÖt ®Ó dÔ dµng h¬n khi tham chiÕu 

qua c¸c Feature.     
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CHƯƠNG 5 

Base Solids 
Base Solids lµ nh÷ng m« h×nh ®îc t¹o thµnh tõ c¸c hÖ thèng CAD kh¸c vµ 

®îc ghi ë d¹ng file SAT hoÆc STEP. Ch¬ng nµy sÏ giíi thiÖu tæng quan vÒ c¸c kh¸i 

niÖm, c¸c thñ tôc vµ tr×nh tù lµm viÖc ®îc sö dông trong m«i trêng Base Solids. §Ó 

biÕt thªm chi tiÕt vÒ c¸c th«ng tin tham kh¶o, c¸c vÝ dô tr×nh diÔn, híng dÉn c¸c 

bíc, dïng Online Help vµ Tutorials. 

4.1. Giíi thiÖu chung 

 Ta cã thÓ më vµ sö dông c¸c file ®îc t¹o vµ ghi trong Pro\ENGINEER vµ 

c¸c hÖ thèng CAD  kh¸c víi c¸c phÇn më réng cña file lµ SAT (.sat), STEP (.step) vµ 

DWG ( cña AutoCAD vµ Mechanical Desktop). 

NÕu mét file SAT hoÆc STEP ®îc nhËp mµ chøa ®ùng mét thµnh phÇn ®¬n, 

Autodesk Inventor sÏ nhËn ra nã lµ mét file chi tiÕt Base Solids. NÕu file ®îc nhËp 

chøa ®ùng nhiÒu thµnh phÇn, Autodesk Inventor sÏ nhËn ra nã lµ mét l¾p  r¸p Base 

Solids víi nhiÒu file chi tiÕt. 

- Khi nµo th× dïng m«i trêng m« h×nh Solid:  

Sau khi nhËp mét file, kÝch ®óp chuét vµo biÓu tîng Base Solids trªn cöa sæ 

duyÖt ®Ó kÝch ho¹t m«i trêng Solid Model. Dïng m«i trêng Solid Model ®Ó ®Þnh vÞ 

c¸c Work Feature, chØnh söa c¸c Base Solids hoÆc sö dông c¸c c¹nh cña mét mÆt 

Base Solid nh lµ biªn d¹ng ph¸c th¶o. 

Chó ý: §Ó xem thªm chi tiÕt vÒ nhËp vµ xuÊt c¸c file .sat vµ .stp xem “ Data 

Translation”  trong Help. 

- Ta cã thÓ lµm g× víi m« h×nh Solid:  

C¸c m« h×nh Solid kh¸c víi c¸c m« h×nh cña Autodesk Inventor. Ta kh«ng thÓ 

truy cËp vµo c¸c Sketch, c¸c Feature, c¸c kÝch thíc còng nh c¸c rµng buéc mµ ®· 

t¹o ra Solid. Tuy nhiªn ta cã thÓ söa mét Base Solid, lÊy ra hoÆc xo¸ c¸c mÆt vµ t¹o 

c¸c Work Feature ®Ó sö dông nh c¸c ®èi tîng dùng h×nh. 

- Ta cã thÓ t×m m« h×nh Solid ë ®©u: 

Khi ta nhËp c¸c file ®Þnh d¹ng .sat hoÆc .stp trong cöa sæ duyÖt hiÓn thÞ c¸c 

biÓu tîng Base ®Ó diÔn t¶ c¸c Base Solid. 

4.2. C¸c tiÖn Ých: 

Díi ®©y lµ c¸c tiÖn Ých chÝnh trong m«i trêng Solid Model. 

- Editing Solids: Lo¹i bá hoÆc xo¸ c¸c mÆt cña Base Solid, kÐo d·n hoÆc  

co ng¾n mét Base Solid, xo¸ mét mÆt Base Solid hoÆc Base Solid. 

- Retain faces: Gi÷ l¹i mét mÆt cña mét Solid bÞ xo¸ ®Ó dïng t¹o ph¸c  

      th¶o. 
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- Work features: T¹o c¸c Work Feature ®Ó dïng nh lµ c¸c ®èi tîng dùng 

h×nh. 

4.3. Tr×nh tù lµm viÖc: 

PhÇn nµy nªu tæng quan vÒ c¸c thao t¸c lµm viÖc trong m«i trêng Base Solid. 

Trong online Help, Tutorial vµ Visual SyllabusTM hç trî c¸c th«ng tin chi tiÕt h¬n vµ 

c¸c vÝ dô tr×nh diÔn, híng dÉn c¸c bíc.    

 

 

4.3.1. LËp kÕ ho¹ch lµm viÖc: 

Trong m«i trêng Solid, ta dïng c¸c c«ng cô Solid ®Ó chØnh söa vµ nhËp Base 

Solid. C¸c chØnh söa kh«ng ®îc tham sè ho¸ vµ kh«ng bæ sung c¸c Feature cho 

Solid ngo¹i trõ c¸c Work Feature ®îc sö dông nh lµ c¸c ®èi tîng dùng h×nh. Khi 

cËp nhËt Base Solid ®Ó hîp nhÊt nh÷ng thay ®æi, c¸c Feature ®îc bæ sung trong m«i 

trêng Part ®îc bè trÝ l¹i.    

 

4.3.2. NhËp c¸c files Base Solid: 

Ta cã thÓ nhËp c¸c files SAT vµ STEP ®îc khëi t¹o trong c¸c hÖ thèng CAD 

kh¸c hoÆc c¸c files DWG cña AutoCAD hoÆc Mechanical Desktop. 

KÝch chuét vµo Files->Open trong hép héi tho¹i chän kiÓu files .sat or .dwg. 

KÝch chuét vµo nót Option ®Ó chän thªm c¸c tuú chän. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                NhËp mét file Base Solid 
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4.3.3.  ChØnh söa c¸c Base Solid: 

Ta cã thÓ kÐo d·n hoÆc thu nhá mét Base Solid vµ lÊy ra hoÆc xo¸ c¸c mÆt. 

Sau khi bæ sung mét ph¸c th¶o vµ mét Sketched Feature tíi mét Base Solid. Ta cã 

thÓ xo¸ Solid nhng gi÷ l¹i c¸c Feature vµ c¸c Sketch phô thuéc. 

KÝch ®óp chuét vµo biÓu tîng Base Solid trong tr×nh duyÖt sau ®ã chän mét 

c«ng cô chØnh söa chuyªn dïng. Khi kÕt thóc chØnh söa kÝch chuét vµo nót Update 

®Ó cËp nhËt c¸c thay ®æi vµ tho¸t khái m«i trêng Solid.     

 

 

 

 

 

 

 

 

 

 

 

 

 

- KÐo d·n hoÆc thu nhá mét Base Solid:  

KÝch chuét vµo c«ng cô Extend or Contract Body, sau ®ã kÝch chuét vµo Plane 

vµ chän mÆt lµm viÖc hoÆc mÆt ph¼ng. KÝch chuét vµo Extend or Contract. Dïng c¸c 

tuú chän ®Ó ®Þnh nghÜa phÐp kÐo d·n vµ co ng¾n Solid sau ®ã kÝch chuét vµo Update. 

 

 

 

    

 

 

 

 

 

        H×nh trô tríc khi kÐo d·n                           H×nh trô sau khi kÐo d·n 

 

 

KÝch ®óp chuét vµo biÓu tîng Base 

Solid trªn tr×nh duyÖt ®Ó kÝch ho¹t chÕ 

®é chØnh söa Solid 
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- Di chuyÓn c¸c mÆt trªn Base Solid: 

KÝch chuét vµo c«ng cô Move Face sau ®ã chän mét hoÆc mét vµi mÆt cÇn di 

chuyÓn. §Ó di chuyÓn mÆt cÇn x¸c ®Þnh híng vµ kho¶ng c¸ch di chuyÓn sö dông c¸c 

tuú chän Direction vµ Distance. §Ó di chuyÓn gi÷a c¸c ®iÓm lùa chän trªn mÆt 

ph¼ng, sö dông c¸c tuú chän Plane vµ Points. Sau ®ã kÝch chuét vµo Update. 

 

 

 

 

 

 

 

 

 

 

 

     Tríc khi di chuyÓn mÆt                                    Sau khi di chuyÓn mÆt 

 

- Xo¸ c¸c mÆt trªn mét Base Solid: 

Chän mét hay mét vµi mÆt cÇn xo¸ sau ®ã kÝch chuét ph¶i vµ chän Delete. KÝch 

chuét vµo Update. 

- Xo¸ mét Base Solid vµ gi÷ l¹i c¸c Feature vµ c¸c sketch:  

KÝch chuét ph¶i vµo biÓu tîng cña Base Solid trong tr×nh duyÖt vµ chän Delete. 

Dïng c¸c tuú chän ®Ó xo¸ c¸c Feature vµ c¸c Sketch g¾n vµo chóng hay gi÷ l¹i c¸c 

Feature vµ c¸c Sketch phô thuéc sau ®ã kÝch chuét vµo OK vµ Update. 

- T¹o mét Work Feature :  

KÝch chuét vµo mét trong sè c¸c nót Work Plane, Work Axis, Work Point. Chän 

mét ®èi tîng h×nh häc hoÆc lµ hÖ to¹ ®é mÆc ®Þnh. Autodesk Inventor cã thÓ x¸c 

®Þnh Work Feature tõ ®èi tîng h×nh häc ®· chän. VÝ dô, nÕu ta muèn t¹o mét 

Work Axis, chØ cÇn chän mÆt ®Çu cña mét mÆt trô khi ®ã mét Work axis sÏ ®îc t¹o 

ra qua t©m cña h×nh trô. 

 

4.4. C¸c c«ng cô chØnh söa Base Solid:  

C¸c c«ng cô chØnh söa Base Solid cã s½n cho viÖc chØnh söa c¸c m« h×nh Solid  
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mµ ®îc t¹o trong hÖ thèng CAD kh¸c vµ ghi díi d¹ng file .sat hoÆc .stp. DÓ 

chØnh söa c¸c Base Solid nµy ta kÝch ho¹t m«i trêng Solid b»ng c¸ch kÝch chuét 

ph¶i vµo thµnh phÇn nµy trong cöa sæ duyÖt vµ chän Edit Solid. 

 C¸c c«ng cô chØnh söa Base Solid:  

T 
Nót 

lÖnh 
C«ng cô Chøc n¨ng 

Ghi 

chó 

1 
 

Move Face 
Di chuyÓn mét hoÆc nhiÒu mÆt trªn 

Solid 

 

2 
 

Extend or 

Contract 

Body 

Më réng hoÆc thu nhá mét Base 

Solid ®çi xøng víi mét mÆt ph¼ng 

hoÆc mét mÆt lµm viÖc 

 

3 

 

Work Plane T¹o mét mÆt lµm viÖc  

 

4 
 

Work Axis T¹o mét trôc lµm viÖc 
 

5 
 

Work Point T¹o mét ®iÓm lµm viÖc 
 

6 
 

Toggle 

Precise UI 
BËt t¾t chÕ ®é nhËp chÝnh x¸c 

 

             

MÑo: 

Sö dông c¸c mÑo nµy ®Ó n©ng cao hiÖu qu¶ thiÕt kÕ khi lµm viÖc víi Base 

Solid. 

- Sö dông c¸c c«ng cô nhËp vµ ®o chÝnh x¸c ®Ó nhËp c¸c gi¸ trÞ khi  

®Þnh d¹ng l¹i kÝch cì cña Base Solid. 

Dïng c¸c nót c«ng cô nµy trªn thanh c«ng cô chuÈn trong qu¸ tr×nh më réng 

hoÆc kÕt nèi víi mét Base Solid. 

- Di chuyÓn c¸c sketch trªn c¸c mÆt ph¨bgr lµm viÖc kh¸c. 

Ta cã thÓ rµng buéc c¸c sketch tíi c¸c mÆt ph¼ng lµm viÖc hoÆc sö dông c«ng 

cô Reattach Sketch ®Ó di chuyÓn c¸c sketch trªn c¸c mÆt ph¼ng lµm viÖc kh¸c.  
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CHƯƠNG 6 

ThiÕt kÕ chi tiÕt d¹ng tÊm   

(Sheet metal) 
 

 

Ch¬ng nµy sÏ giíi thiÖu tæng quan vÒ m«i trêng thiÕt kÕ chi tiÕt d¹ng tÊm 

cña Autodesk Inventor, tr×nh tù lµm viÖc, c¸c c«ng cô t¹o c¸c chi tiÕt d¹ng tÊm. Ta sÏ 

t×m hiÓu c¸ch sö dông c¸c c«ng cô trong m«i trêng Part Model ®Ó t¹o ra c¸c chi tiÕt 

mµ sÏ ®îc nhËn d¹ng trong m«i trêng thiÕt kÕ chi tiÕt d¹ng tÊm. C¸c tµi liÖu bæ 

sung, c¸c vÝ dô tr×nh diÔn, híng dÉn c¸c bíc xem trªn online Help vµ Tutorials.    

 

5.1. Giíi thiÖu chung 

Trong m«i trêng thiÕt kÕ chi tiÕt d¹ng tÊm ta cã thÓ t¹o c¸c chi tiÕt d¹ng tÊm 

vµ c¸c Feature b»ng c¸ch sö dông c¶ hai lo¹i c«ng cô lµ thiÕt kÕ m« h×nh chi tiÕt 

(Part model) vµ c¸c c«ng cô chuyªn dïng cho thiÕt kÕ chi tiÕt tÊm (Sheet Metal).  

- Sù kh¸c nhau gi÷a Part Model vµ Sheet Metal: 

RÊt nhiÒu c¸c c«ng cô Sheet Metal ®îc dùa trªn c¬ së c¸c c«ng cô trong Part 

Model nhng ®· ®îc tèi u cho Sheet Metal. VÝ dô, khi t¹o mét mÆt cña tÊm kim 

lo¹i ta còng chän mét biªn d¹ng ph¸c th¶o gièng nh trong lÖnh Extrude. HÖ thèng 

sÏ ®ïn biªn d¹ng ph¸c th¶o b»ng chiÒu dµy vËt liÖu ®ång thêi cã thÓ bæ sung c¸c mÆt 

uèn cong. C¸c c«ng cô ph¸t triÓn riªng cho thiÕt kÕ chi tiÕt tÊm(Sheet Metal) bao 

gåm Bend(uèn cong) vµ Corner Seam(®êng viÒn gãc). 

 - Sheet Metal lµm g× m«i trêng thiÕt kÕ: 

Khi t¹o mét chi tiÕt trong m«i trêng Sheet Metal. Ta t¹o c¸c mÆt chÝnh sau 

®ã bæ sung thªm c¸c yÕu tè phô. VÝ dô, ta cã thÓ t¹o c¸c mÆt rêi nhau sau ®ã bæ sung 

c¸c mÆt uèn cong ë mÐp. C«ng cô Bend sÏ t¹o c¸c mÆt uèn cong trªn ®êng biªn 

d¹ng hoÆc cã thÓ më réng hoÆc c¾t xÐn c¸c mÆt nÕu cÇn thiÕt. NÕu hai mÆt song song 

Bend sÏ t¹o ra mét mÆt nèi gi÷a chóng. NÕu thay ®æi gãc cña mét mÆt sao cho hai 

mÆt c¾t nhau. HÖ thèng sÏ tù ®éng thay mÆt nèi b»ng mÆt uèn cong.  

 - T¹o vËt khai triÓn. 

Dïng c«ng cô Flat Pattern ®Ó t¹o vËt khai triÓn. VËt khai triÓn ®îc t¹o trong 

cöa sæ thø hai vµ mét biÓu tîng ®îc ®Æt t¹i ®Ønh cña cöa sæ duyÖt. Khi thay ®æi m« 

h×nh vËt khai triÓn còng sÏ tù ®éng thay ®æi theo.  

- C¸ch t¹o c¸c Feature ghÐp: 

NÕu chi tiÕt cã c¸c ®Æc ®iÓm víi nhiÒu biÕn d¹ng vËt liÖu nh c¸c m¸i h¾t 

ta cã thÓ  
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dïng c¸c c«ng cô t¹o m« h×nh Feature. Ta sÏ xem h×nh d¸ng bªn ngoµi cña 

Feature khi ta quan s¸t vËt khai triÓn vµ ta cã thÓ g¸n kÝch thíc tíi Feature trong 

b¶n vÏ. NÕu ta t¹o c¸c Feature nµy nh lµ c¸c phÇn tö thiÕt kÕ, c«ng cô ph©n tÝch vËt 

khai triÓn  sÏ nhËn ra chóng vµ hiÓn thÞ chóng nh lµ vËt khai triÓn trong kh«ng 

gian 3D.     

5.2. C¸c tiÖn Ých: 

- Face: T¹o mÆt uèn cong ë vÞ trÝ cã thÓ. 

- Flange: T¹o mét mÆt trªn toµn bé chiÒu réng ®ång thêi t¹o c¸c mÆt uèn. T¹o 

cã thÓ t¹o gê biªn d¹ng. 

- Bend: KÐo dµi hoÆc c¾t bá c¸c mÆt khi cÇn thiÕt ®Ó t¹o mÆt uèn. LÖnh Fold 

t¹o mÆt uèn trªn ®êng ph¸c th¶o, t¹o c¸c mÆt uèn ®óp gi÷a hai mÆt song song, c¸c 

mÆt kh«ng ®ång ph¼ng. Sö dông lÖnh Unfold ta cã thÓ c¾t quanh mÆt uèn. 

- Hem: T¹o ®êng viÒn gÊp hoÆc uèn 1800 trªn mét c¹nh hoÆc ®êng viÒn 

®óp. 

- Flat pattern: Tù ®éng cËp nhËt ®Ó mang l¹i kÕt qu¶ cña sù thay ®æi tíi m« 

h×nh. 

5.3. Tr×nh tù lµm viÖc: 

PhÇn nµy tr×nh bµy tæng quan vÒ c¸ch t¹o mét chi tiÕt d¹ng tÊm. Trªn online 

Help vµ Tutorial cung cÊp nh÷ng th«ng tin vµ vÝ dô cô thÓ h¬n. Khi Ta lµm viÖc 

trong Sheet Metal, Design Doctor gióp ta ph¸t hiÖn vµ söa c¸c lçi. 

5.3.1. LËp kÕ ho¹ch lµm viÖc: 

C¸c chi tiÕt tÊm th«ng thêng lµ c¸c ®êng bao, c¸c vá bäc vµ khung c¸c gi¸ 

®ì. Ta cã thÓ thiÕt kÕ trong côm l¾p vµ hoµn thiÖn h×nh d¸ng tríc khi hoµn thiÖn 

c¸c phÇn chi tiÕt. VÝ dô, khi thiÕt kÕ gi¸ ®ì ta t¹o c¸c mÆt rêi vµ sau ®ã l¾p chóng 

trong côm l¾p.  

Sau ®ã ghÐp c¸c mÆt ®ã víi c¸c mÆt uèn vµ hoµn thiÖn m« h×nh. §iÒu nµy sÏ 

®em l¹i hiÖu xuÊt cao tõ viÖc thiÕt kÕ phèi c¶nh vµ nã lµm ®¬n gi¶n ho¸ qu¸ tr×nh 

chØnh söa.  

Mét vÝ dô n÷a, ta cã thÓ xo¸ vµ t¹o c¸c mÆt uèn ®Ó tèi u ho¸ tÊm tr¶i ph¼ng 

khi chÕ t¹o chi tiÕt.    

5.3.2. ChuyÓn tíi m«i trêng thiÕt kÕ chi tiÕt tÊm(Sheet metal) 

ThiÕt kÕ chi tiÕt tÊm lµ m«i trêng thiÕt kÕ tèi u ®Çu tiªn cho thiÕt kÕ m« 

h×nh chi tiÕt. Autodesk Inventor nhËn ra m« h×nh vµ chi tiÕt tÊm lµ c¸c kiÓu con cña 

files chi tiÕt.  

Ta hoµn toµn cã thÓ thay ®æi c¸c kiÓu con d¹ng Part Model mÆc ®Þnh thµnh 

Sheet Metal. KiÓu con Sheet Metal chØ ra r»ng chi tiÕt lµ mét chi tiÕt tÊm cho phÐp 

sö dông thanh c«ng cô Sheet Metal vµ bæ sung c¸c tham sè cña Sheet Metal. Khi ta 
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chuyÓn l¹i nã thµnh m« h×nh chi tiÕt th× c¸c tham sè chi tiÕt tÊm vÉn ®îc lu gi÷ 

nhng khi ®ã hÖ thèng sÏ coi nã lµ m« h×nh chi tiÕt. 

- §Ó cho phÐp sö dông m«i trêng Sheet Metal:  

Më mét file mÉu Sheet Metal hoÆc lµ chän mét mÆt cña chi tiÕt trong file 

Part, sau  

®ã chän Application-> Sheet metal. HÖ thèng cho phÐp sö dông thanh c«ng cô 

Sheet Metal vµ bæ sung c¸c tham sè Sheet Metal tíi file. 

5.3.3. Cµi ®Æt c¸c kiÓu Sheet Metal. 

Mét chi tiÕt Sheet Metal cã c¸c tham sè m« t¶ chi tiÕt vµ c¸ch t¹o ra nã. VÝ dô 

c¸c Sheet Metal thêng cã cïng chiÒu dµy th× c¸c mÆt uèn cong thêng cã cïng b¸n 

kÝnh. 

Nót Sheet Metal Styles lµ biÓu tîng ®Çu tiªn trªn thanh c«ng cô Sheet Metal. 

Díi ®©y m« t¶ mét c¸ch tæng quan vÒ Sheet Metal Styles. Cã thÓ xem Help ®Ó biÕt 

vÒ diÔn t¶ ®Çy ®ñ cña c¸c cµi ®Æt nµy 

 

 

 

 

 

 

 

 

 

 

 

 

- Sheet tab: §îc chia ra c¸c tham sè  cña Sheet vµ Flat Pattern. Tham sè 

Sheet bao gåm kiÓu vËt liÖu (Material Type) vµ chiÒu dµy (Thickness). 

C¸c tham sè Flat Pattern ®Þnh nghÜa giíi h¹n cho phÐp uèn cong ®îc tÝnh 

to¸n. Víi ph¬ng ¸n Linear Unfold nhËp vµo phÇn tr¨m thËp ph©n cña chiÒu dµy 

vËt liÖu cho Linear Offset. Linear Offset lµ vÞ trÝ cña trôc trung gian cña mÆt uèn 

cong.  

Víi Bend Table kho¶ng c¸ch th¼ng ®îc ®Þnh nghÜa b»ng kiÓu vËt liÖu, chiÒu 

dµy, b¸n kÝnh uèn cong vµ mÆt uèn. 

- Bend tab: Danh s¸ch c¸c tham sè trong Bend tab ®Þnh nghÜa c¸c mÆt uèn 

cong.  Ta cã thÓ nhËp gi¸ trÞ cho b¸n kÝnh uèn cong, bæ sung h×nh d¸ng vµ kÝch cì. 
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- Corner tab: Danh s¸ch c¸c tham sè trong Corner tab ®Þnh nghÜa gãc nèi. Ta 

cã thÓ nhËp gi¸ trÞ cho gãc nèi vµ chØnh söa vµ thay ®æi kÝch thíc. 

- §Ó nhËp c¸c kiÓu Sheet metal:  

KÝch chuét vµo nót Sheet Metal Styles. Cã mét sè kiÓu mÆc ®Þnh cho chi 

tiÕt. Ta  

cã thÓ ®Æt mét vµi kiÓu nh b¸n kÝnh uèn cong( Bend Radius) khi t¹o mét 

Feature. C¸c cµi ®Æt kh¸c nh chiÒu dµy (Thickness) g¸n cho toµn bé chi tiÕt vµ 

kh«ng thÓ g¸n cho mét Feature riªng. 

5.3.4. T¹o c¸c mÆt 

Bíc ®Çu tiªn trong qu¸ tr×nh thiÕt kÕ hÇu hÕt c¸c chi tiÕt Sheet Metal lµ t¹o 

mét mÆt. C«ng cô t¹o mÆt gièng nh c«ng cô Extrude trong m« h×nh chi tiÕt. ChØ cã 

mét ®iÓm kh¸c chÝnh lµ c«ng cô Face th× lu«n lu«n bæ sung thªm mét Boolean. ChiÒu 

s©u Extrude chÝnh lµ chiÒu dµy. NÕu cã mét mÆt trªn chi tiÕt ta hoµn toµn cã thÓ t¹o 

mét mÆt uèn cong hoÆc mét ®êng viÒn gièng nh ta t¹o mét mÆt míi. 

- C¸ch t¹o mÆt: 

 KÝch chuét vµo nót c«ng cô Face. NÕu cã nhiÒu h¬n mét biªn d¹ng trªn mÆt 

ph¸c  

th¶o th× chän biªn d¹ng cÇn t¹o mÆt. NÕu mét ®êng th¼ng cña biªn d¹ng trïng 

khíp víi mét c¹nh m« h×nh cã s½n. Mét mÆt uèn cong sÏ tù ®éng ®îc t¹o ra gi÷a 

c¸c mÆt ®ã. NÕu ®êng th¼ng trong ph¸c th¶o kh«ng trïng, kÝch chuét vµo nót 

More(>>) vµ chän c¹nh trªn mét mÆt cã s½n ®Ó t¹o mÆt uèn cong. Cã thÓ nhËp gi¸ trÞ 

b¸n kÝnh uèn cong. 

 

 

 

 

 

 

 

                                                               

 

 

 

 

 

 

 

MÆt ph¼ng ph¸c th¶o ®îc t¹o trªn 

c¹nh cña mét chi tiÕt tÊm kh¸c 

Khi cã ph¸c th¶o 

®îc g¾n víi mét c¹nh 

cña tÊm. C«ng cô Face tù 

®éng cung trßn uèn  

 

 



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 57 

- C¸ch t¹o gê biªn d¹ng ( Contour flange) 

KÝch chuét vµo c«ng cô Contour Flange. Trªn mét mÆt Sheet Metal cã s½n, 

kÝch vµo c¹nh ®Ó xem tríc gê t¹o ra. NhËp vµo gi¸ trÞ díi Shape vµ sö dông Flip 

Offset and Flip Direction ®Ó ®Æt híng ph¸t triÓn cña gê. KÝch chuét vµo nót ph¸t 

triÓn theo mét híng hoÆc hai híng ®Ó t¹o gê. §Ó ®Þnh nghÜa mÆt uèn cong dïng 

c¸c tuú chän phÝa díi Bend, xo¸ hép kiÓm Bend Relief nÕu kh«ng muèn chÌn mét 

mÆt uèn næi. KÝch chuét vµo Apply ®Ó tiÕp tôc bæ sung c¸c gê hoÆc kÝch chuét vµo 

OK ®Ó ®ãng hép tho¹i. 

 

 

 

 

 

 

 

 

 

 

 

Ph¸c th¶o biªn d¹ng gê 

 

                                                                           Chän c¹nh cÇn t¹o gê 

 

 

 

 

 

 

 

5.6. T¹o c¸c lç vµ c¸c tÊm c¾t 

- C¾t mÆt ph¼ng: 

 

 

 

 

 

f 

 

 

TÊm t¹o 

thµnh sau khi t¹o 

gê 
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5.3.5. T¹o c¸c m¶nh c¾t vµ c¸c lç 

 C¸c c«ng cô c¾t (Cut) t¬ng tù nh «ng cô Face. C«ng cô c¾t lu«n lu«n thùc 

hiÖn phÐp to¸n trõ l«gic (c¾t bá ®i). Ta kh«ng thÓ t¹o mÆt uèn víi c«ng cô c¾t. Ta cã 

thÓ chän tuú chän giíi h¹n nh lµ Through All cho feature.C¸c feature c¾t lµm ®¬n 

gi¶n ho¸ viÖc chØnh söa m« h×nh. Ta cã thÓ t¹o c¸c mÆt ch÷ nhËt ®¬n gi¶n mµ ®Þnh 

nghÜa kÝch cì cña chi tiÕt, sau ®ã dïng Cut ®Ó c¾t bá nh÷ng chç c¾t. NÕu ta dïng Cut 

®Ó t¹o c¸c Design Element ta cã thÓ t¹o th viÖn c¸c h×nh d¹ng lç cÇn ®ôc vµ dÓ dµng 

chÌn chóng vµo trong chi tiÕt. Ta cã thÓ ph¸c th¶o mét biªn d¹ng kÝn qua mét mÆt 

uèn cong th¼ng gãc ®îc tr¶i ra vµ lo¹i bá phÇn biªn d¹ng c¾t qua mét hoÆc nhiÒu 

mÆt. PhÇn c¾t sÏ ®îc bao kÝn xung quanh mÆt uèn th¼ng gãc theo cÊu h×nh nÕp gÊp 

cña chi tiÕt tÊm. KiÓu c¾t bít nµy ®îc t¹o ra trªn chi tiÕt tÊm tríc khi nã ®îc uèn 

cong.  

- §Ó t¹o m¶nh c¾t:    

KÝch vµo nót Cut sau ®ã chän biªn d¹ng cÇn c¾t chän kiÓu c¾t vµ híng c¾t. 

Dïng tuú chän Extents ®Ó cã thÓ c¾t qua nhiÒu mÆt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           T¹o biªn d¹ng cÇn c¾t                                         C¸c tÊm sau khi bÞ c¾t 
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     -  C¾t qua mÆt uèn cong 

      Trong thanh c«ng cô Sketch më réng nót Project Geometry vµ kÝch vµo nót 

Project Flat Pattern. Trªn vËt khai triÓn t¹o mét biªn d¹ng kÝn. Sau ®ã chän biªn 

d¹ng vµ kÝch chuét vµo nót Cut. Trong hép tho¹i Cut chän Cut Across Bend. Víi tuú 

chän nµy th× Extents lu«n lµ chiÒu dµy vµ kh«ng thÓ thay ®æi. 

 

 

 

 

 

 

 

 

 

 

 

         MÆt uèn cong khi cha c¾t                                      MÆt uèn cong sau khi c¾t 

 

      C«ng cô Hole gièng nh c«ng cô Hole trong m« h×nh chi tiÕt. Ta cã thÓ t¹o 

ren trong lç vµ mét sè tuú chän kh¸c. 

5.3.6. T¹o gê mÐp (Flange) 

     Flange lµ mét c«ng cô m¹nh mµ lµm ®¬n gi¶n ho¸ thiÕt kÕ m« h×nh. VÝ dô ®Ó 

t¹o mét c¸nh cöa ta t¹o mét mÆt vµ sau ®ã bæ sung mét mÆt víi cïng chiÒu dµy vµ 

uèn cong c¹nh mµ kh«ng cÇn bæ sung biªn d¹ng. Ta cã thÓ thay ®æi chiÒu dµi cña 

Flange b»ng c¸ch sö dông kho¶ng offset tõ 2 ®èi tîng tham chiÕu. 

- T¹o Flange:  

KÝch chuét vµo c«ng cô Flange vµ chän 1 c¹nh. Flange sÏ ®îc hiÓn thÞ tríc. 

X¸c ®Þnh híng t¹o gê, chän chiÒu dµi mÆt gê vµ gi¸ trÞ kho¶ng offset nÕu yªu cÇu. 

NhËp gi¸ trÞ cho chiÒu s©u vµ gãc cña mÆt gê. Thay ®æi b¸n kÝnh uèn cong nÕu cÇn 

thiÕt. 
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5.3.7. T¹o mÆt uèn cong vµ c¸c ®êng nèi (Bend vµ Seam): 

        Autodesk Inventor ta cã thÓ t¹o c¸c mÆt uèn cong b»ng c«ng cô Face hoÆc 

bæ sung chóng riªng. NÕu t¹o mét chi tiÕt ®¬n gi¶n nh d¹ng hµng rµo. C¸ch nhanh 

nhÊt lµ t¹o mÆt uèn cong trong lÖnh Face. NÕu chi tiÕt phøc t¹p h¬n th× cã thÓ t¹o c¸c 

mÆt uèn cong riªng.  
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§iÒu nµy sÏ lµm cho viÖc chØnh söa ®¬n gi¶n h¬n. Trong lÖnh Bend ta cã thÓ t¹o 

c¸c mÆt uèn theo ®êng ph¸c th¶o hoÆc c¸c ®êng chiÕu vµ cã thÓ ®Þnh d¹ng c¸c 

c¹nh víi nhiÒu lo¹i ®êng viÒn ®¬n hoÆc ®óp. 

G¸n c¸c ®êng nèi gãc sau khi t¹o c¸c mÆt kÒ nhau. Khi t¹o ®êng nèi gãc 

mét trong c¸c c¹nh sÏ gèi lªn c¹nh kh¸c. NÕu c¸c mÆt ®ång ph¼ng c«ng cô Corner 

Seam sÏ t¹o ra mét ®Çu nèi. Ta cã thÓ t¸ch c¸c mÆt ®· ®îc nèi vµ xÎ c¸c gãc trªn 

m« h×nh ®Ó thÓ hiÖn t×nh tr¹ng mèi nèi. Mét vµi kiÓu gê ë gãc cã s½n trong Corner 

Seam. 

Sö dông c¸c tuú chän trªn menu ng÷ c¶nh cña cöa sæ duyÖt ta cã thÓ chuyÓn 

®æi mét mÆt uèn cong thµnh mèi nèi gãc vµ ngîc l¹i.    

- T¹o mÆt uèn cong tõ 2 mÆt:  

KÝch chuét vµo c«ng cô Bend vµ chän mét c¹nh trªn mçi mÆt. HÖ thèng sÏ c¾t 

hoÆc më réng c¸c mÆt ®Ó t¹o mÆt uèn cong, chØnh söa mÆt uèn cong nÕu thÊy cÇn 

thiÕt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                     Hai mÆt tríc khi uèn                                          Hai mÆt sau khi uèn 

 

    -T¹o mÆt uèn cong tõ mét ®êng cña ph¸c th¶o: 

 KÝch chuét vµo c«ng cô Fold vµ chän mét biªn d¹ng ph¸c th¶o. X¸c ®Þnh gãc 

vµ dïng c¸c tuú chän ®Ó ®Þnh nghÜa mÆt uèn cong. C¸c lùa chän sÏ ®îc ph¶n ¸nh 

b»ng c¸c mòi tªn xem tríc. KÝch chuét vµo Apply hoÆc OK ®Ó t¹o mÆt uèn cong. 
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Chi tiÕt tríc khi uèn cong                 Chi tiÕt sau khi uèn cong qua  

                                                                ®êng th¼ng 1 gãc 40o 

 

    -T¹o ®êng nèi gãc:   

KÝch chuét vµo c«ng cô Corner Seam vµ chän mét c¹nh trªn mçi mÆt. Chän 

c¹nh cÇn chång lªn sau ®ã nhËp vµo gi¸ trÞ cho khe hë (gap). NÕu cÇn thiÕt ta cã thÓ 

chän kiÓu chång 2 mÆt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           Hai tÊm tríc khi nèi gãc                                    Hai tÊm sau khi nèi gãc 

- XÎ mét gãc cña solid:  

KÝch chuét vµo c«ng cô Corner Seam vµ chän hai mÆt kÒ s¸t nhau. Sö dông c¸c 

lùa chän trong hép tho¹i Corner Seam mµ ta sÏ t¹o mét nèi gãc míi. 

- §Ó chuyÓn ®æi gãc:  
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KÝch chuét ph¶i vµo mét gãc hoÆc mét mÆt uèn cong  trong cöa sæ duyÖt sau ®ã 

kÝch chuét vµo Convert to Corner or Convert to Bend. §Þnh nghÜa gãc hoÆc mÆt 

uèn cong mµ ta sÏ t¹o ra. 

 

5.3.8. T¹o vËt khai triÓn (Flat Pattern): 

C«ng cô Flat Pattern khai triÓn m« h×nh chi tiÕt d¹ng tÊm vµ hiÓn thÞ vËt khai 

triÓn nµy trªn cöa sæ thø hai. VËt khai triÓn vµ m« h×nh cã thÓ hiÓn thÞ cïng mét 

thêi ®iÓm.  Trªn vËt khai triÓn mét mÆt uèn cong ®îc biÓu diÔn b»ng mét ®êng 

t©m vµ ®êng biªn d¹ng trong vµ ngoµi. C¸c phÇn tö thiÕt kÕ (Design Element) 

trªn vËt khai triÓn ®îc hiÓn thÞ nh m« h×nh 3D. Khi t¹o vËt khai triÓn hÖ thèng 

sÏ tÝnh to¸n kÝch thíc toµn bé hoÆc kho¶ng hë cña chi tiÕt.  

VËt khai triÓn tù ®éng cËp nhËt khi thay ®æi trªn m« h×nh. NÕu m« h×nh kh«ng 

tr¶i ph¼ng ®îc, vËt khai triÓn tù ®éng cËp nhËt ngay khi m« h×nh t¬ng thÝch trë 

l¹i. §iÒu nµy gióp ta dÔ dµng kh¶o s¸t c¸c lùa chän khi chÕ t¹o nh thay ®æi mÆt uèn 

cong vµ ®êng nèi gãc.    

- §Ó t¹o vËt khai triÓn:  

KÝch chuét vµo Flat Pattern trªn thanh c«ng cô Sheet Metal. NÕu chän mét mÆt 

th×  

c«ng cô tr¶i ph¼ng sÏ t¹o vËt khai triÓn cho mÆt ®ã. VËt khai triÓn sÏ ®îc t¹o 

trªn cöa sæ thø 2 vµ mét biÓu tîng vËt khai triÓn ®îc t¹o trong cöa sæ duyÖt.  

- §Ó x¸c ®Þnh kho¶ng hë cña vËt khai triÓn: 

KÝch chuét ph¶i vµo biÓu tîng cña vËt khai triÓn trong cöa sæ duyÖt vµ chän 

Extents. Mét dßng nh¾c hiÓn thÞ c¸c gi¸ trÞ X vµ Y. 

 

 

 

 

 

 

 

 

 

 

 

    Chi tiÕt tríc khi khai triÓn                             Chi tiÕt sau khi khai triÓn 

C¸c vËt khai triÓn ®îc t¹o b»ng phÇn mÒm MetalBender tõ d÷ liÖu Software 

+ Engineering 
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5.4. C¸c c«ng cô thiÕt kÕ chi tiÕt tÊm.        

Bé c«ng cô trong m«i trêng thiÕt kÕ chi tiÕt tÊm bao gåm mét sè c¸c c«ng cô 

trong Part Model vµ c«ng cô t¹o Sketch vµ bæ sung mét sè c«ng cô cña Sheet Metal.  

         

T

T 

Nót C«ng cô Chøc n¨ng 

1 

 

Styles Cµi ®Æt tham sè cho c¸c kiÓu chi tiÕt tÊm   

2 

 

Flat Pattern T¹o vËt khai triÓn cña chi tiÕt tÊm  

3 

 

Face T¹o mÆt chi tiÕt tÊm   

4 

 

Contour 

Flange 

Bæ sung gê cña ®êng biªn d¹ng cña chi tiÕt 

tÊm   

5 

 

Cut C¾t bá theo mét biªn d¹ng tõ mét mÆt cña chi 

tiÕt tÊm 

6 

 

Flange T¹o mét gê trªn mét c¹nh cña chi tiÕt tÊm. 

7 

 

Hem T¹o mét ®êng viÒn trªn chi tiÕt chi tiÕt tÊm  

8 

 

Fold T¹o mét mÆt uèn cong theo mét ®êng ph¸c 

th¶o trªn mét mÆt cña chi tiÕt tÊm. 

9 

 

Corner 

Seam 

T¹o mét gãc nèi gi÷a hai mÆt cña chi tiÕt tÊm. 

1

0 
 

Bend T¹o mÆt uèn cong gi÷a c¸c mÆt cña chi tiÕt 

tÊm. 

1

1 
 

Hole T¹o mét lç. C«ng cô nµy gièng nh trong thiÕt 

kÕ m« h×nh chi tiÕt. 

1

2  

Corner 

Round 

Vª trßn gãc. 

1

3  

Corner 

Chamfer 

V¸t mÐp c¸c gãc 

1

4 
 

View 

Catalog 

Më mÉu c¸c phÇn tö thiÕt kÕ 
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1

5 

 Insert 

Design 

Element 

ChÌn mét phÇn tö thiÕt kÕ 

1

6 

 Create 

Design 

Element 

T¹o mét phÇn tö thiÕt kÕ tõ mét Feature cã s½n 

 

MÑo:  

- Tù ®éng t¹o mÆt uèn cong víi mét mÆt: 

Ph¸c th¶o biªn d¹ng cho mÆt míi sao cho cã mét ®êng th¼ng n»m trªn mét c¹nh 

cña m« h×nh trªn mÆt cã s½n. C«ng cô mÆt sÏ tù ®éng t¹o mÆt uèn cong gi÷a c¸c mÆt. 

- T¹o c¸c phÇn tö thiÕt kÕ ( Design Element) cña c¸c h×nh d¸ng chuÈn: 

T¹o c¸c h×nh d¸ng chuÈn sö dông c«ng cô Cut hoÆc c¸c c«ng cô m« h×nh 

Feature nh Revolve. X©y dùng th viÖn c¸c h×nh d¹ng nµy víi chøc n¨ng Design 

Element. 

- T¹o c¸c phÇn tö thiÕt kÕ cña c¸c Feature ®îc Ðp vµo nhau: 

C¸c feature Cut cã thÓ ®îc ghi nh lµ c¸c phÇn tö thiÕt kÕ hoÆc ®îc dïng 

®Ó t¹o c¸c phÇn tö thiÕt kÕ. 

- T¹o c¸c mÆt rêi sau ®ã bæ sung c¸c mÆt uèn cong vµ c¸c ®êng nèi gãc: 

Ban ®Çu ta tËp trung gi¶i quyÕt theo môc ®Ých thiÕt kÕ sau ®ã tèi u ho¸ c¸c chi 

tiÕt ®Ó chÕ t¹o. 

 

- T¹o c¸c lç v¸t sö dông hép tho¹i Hole: 

Dïng hép tho¹i Hole ®Ó t¹o c¸c lç v¸t b¶o ®¶m c¸c lç ®îc nhËn ra vµ hiÓn 

thÞ chÝnh x¸c. NÕu c¸c lç th«ng ®îc t¹o ra vµ sau ®ã t¹o v¸t, chóng khong thÓ 

nhËn ra vµ hiÓn thÞ chÝnh x¸c.   
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CHƯƠNG 7 

L¾p r¸p (Assemblies) 
 

Trong ch¬ng nµy ta sÏ t×m hiÓu vÒ c¸c c«ng cô l¾p r¸p vµ tr×nh 

tù lµm viÖc ®Ó t¹o c¸c l¾p r¸p. Ta còng sÏ t×m hiÓu mét sè kü thuËt 

®Ó t¹o c¸c ph¸c th¶o (Sketch) vµ c¸c m« h×nh chi tiÕt (Part Model) 

mét c¸ch hiÖu qu¶ h¬n trong m«i trêng l¾p r¸p. §Ó cã thªm th«ng 

tin tham kh¶o, c¸c vÝ dô tr×nh diÔn, chØ dÉn c¸c bíc xem trªn online 

Help, Tutorial vµ Visual SyllabusTM.  

6.1. Giíi thiÖu chung 

Theo c¸ch truyÒn thèng, c¸c kü s vµ c¸c nhµ thiÕt kÕ t¹o s¬ ®å 

tr×nh bµy, thiÕt kÕ c¸c chi tiÕt sau ®ã l¾p  chóng víi nhau vµo trong 

côm l¾p. Trong Autodesk Inventor ta cã thÓ tæ chøc qu¸ tr×nh thiÕt 

kÕ b»ng c¸ch t¹o c¸c chi tiÕt In-place(chi tiÕt l¾p r¸p) hoÆc chÌn c¸c 

chi tiÕt cã s½n khi ta t¹o l¾p r¸p. §©y lµ ph¬ng ph¸p thiÕt kÕ lÊy 

côm l¾p lµm trung t©m hç trî chiÕn lîc thiÕt kÕ Top-Down(trªn 

xuèng), Bottom-up(díi lªn) vµ Middle-out(tõ gi÷a ra). 

- L¾p r¸p lµ g×? 

L¾p r¸p  lµ tËp hîp c¸c chi tiÕt vµ c¸c côm l¾p. Trong tµi liÖu nµy 

Component kÓ ®Õn c¸c chi tiÕt vµ c¸c côm l¾p.     

- Khi nµo th× sö dông m«i trêng l¾p r¸p: 

T¹o l¾p r¸p thêng lµ bíc cuèi cïng cña qu¸ tr×nh thiÕt kÕ. Khi 

c¸c chi tiÕt ®¬n lÎ ®· ®îc kiÓm nghiÖm vÒ kÕt cÊu. Víi Autodesk 

Inventor ta cã thÓ t¹o l¾p r¸p t¹i bÊt kú thêi diÓm nµo trong qu¸ 

tr×nh thiÕt kÕ. NÕu ta ®ang lµm viÖc víi mét thiÕt kÕ míi, ta cã thÓ 

b¾t ®Çu víi mét l¾p r¸p rçng sau ®ã t¹o c¸c chi tiÕt ®Ó hoµn thµnh 

thiÕt kÕ. NÕu ta chØnh söa mét l¾p r¸p ta cã thÓ t¹o c¸c chi tiÕt míi 

®Ó chÌn vµo l¾p r¸p sao cho chóng l¾p víi c¸c chi tiÕt cã s½n.  

- C¸c chi tiÕt vµ c¸c côm l¾p r¸p thÝch nghi lµ g×: 

Trong l¾p r¸p thÝch nghi ta cã thÓ t¹o c¸c chi tiÕt mµ nã thÝch 

nghi víi c¸c chi tiÕt kh¸c. VÝ dô t¹o mét miÕng ®Öm, ta ®Þnh nghÜa nã 

nh lµ mét chi tiÕt thÝch nghi, sau ®ã ta t¹o c¸c rµng buéc gi÷a c¸c 
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mÆt cña miÕng ®Öm víi c¸c mÆt cña c¸c chi tiÕt ghÐp víi nã. MiÕng 

®Öm sÏ co d·n ®Ó võa khÝt víi kho¶ng trèng gi÷a 2 chi tiÕt. 

C¸c u ®iÓm cña c«ng nghÖ thÝch nghi: 

+ Cã thÓ chÌn vµ thÝch nghi c¸c chi tiÕt lµm viÖc trong l¾p r¸p. 

+ Cã thÓ t¹o c¸c chi tiÕt ®Ó chÌn vµ thÝch nghi chóng khi thiÕt 

kÕ. 

+ Cã thÓ chØnh söa c¸c l¾p r¸p cã c¸c chi tiÕt thÝch nghi thay 

®æi. 

- C¸ch thiÕt kÕ c¸c chi tiÕt l¾p r¸p (In-place): 

Khi t¹o c¸c chi tiªt l¾p r¸p ta cã thÓ chän mét mÆt trªn chi tiÕt cã 

s½n lµm mÆt ph¸c th¶o cho chi tiÕt míi. Chän mÆt l¾p r¸p hîp lý t¹o 

thuËn lîi cho ®Þnh nghÜa thiÕt kÕ. 

- C¸c chi tiÕt dÉn xuÊt lµ g×: 

Chi tiÕt dÉn xuÊt lµ mét chi tiÕt míi mµ sö dông c¸c ®Æc tÝnh c¬ 

b¶n cña chi tiÕt cã s½n. Ta cã thÓ chØnh söa chi tiÕt dÉn xuÊt mµ 

kh«ng ¶nh hëng ®Õn chi tiÕt gèc. Ta cã thÓ cËp nhËt chi tiÕt dÉn 

xuÊt ®Ó cËp nhËt c¸c thay ®æi t¹o ra trªn chi tiÕt gèc. Ta cã thÓ ph¸ 

bá liªn kÕt gi÷a chi tiÕt dÉn xuÊt vµ chi tiÕt gèc nÕu ta kh«ng muèn 

cËp nhËt chi tiÕt dÉn xuÊt dùa trªn chi tiÕt gèc. 

- L¾p r¸p dÉn xuÊt lµ g×? 

L¾p r¸p dÉn xuÊt lµ mét chi tiÕt míi mµ dùa trªn l¾p r¸p cã s½n. 

Ta cã thÓ nhËp c¸c chi tiÕt trong mét l¾p r¸p thµnh mét thùc thÓ ®¬n 

vµ còng cã thÓ c¾t bá mét chi tiÕt tõ mét chi tiÕt kh¸c. KiÓu thiÕt kÕ 

m« h×nh l¾p r¸p top-down t¹o sù trùc quan h¬n vµ gióp ta tr¸nh 

®îc c¸c lçi vµ tiÕt kiÖm thêi gian. 

6.2. C¸c tiÖn Ých: 

- Adaptive technology: C¸c chi tiÕt thÝch nghi t¹o cho c¸c l¾p r¸p 

chÝnh x¸c h¬n, c¸c kÝch thíc kh«ng cÇn chØ ra mét c¸ch chÝnh x¸c 

hoÆc kh«ng cÇn g¸n c¸c quan hÖ gi÷a c¸c chi tiÕt. 

- Design-in-place: T¹o vµ chØnh söa c¸c chi tiÕt trong kh«ng 

gian l¾p r¸p. 

- Design layouts: Sö dông c¸c s¬ ®å bè trÝ ®Ó thiÕt kÕ l¾p r¸p 

vµ c¸c chi 
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tiÕt tríc khi chuyÓn chóng thµnh c¸c solid 3D.   

- English and metric: T¹o c¸c l¾p  r¸p chøa c¸c chi tiÕt víi c¸c 

hÖ thèng  

®o kh¸c nhau. 

- IMates: Lu tr÷ c¸c th«ng tin rµng buéc ®îc ®Þnh nghÜa 

tríc víi mét  

chi tiÕt vµ sau ®ã dïng ph¬ng ph¸p kÐo rª ®Ó ®Æt chi tiÕt vµo l¾p 

r¸p. Ta còng cã thÓ thay mét chi tiÕt b»ng mét chi tiÕt kh¸c vµ vÉn 

duy tr× ®îc c¸c rµng buéc mÆt giíi h¹n th«ng minh. 

- Large assemblies: Lµm viÖc víi mét l¾p r¸p lín sö dông c¬ 

së d÷ liÖu  

®îc ph©n ®o¹n cña Autodesk Inventor. 

- Pack and Go: §ãng gãi mét l¾p r¸p trong Autodesk Inventor 

vµ tÊt c¶  

c¸c file tham chiÕu cña chóng sÏ ®îc ®Þnh vÞ trong mét vïng riªng. 

 

6.3. Tr×nh tù lµm viÖc: 

PhÇn nµy sÏ tr×nh bµy tæng quan vÒ c¸ch t¹o mét l¾p r¸p. Trªn  

online Help, Tutorial vµ Visual Syllabus cung cÊp nhiÒu th«ng tin 

h¬n vµ c¸c vÝ dô tr×nh diÔn, c¸c chØ dÉn tõng bíc.  

6.3.1. LËp kÕ ho¹ch lµm viÖc: 

Thø tù t¹o c¸c chi tiÕt vµ c¸c côm l¾p phô thuéc vµo viÖc ta tr¶ lêi 

c¸c c©u hái sau ra sao: 

- Ta chØnh söa mét l¾p r¸p cã s½n hay b¾t ®Çu mét l¾p r¸p míi? 

- Ta cã thÓ ®Ëp vì mét l¾p r¸p lín thµnh c¸c côm l¾p con ®îc 

kh«ng? 

- Ta cã thÓ dïng c¸c chi tiÕt cã s½n vµ c¸c phÇn tö thiÕt kÕ 

kh«ng? 

- Rµng buéc nµo sÏ ¶nh hëng ®Õn chøc n¨ng cña thiÕt kÕ?   

6.3.2. T¹o hoÆc chÌn thµnh phÇn l¾p r¸p ®Çu tiªn: 

Chän mét chi tiÕt hoÆc mét côm l¾p c¬ së (vÝ dô nh mét khung 

hoÆc tÊm kim lo¹i) lµm thµnh phÇn l¾p r¸p ®Çu tiªn cña l¾p r¸p. Ta 

cã thÓ chÌn mét thµnh phÇn l¾p r¸p cã s½n hoÆc t¹o míi mét thµnh 
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phÇn l¾p r¸p míi trong l¾p r¸p. Thµnh phÇn l¾p r¸p ®Çu tiªn nµy tù 

®éng ®îc g¸n cè ®Þnh ( tÊt c¶ c¸c bËc tù do ®Òu bÞ h¹n chÕ). Gèc to¹ 

®é vµ c¸c trôc to¹ ®é cña nã ®îc c¨n theo gèc vµ c¸c trôc to¹ ®é cña 

l¾p r¸p. 

- T¹o mét thµnh  phÇn l¾p r¸p:  

Chän Insert->New Component. Trong hép tho¹i Create  In-Place 

Component ta  nhËp vµo tªn File míi vµ kiÓu file ( Part hoÆc 

Assembly). Khi ®ã sÏ t¹o ra thµnh phÇn l¾p r¸p ®Çu tiªn. Tuú chän 

Mate Sketch Plane to Selected Face bÞ Èn ®i. KÝch chuét vµo nót 

More ®Ó chØ ra vïng ghi file míi vµ Template.  

 

 

 

 

 

 

 

 

 

 

- ChÌn mét thµnh phÇn l¾p r¸p cã s½n: 

Chän Insert->Existing Component. DuyÖt qua c¸c file cÇn më 

trong hép tho¹i Open. KÝch chuét vµo cöa sæ ®å ho¹ ®Ó chÌn thµnh 

phÇn l¾p r¸p thµnh phÇn l¾p r¸p, cã thÓ chÌn nhiÒu b¶n mét lóc, kÕt 

thóc kÝch chuét ph¶i vµ chän Done. B¶n chÌn ®Çu tiªn sÏ lµ chi tiÕt 

cè ®Þnh c¸c b¶n kh¸c kh«ng cã c¸c rµng buéc l¾p r¸p.  
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6.3.3. §Þnh vÞ c¸c thµnh phÇn l¾p r¸p  

Cã nhiÒu c¸ch ®Ó di chuyÓn c¸c thµnh phÇn  l¾p r¸p. NÕu mét 

thµnh phÇn  l¾p r¸p kh«ng ph¶i lµ  cè ®Þnh hoÆc kh«ng bÞ rµng buéc 

hoµn toµn, ta cã thÓ di chuyÓn nã trong vïng l¾p r¸p.  C¸c rµng buéc 

sÏ xo¸ mét vµi bËc tù do cña thµnh phÇn l¾p r¸p nµy. Cã thÓ dÞch 

chuyÓn mét thµnh phÇn l¾p r¸p theo c¸c bËc tù do cßn l¹i. 

Khi mét chi tiÕt hoÆc mét côm l¾p ®îc cè ®Þnh nã sÏ ®îc cè 

®Þnh trong hÖ to¹ ®é l¾p r¸p. Chi tiÕt cè ®Þnh nµy sÏ ®îc m« t¶ b»ng 

mét biÓu tîng riªng trªn cöa sæ duyÖt. BÊt kú thµnh phÇn l¾p r¸p 

nµo trong mét l¾p r¸p còng cã thÓ ®îc cè ®Þnh. Thµnh phÇn l¾p r¸p 

®Çu tiªn cña l¾p r¸p ®îc tù ®éng cè ®Þnh tuy nhiªn ta cã thÓ huû bá 

tr¹ng th¸i cè ®Þnh cña nã.   

Mét thµnh phÇn l¾p r¸p cè ®Þnh th× kh«ng gièng nh c¸c thµnh 

phÇn l¾p r¸p rµng buéc kh¸c. Mét thµnh phÇn l¾p r¸p cè ®Þnh ®îc 

cè ®Þnh vµo hÖ trôc to¹ ®é l¾p r¸p. Mét thµnh phÇn l¾p r¸p rµng 

buéc th× cã  quan hÖ víi c¸c thµnh phÇn l¾p r¸p kh¸c mµ ®Þnh nghÜa 

vÞ trÝ cña nã. §©y lµ sù t¸c ®éng lÉn nhau gi÷a c¸c thµnh phÇn l¾p 

r¸p. VÝ dô nÕu ta dïng c«ng cô Move or Rotate ®Ó t¹m thêi ®Þnh vÞ 

l¹i mét thµnh phÇn l¾p r¸p ®îc rµng buéc khi Update thµnh phÇn 

l¾p r¸p nµy sÏ trë l¹i vÞ trÝ rµng buéc cña nã. 

Khi dÞch chuyÓn mét thµnh phÇn l¾p r¸p cè ®Þnh b»ng c«ng cô 

Move or Rotate, bÊt kú thµnh phÇn l¾p r¸p nµo  mµ cã rµng buéc tíi 

nã sÏ cïng dÞch chuyÓn tíi vÞ trÝ míi cña thµnh phÇn l¾p r¸p cè ®Þnh. 
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     BiÓu tîng chi tiÕt ®Þnh vÞ trªn cöa sæ duyÖt 

 

- HiÓn thÞ c¸c bËc tù do cã s½n: 

KÝch chuét ph¶i vµo chi tiÕt trong cöa sæ duyÖt hoÆc cöa sæ ®å 

ho¹ sau ®ã chän Properties. Trong hép héi tho¹i Properties chän 

nót Occurrence, ®¸nh dÊu vµo hép kiÓm Degrees of Freedom sau 

®ã kÝch chuét vµo OK. §Ó t¾t chÕ ®é hiÓn thÞ bËc tù do ta bá ®¸nh 

dÊu hép kiÓm trªn. Ta còng cã thÓ sö dông tuú chän Degrees of 

Freedom trong menu View. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 72 

 

- Thay ®æi tr¹ng th¸i cè ®Þnh cña mét thµnh phÇn l¾p r¸p: 

KÝch chuét ph¶i vµo chi tiÕt trªn cöa sæ duyÖt sau ®ã chän 

hoÆc bá ®¸nh dÊu vµo Grounded. 

 

 

 

 

 

 

 

 

 

 

 

- Di chuyÓn hoÆc quay thµnh phÇn l¾p r¸p cè ®Þnh: 

  KÝch chuét vµo c«ng cô Move Component or Rotate 

Component trªn thanh c«ng cô Assembly. Sau ®ã kÐo rª thµnh 

phÇn l¾p r¸p cè ®Þnh tíi vÞ trÝ míi. Khi kÝch chuét vµo Update bÊt 

kú c¸c thµnh phÇn l¾p r¸p rµng buéc nµo sÏ ®îc ®Þnh vÞ l¹i tíi vÞ 

trÝ míi. 
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- Di chuyÓn mét thµnh phÇn l¾p r¸p víi mét kho¶ng c¸ch x¸c 

®Þnh:   

KÝch chuét ph¶i vµo thµnh phÇn l¾p r¸p cÇn di chuyÓn sau ®ã 

chän  

Properties->Occurrence. Ta cã thÓ nhËp sè cho c¸c gi¸ trÞ dÞch 

chuyÓn theo c¸c trôc to¹ ®é X,Y,Z. Ta còng cã thÓ bËt t¾t tr¹ng th¸i 

cè ®Þnh cña thµnh phÇn l¾p r¸p cè ®Þnh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Di chuyÓn hoÆc quay t¹m thêi c¸c thµnh phÇn l¾p r¸p rµng 

buéc:  

KÝch chuét vµo c«ng cô Move Component or Rotate 

Component trªn thanh c«ng cô Assembly. Dïng c¸c c«ng cô nµy ®Ó 

di chuyÓn hoÆc quay t¹m thêi c¸c thµnh phÇn l¾p r¸p mµ kh«ng xo¸ 

mÊt rµng buéc. Thµnh phÇn l¾p r¸p rµng buéc sÏ trë l¹i vÞ trÝ ban 

®Çu cña nã khi ta kÝch chuét vµo Update. 
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6.3.4. Bæ sung c¸c thµnh phÇn l¾p r¸p  

Trong m«i trêng l¾p r¸p ta cã thÓ t¹o mét côm l¾p, mét chi 

tiÕt míi hoÆc chÌn mét chi tiÕt hay mét côm l¾p cã s½n. Khi t¹o mét 

Component in-place míi ta cã thÓ g¸n mÆt ph¼ng ph¸c th¶o trong 

mÆt quan s¸t hiÖn hµnh hay rµng buéc nã tíi mét mÆt cña thµnh 

phÇn l¾p r¸p cã s½n. Ta cã thÓ chÌn nã vµo vïng l¾p r¸p sau ®ã bæ 

sung c¸c rµng buéc.  

Khi mét thµnh phÇn l¾p r¸p ®îc kÝch ho¹t th× c¸c thµnh phÇn 

l¾p r¸p cßn l¹i sÏ bÞ mê ®i trong cöa sæ duyÖt. ChØ cã mét thµnh 

phÇn l¾p r¸p cã thÓ ®îc kÝch ho¹t t¹i mét thêi ®iÓm. Bé phËn l¾p 

r¸p tù nã ph¶i ®îc kÝch ho¹t khi t¹o hoÆc chÌn mét thµnh phÇn l¾p 

r¸p. 

- KÝch ho¹t chi tiÕt: KÝch ®óp vµo tªn chi tiÕt trong cöa sæ duyÖt. 

C¸c chi tiÕt cßn l¹i sÏ bÞ mê ®i. 

- KÝch ho¹t mét côm l¾p: KÝch ®óp vµo lªn cña cña côm l¾p 

trong cöa sæ duyÖt hoÆc kÝch chuét ph¶i trong cöa sæ ®å ho¹ vµ 

chän Finish Edit. 

Chó ý: Finish Edit sÏ bÞ Èn trªn menu ng÷ c¶nh trong khi ®èi 

tîng h×nh häc ®îc chän trong cöa sæ ®å ho¹. 
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- T¹o mét Component in-place:  

KÝch chuét vµo c«ng cô Create Component. NÕu cÇn t¹o rµng 

buéc gi÷a mÆt ph¸c th¶o vµ mét mÆt cña chi tiÕt cã s½n th×  chän 

Constrain Sketch Plane to Selected Face trong hép tho¹i Create In-

Place Component. 

C¸ch kh¸c cã thÓ kÝch chuét vµo mét vÞ trÝ trong cöa sæ ®å ho¹ ®Ó 

x¸c ®Þnh mÆt ph¸c th¶o. 

 

 

 

 

 

 

 

 

 

- T¹o mét chi tiÕt hoÆc mét côm l¾p dÉn xuÊt:  

DuyÖt vµ më file part (.ipt) ®èi víi Feature c¬ së. Trong thanh 

c«ng cô Feature kÝch chuét vµo nót Derived Component. X¸c ®Þnh 

hÖ sè tû lÖ, mÆt ®èi xøng vµ kÝch OK. NÕu ta chØnh söa Feature cña 

chi tiÕt dÉn xuÊt kÝch chuét ph¶i vµ chän Update Derived Feature. 

§Ó ph¸ huû liªn kÕt vµ kh«ng cËp nhËt sù thay ®æi cña chi tiÕt gèc, 

kÝch chuét ph¶i  vµo Feature dÉn xuÊt trong cöa sæ duyÖt vµ kÝch 

chuét vµo Break link.  

- ChÌn mét chi tiÕt hoÆc mét côm l¾p:  

KÝch chuét vµo c«ng cô Place Component sau ®ã chØ râ file cÇn 

chÌn . KÝch chuét vµo cöa sæ ®å ho¹ ®Ó ®Þnh vÞ thµnh phÇn l¾p r¸p 

khi chÌn. Mçi lÇn kÝch chuét vµo cöa sæ ®å ho¹ sÏ chÌn mét b¶n cña 

chi tiÕt hoÆc côm l¾p cÇn chÌn. Kh«ng cã rµng buéc nµo ®îc g¸n 

khi dïng c«ng cô Place Component.  
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6.3.5. T¹o m¶ng c¸c thµnh phÇn l¾p r¸p:  

B¹n cã thÓ t¹o m¶ng chi tiÕt, nhãm chi tiÕt, côm l¾p. C¸c thµnh 

phÇn l¾p r¸p ®îc t¹o m¶ng cã thÓ bao gåm c¸c rµng buéc vµ lµ c¸c 

®èi tîng l¾p r¸p duy nhÊt víi c¸c ®Æc tÝnh kh«ng cã trong c¸c 

thµnh phÇn l¾p r¸p chÌn th«ng thêng. Ta cã thÓ t¹o c¸c thµnh phÇn 

l¾p r¸p ®îc t¹o m¶ng mµ cã liªn kÕt tíi m¶ng c¸c Feature chi tiÕt. 

VÝ dô, Mét m¶ng c¸c lç cã thÓ tån t¹i cïng víi c¸c bul«ng mµ cã mèi 

liªn hÖ víi m¶ng c¸c lç. NÕu sè lç thay ®æi th× sè bu long còng thay 

®æi theo. 

- §Ó t¹o m¶ng c¸c thµnh phÇn l¾p r¸p :  

KÝch chuét vµo c«ng cô Pattern Component sau ®ã chän nót 

Rectangular hoÆc  

Circular. Ta cã thÓ chän c¸c thµnh phÇn l¾p r¸p cÇn t¹o m¶ng 

trong cöa sæ duyÖt hoÆc trong cöa sæ ®å ho¹. Sau ®ã chän c¸c c¹nh 

cña thµnh phÇn l¾p r¸p, c¸c trôc lµm viÖc hoÆc c¸c trôc to¹ ®é ®Ó 

x¸c ®Þnh híng cña c¸c hµng vµ c¸c cét hoÆc trôc quay. NhËp sè 

phÇn tö vµ kho¶ng c¸ch gi÷a c¸c phÇn tö. 

Chó ý:Mçi lÇn chÌn mét thµnh phÇn l¾p r¸p hoÆc t¹o mét 

m¶ng tõ mét thµnh phÇn l¾p r¸p, Autodesk Inventor liªn kÕt nã tíi 

tÊt c¶ c¸c c¸ thÓ kh¸c cña thµnh phÇn l¾p r¸p ®ã. Thay ®æi mét m« 

h×nh ®¬n sÏ lµm thay ®æi tÊt c¸c c¸c c¸ thÓ kh¸c. §Ó t¹o mét thµnh 

phÇn l¾p r¸p míi dùa trªn thµnh phÇn l¾p r¸p kh¸c, ghi phiªn b¶n 

víi tªn kh¸c vµ chÌn phiªn b¶n vµo trong l¾p r¸p.     
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6.3.6. Thay ®æi c¸c thµnh phÇn l¾p r¸p:  

ViÖc c¸c nhµ thiÕt kÕ thay ®æi mét chi tiÕt trong l¾p r¸p lµ viÖc 

thêng xuyªn diÔn ra. Autodesk Inventor chÌn chi tiÕt míi víi c¸c 

trôc to¹ ®é cña nã ®îc c¨n theo c¸c trôc to¹ ®é cña chi tiÕt cã s½n. 

Ta ph¶i g¸n bÊt kú rµng buéc nµo cho nã. 

 - §Ó thay ®æi mét thµnh phÇn l¾p r¸p:  

KÝch chuét vµo c«ng cô Replace Component trªn thanh c«ng cô 

Assembly sau ®ã chän thµnh phÇn l¾p r¸p cÇn thay ®æi sau ®ã t×m 

®Õn thµnh phÇn l¾p r¸p míi. TÊt c¶ c¸c rµng buéc trªn thµnh phÇn 

l¾p r¸p cã s½n sÏ bÞ mÊt trong khi thay ®æi. 

6.3.7. Bæ sung c¸c rµng buéc tíi c¸c thµnh phÇn l¾p r¸p: 

Ta cã thÓ bæ sung 4 kiÓu rµng buéc tíi c¸c thµnh phÇn l¾p r¸p: 

mate, angle, tangent vµ insert. Mçi kiÓu cña rµng buéc cã nhiÒu 

ph¬ng ¸n. C¸c ph¬ng ¸n ®îc ®Þnh nghÜa bëi híng cña c¸c vÐct¬ 

vu«ng gãc víi thµnh phÇn l¾p r¸p. Ta cã thÓ Mate c¸c thµnh phÇn 

l¾p r¸p b»ng c¸ch nhÊn phÝm Alt vµ kÐo rª chi tiÕt vµo vÞ trÝ Mate. 

Ph¬ng ph¸p nµy th× nhanh bëi v× kh«ng cÇn nhËp lÖnh t¹o rµng 

buéc. Mét sè bËc tù do sÏ bÞ mÊt khi ta thªm c¸c rµng buéc. C¸c bËc 

tù do cã thÓ vÉn cã s½n nhng bÞ h¹n chÕ. VÝ dô nÕu ta g¸n mét rµng 

buéc Tangent tíi 2 qu¶ cÇu tÊt c¶ s¸u bËc tù do vÉn cßn nhng ta 

kh«ng thÓ dÞch chuyÓn mét qu¶ cÇu dï chØ lµ theo mét híng. Thö 

dùng mét vµi chi tiÕt ®Ó xem c¸c rµng buéc h¹n chÕ chuyÓn ®éng cña 

chóng nh thÕ nµo. 
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- T¹o rµng buéc 2 mÆt, c¹nh, ®iÓm hoÆc c¸c Work Feature víi 

nhau:  

Trong hép tho¹i Place Constraint kÝch chuét vµo Mate. Ta cã hai 

ph¬ng ¸n trong lÖnh Mate lµ Mate vµ Flush nh minh ho¹ h×nh 

díi ®©y. NÕu ta muèn c¸c mòi tªn vu«ng gãc híng vµo nhau th× ta 

chän Mate. NÕu ta muèn c¸c ®èi tîng h×nh häc ®Æt c¹nh nhau vµ 

c¸c mòi tªn theo cïng mét híng ta chän Flush. NÕu muèn t¹o khe 

hë nhËp gi¸ trÞ khe hë vµo hép offset. 
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- T¹o rµng buéc hai mÆt hoÆc hai c¹nh hîp víi nhau mét gãc 

nhÊt ®Þnh:  

Trong hép tho¹i Place Constraint kÝch chuét vµo Angle. Ta cã 

thÓ chän c¸c vect¬ vu«ng gãc víi c¸c mÆt hoÆc c¸c c¹nh riªng. Cã 

4 gi¶i ph¸p cho mçi cÆp l¾p r¸p. C¸c mÆt ®îc lùa chän cña chi 

tiÕt sÏ ®îc rµng buéc theo gãc.  

 

 

 

 

 

 

 

 

 

 

 

 

- T¹o rµng buéc cña mét mÆt cong víi mét mÆt ph¼ng hoÆc mét 

mÆt cong kh¸c: 

Trong hép tho¹i Place Constraint kÝch chuét vµo Tangent. 

Trong trêng hîp nµy ta cã hai ph¬ng ¸n lµ tiÕp xóc trong vµ 

tiÕp xóc ngoµi nh h×nh díi ®©y.. 
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- T¹o rµng buéc ngang b»ng gi÷a lç vµ mÆt trô: 

Trong hép tho¹i Place Constraint kÝch chuét vµo Insert. LÖnh 

nµy sÏ g¸n ®ång t©m cña c¸c cung trßn hoÆc ®êng trßn ®îc chän 

®Ó t¹o rµng buéc.  §Ó g¸n rµng buéc ta chän ®êng trßn trªn h×nh 

trô vµ trªn lç mµ ta muèn rµng buéc. 

Chó ý: C¸c rµng buéc Insert ®îc h¹n chÕ bëi c¸c bÒ mÆt ph¼ng 

mµ vu«ng gãc víi ®êng trôc cña h×nh trô vµ cña lç.  
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6.3.8. Sö dông c¸c rµng buéc ®éng: 

Sau khi ta rµng buéc mét thµnh phÇn l¾p r¸p ta cã thÓ m« 

pháng qu¸ tr×nh chuyÓn ®éng c¬ häc b»ng c¸ch thay ®æi gi¸ trÞ cña 

rµng buéc. C«ng cô Drive Constraint ®Æt l¹i vÞ trÝ mét chi tiÕt qua 

tõng bíc theo gi¸ trÞ rµng buéc. Ta cã thÓ quay mét thµnh phÇn l¾p 

r¸p. VÝ dô b»ng c¸ch t¹o rµng buéc gãc ®éng tõ 0 ®Õn 3600 ta cã thÓ 

m« pháng qu¸ tr×nh ch¹y cña chiÕc ®ång hå.  

 

 

 

 

 

 

 

 

C«ng cô Drive Constraint ®îc giíi h¹n tíi mét rµng buéc. Ta 

cã thÓ ®iÒu khiÓn c¸c rµng buéc bæ sung b»ng c¸ch sö dông c«ng cô 

Parameters ®Ó t¹o c¸c quan hÖ sè häc gi÷a c¸c rµng buéc. 

 

 

 

 

 

 

 

- §Ó ®iÒu khiÓn rµng buéc:  

KÝch chuét ph¶i vµo rµng buéc trong cöa sæ duyÖt sau ®ã chän 

Drive Constraint. NhËp vµo gi¸ trÞ ®Çu vµ gi¸ trÞ cuèi vµ thêi gian 

dõng gi÷a c¸c bíc. KÝch chuét vµo nót More ®Ó ®Æt kho¶ng dÞch 

chuyÓn cho tõng bíc, sè lÇn lÆp l¹i vµ ®Þnh nghÜa chu kú. Chän 

Start/End dÞch chuyÓn sÏ t¨ng dÇn tõ ®iÓm ®Çu ®Õn ®iÓm cuèi, sau 

®ã trë l¹i vÞ trÝ ban ®Çu tríc khi b¾t ®Çu mét chu kú míi. 
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Start/End/Start dÞch chuyÓn t¨ng dÇn tõ ®iÓm ®Çu ®Õn ®iÓm cuèi sau 

®ã dÞch chuyÓn gi¶m dÇn vÒ ®iÓm ®Çu tríc khi lÆp l¹i. KÝch chuét 

vµo c¸c nót Forward, Rewind hoÆc Stop ®Ó ®iÒu khiÓn chuyÓn ®éng. 

 

6.3.9. Bæ sung rµng buéc cho c¸c chi tiÕt thÝch nghi: 

Cã thÓ t¹o c¸c chi tiÕt ®Æt díi sù rµng buéc mµ ®îc thÝch nghi 

theo rµng buéc ®ã trong l¾p r¸p. B»ng c¸ch nµy, chøc n¨ng thiÕt kÕ 

sÏ ®iÒu khiÓn h×nh d¹ng cña c¸c thµnh phÇn l¾p r¸p . VÝ dô, ta cã thÓ 

t¹o mét miÕng ®Öm vµ g¸n c¸c rµng buéc sao cho nã sÏ kÐo d·n hoÆc 

thu nhá ®Ó ®iÒn ®Çy khe hë gi÷a hai chi tiÕt. 

 

Mét sè yªu cÇu ®Ó thÝch nghi: 

- Ph¸c th¶o ph¶i ®îc rµng buéc ®óng c¶ vÒ h×nh häc vµ kÝch 

thíc. NÕu ph¸c th¶o ®· bÞ g¸n toµn bé c¸c kÝch thíc th× 

Autodesk Inventor sÏ kh«ng thÓ thay ®æi kÝch thíc. NÕu cã 

nhiÒu kÝch thíc cßn thiÕu th× Autodesk Inventor cã thÓ thay 

®æi sai ®èi tîng h×nh häc. 

- Chi tiÕt ph¶i ®îc g¸n thÝch nghi trong l¾p r¸p. KÝch chuét 

ph¶i vµo chi tiÕt trong cöa sæ duyÖt cña l¾p r¸p sau ®ã chän 

Adaptive. 

- Feature ph¶i ®îc ®Æt thÝch nghi trong file chi tiÕt. KÝch ho¹t 

chi tiÕt sau ®ã kÝch chuét ph¶i vµo Feature trong cöa sæ duyÖt 

vµ chän Adaptive.  

- ChØ cã mét c¸ thÓ cña chi tiÕt cã thÓ ®îc thÝch nghi. NÕu mét 

chi tiÕt ®· ®îc thÝch nghi th× tuú chän Adaptivity sÏ bÞ mê ®i 

trªn menu ng÷ c¶nh. 

C¸c rµng buéc thÝch nghi ®îc g¸n sau khi thµnh phÇn l¾p r¸p ®· 

®îc rµng buéc vÒ vÞ trÝ. Tríc tiªn Autodesk Inventor ®Þnh vÞ l¹i 

chi tiÕt ®Ó ®¶m b¶o theo rµng buéc. NÕu thµnh phÇn l¾p r¸p kh«ng 

thÓ dÞch chuyÓn, hÖ thèng sÏ thÝch nghi chi tiÕt ®ã ®Ó ®iÒu chØnh 

kho¶ng trèng. NÕu thµnh phÇn l¾p r¸p ®· bÞ rµng buéc hoµn toµn, 

dßng nh¾c nh¾c ta ®ang t¹o c¸c rµng buéc thõa trªn chi tiÕt.  
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6.3.10. T¹o c¸c s¬ ®å bè trÝ 2D: 

TÊt c¶ c¸c kü thuËt dïng ®Ó t¹o c¸c chi tiÕt cã thÓ ®îc g¸n tíi 

s¬ ®å bè trÝ 2D. Ta cã thÓ dùng mét s¬ ®å 2D b»ng c¸ch t¹o c¸c chi 

tiÕt vµ ph¸c th¶o h×nh d¸ng bÒ ngoµi cña chóng nh c¸c ®êng ph¸c 

th¶o vµ c¸c ®iÓm t©m, kh«ng t¹o c¸c Feature. VÝ dô, ta cã thÓ t¹o 

mét c¬ cÊu ph¸c th¶o 2D, sau ®ã rµng buéc c¸c ®iÓm víi nhau vµ 

®iÕu khiÓn c¸c rµng buéc ®Ó quan s¸t chuyÓn ®éng. Ta cã thÓ thay 

®æi kÝch thíc cña chi tiÕt mét c¸ch ®¬n gi¶n b»ng c¸ch kÐo rª ph¸c 

th¶o cña chóng. Sau khi ®Þnh râ ®îc c¸c quan hÖ, hoµn thiÖn h×nh 

d¸ng vµ t¹o c¸c Feature. 

M« t¶ díi ®©y lµ c¬ cÊu tay quay con trît ®îc dùng tõ c¸c 

chi tiÕt 2D. C¸c Work Feature ®îc bæ sung sao cho c¸c rµng buéc 

l¾p r¸p cã thÓ ®îc g¸n. TÊt c¶ c¸c thay ®æi cã thÓ ®îc chØnh söa dÔ 

dµng. Chi tiÕt cã thÓ chØnh söa b»ng c¸ch kÐo rª. Ta cã thÓ thay ®æi 

kho¶ng c¸ch gi÷a t©m cña tay quay vµ chi tiÕt ®Õ cè ®Þnh b»ng c¸ch 

söa l¹i rµng buéc Mate. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 84 

6.3.11. KiÓm tra vµ ch¹m: 

Autodesk Inventor cã thÓ kiÓm tra va ch¹m gi÷a c¸c tËp hîp cña 

c¸c thµnh phÇn l¾p r¸p vµ c¸c thµnh phÇn l¾p r¸p trong mét tËp 

hîp. §Ó kiÓm tra nhanh ta cã thÓ chän thµnh phÇn l¾p r¸p ta cÇn 

kiÓm tra. VÝ dô, nÕu ta ®ang söa mét chi tiÕt trong l¾p r¸p ta cã thÓ 

giíi h¹n viÖc kiÓm tra va ch¹m cña c¸c thµnh phÇn l¾p r¸p ®ã khi 

chiô t¸c ®éng cña sù thay ®æi. 

- §Ó kiÓm tra va ch¹m cña c¸c thµnh phÇn l¾p r¸p:  

Chän Tools->Analyze Interferance. §Ó kiÓm tra va ch¹m gi÷a 

c¸c tËp hîp cña c¸c thµnh phÇn l¾p r¸p, chän thµnh phÇn l¾p r¸p 

cho tËp hîp ®Çu tiªn sau ®ã chän tËp hîp thø hai vµ kÝch chuét 

vµo OK. NÕu cã va ch¹m, Autodesk Inventor hiÓn thÞ va ch¹m 

nh lµ mét solid vµ hiÓn thÞ khèi lîng vµ träng t©m trong hép 

tho¹i. §Ó kiÓm tra va ch¹m trong mét tËp hîp, chän tÊt c¶ c¸c 

thµnh phÇn l¾p r¸p trong tËp hîp ®ã. TÊt c¶ c¸c chi tiÕt trong tËp 

hîp kiÓm tra sÏ ®îc tÝnh to¸n l¹i dùa vµo nhau vµ va ch¹m sÏ 

®îc hiÓn thÞ b»ng mµu ®á.          

Va ch¹m gi÷a hai chi tiÕt ®îc hiÓn thÞ theo diÔn t¶ díi ®©y. Khèi 

lîng vµ d÷ liÖu vÞ trÝ  ®îc hiÓn thÞ khi ta kÝch vµo More trong hép 

tho¹i. 
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6.3.12. T¹o c¸c quan s¸t thiÕt kÕ (Design View):     

Quan s¸t thiÕt kÕ lu gi÷ cÊu h×nh hiÓn thÞ l¾p r¸p , sau ®ã ta cã 

thÓ dïng tªn ®Ó gäi l¹i nã. 

Ta cã thÓ ghi c¸c cµi ®Æt díi ®©y: 

- Visibility on/off 

- Enable on/off 

- View orientation 

- Zoom factor 

- Browser expansion 

- Color overrides 

- §Ó t¹o quan s¸t thiÕt kÕ: 

 Trªn thanh c«ng cô cña cöa sæ duyÖt kÝch chuét vµo Design View. 

Trong hép tho¹i Design View nhËp vµo tªn cña quan s¸t thiÕt kÕ vµ 

vïng lu tr÷ sau ®ã kÝch chuét vµo Save.  
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- §Ó gäi l¹i quan s¸t thiÕt kÕ:  

Trªn thanh c«ng cô cña cöa sæ duyÖt më réng nót Design View vµ 

chän mét quan s¸t thiÕt kÕ. 

- §Ó cËp nhËt quan s¸t thiÕt kÕ:  

KÝch chuét vµo Design View vµ chän mét quan s¸t thiÕt kÕ. Thùc 

hiÖn c¸c thay ®æi vµ kÝch chuét vµo Save. 

6.3.13. CÊu tróc l¹i l¾p r¸p: 

CÊu tróc cña mét l¾p r¸p lµ tæ chøc c¸c thµnh phÇn l¾p r¸p. 

Nhãm c¸c chi tiÕt vµo trong mét côm l¾p ®Ó ®¬n gi¶n ho¸ cöa sæ 

duyÖt. Côm l¾p còng cã thÓ ph¶n ¸nh tiÕn tr×nh chÕ t¹o. Trong 

Autodesk Inventor ta cã thÓ thay ®æi c¸c thµnh phÇn l¾p r¸p cña 

côm l¾p hoÆc t¹o mét côm l¾p míi t¹i bÊt kú thêi ®iÓm nµo trong 

qu¸ tr×nh thiÕt kÕ.  

T¹i ®Ønh cña mét cÊu tróc l¾p l¸p cã thÓ bao gåm c¸c chi tiÕt vµ 

c¸c côm l¾p. Mçi mét côm l¾p cã thÓ bao gåm c¸c chi tiÕt vµ c¸c côm 

l¾p nhá h¬n kh¸c. ViÖc di chuyÓn mét thµnh phÇn l¾p r¸p ( mét chi 

tiÕt hoÆc mét côm l¾p) vµo trong mét côm l¾p lµm cho thµnh phÇn 

l¾p r¸p ®ã gi¶m xuèng mét cÊp (sau ®©y ta gäi t¾t lµ gi¶m cÊp) trong 

c©y cÊu tróc. Ngîc l¹i di chuyÓn mét thµnh phÇn l¾p r¸p ra ngoµi 

côm l¾p lµm cho thµnh phÇn l¾p r¸p ®ã t¨ng thªm mét cÊp (sau ®©y 

ta gäi t¾t lµ t¨ng cÊp). Khi ta t¨ng cÊp hay gi¶m cÊp mét thµnh phÇn 

l¾p r¸p th× hÖ thèng sÏ xo¸ c¸c rµng buéc. 

- T¨ng cÊp hoÆc gi¶m cÊp mét thµnh phÇn l¾p r¸p hoÆc côm l¾p: 

 KÝch chuét  ph¶i vµo thµnh phÇn l¾p r¸p cÇn ®a trong cöa sæ 

duyÖt vµ chän Demote(gi¶m cÊp) hoÆc Promote(t¨ng cÊp) tõ menu 

ng÷ c¶nh. NhËp vµo tªn file vµ kÝch OK. Mét côm l¾p míi sÏ ®îc 

t¹o ra vµ hiÓn thÞ trªn cöa sæ duyÖt.  
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- Di chuyÓn mét thµnh phÇn l¾p r¸p tíi mét côm l¾p riªng biÖt:  

KÝch chuét vµo thµnh phÇn l¾p r¸p trong cöa sæ duyÖt vµ kÐo nã 

tíi côm l¾p. BÊt kú nh÷ng rµng buéc cã s½n ®Òu bÞ xo¸ khái thµnh 

phÇn l¾p r¸p. Ta còng cã thÓ kÐo mét thµnh phÇn l¾p r¸p tíi côm 

l¾p trong Windows Explorer.  

 

Chó ý:  

Khi cÊu tróc l¹i c¸c thµnh phÇn l¾p r¸p lµ d¹ng nhãm, t¨ng cÊp 

hoÆc gi¶m cÊp, c¸c rµng buéc gi÷a c¸c thµnh phÇn l¾p r¸p ®ã ®îc 

gi÷ l¹i nhng c¸c rµng buéc tíi c¸c thµnh phÇn l¾p r¸p bªn ngoµi 

nhãm sÏ bÞ mÊt.   

6.3.14. T¹o danh môc chi tiÕt (Bills of Material): 

Ta cã thÓ t¹o danh môc chi tiÕt (BOM) cho l¾p r¸p. Danh môc 

nµy sÏ liÖt kª tÊt c¶ c¸c thµnh phÇn l¾p r¸p vµ c¸c thuéc tÝnh cña 

chóng. Thø tù c¸c thµnh phÇn l¾p r¸p trong cöa sæ duyÖt sÏ ®îc ®Æt 

mÆc ®Þnh. Ta cã thÓ s¾p xÕp chóng theo bÊt kú kiÓu thuéc tÝnh nµo. 

Ta còng cã thÓ t¹o BOM mµ chØ liÖt kª cho c¸c chi tiÕt ®îc chän. 

Ta còng cã thÓ t¹o danh môc c¸c chi tiÕt ®îc chän. 

- §Ó t¹o danh môc chi tiÕt: Chän Tools->Bill of Material, sau ®ã 

chän c¸c thuéc tÝnh cÇn lÊy ra vµ ®Þnh d¹ng danh s¸ch. 
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- S¾p xÕp danh môc vËt liÖu: KÝch chuét vµo Sort vµ x¸c ®Þnh 3 

cét s¾p xÕp vµ thø tù s¾p xÕp ( t¨ng dÇn hoÆc gi¶m dÇn). 

- §Ó bæ sung hoÆc xo¸ c¸c cét: KÝch chuét vµo Column Chooser 

vµ chän cét d÷ liÖu tõ c¸c trêng trong danh s¸ch Available 

Properties. Ta còng cã thÓ t¹o trêng míi vµ bæ sung chóng 

vµo trong danh s¸ch. 
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- XuÊt d÷ liÖu danh môc chi tiÕt: 

 KÝch chuét vµo Export sau ®ã x¸c ®Þnh kiÓu file, tªn file, tªn 

b¶ng vµ vÞ trÝ lu tr÷ trªn ®Üa. Ta cã thÓ xuÊt ra mét c¬ së d÷ liÖu, 

mét b¶ng tÝnh, mét file text…. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- §Ó ®Þnh d¹ng cét:  

KÝch chuét vµo More ta cã thÓ x¸c ®Þnh chiÒu réng vµ c¨n lÒ 

cña cét. 

- XuÊt b¶ng danh môc chi tiÕt víi nh÷ng chi tiÕt ®îc chän:  

Trong cöa sæ duyÖt chän c¸c chi tiÕt cÇn bao gåm trong danh 

môc. T¹o danh môc chi tiÕt, chØ nh÷ng chi tiÕt ®îc chän míi 

®îc liÖt kª trong danh môc chi tiÕt. 
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6.3.15.  §ãng gãi c¸c l¾p r¸p: 

Chøc n¨ng Pack and Go trong Autodesk Inventor ®ãng gãi 

l¾p r¸p  vµ tÊt c¶ c¸c file tham chiÕu cña nã trong mét vïng riªng. 

§iÒu nµy sÏ ®Æc biÖt tiÖn lîi khi ta cÇn:  

- Lu tr÷ c¸c file trªn ®Üa CD hoÆc trªn c¸c ph¬ng tiÖn kh¸c. 

- Göi bé hoµn chØnh c¸c files tíi ngêi b¸n hoÆc kh¸ch hµng. 

- T¸ch c¸c file ®· tham chiÕu ra khái c¸c file kh¸c trong cïng th 

môc nguån. 

- KiÓm tra c¸c cÊu h×nh xen kÏ trong c¸c file ®ãng gãi mµ kh«ng 

thay ®æi file nguån.  

- Sö dông Pack and Go cña Windows Explorer: KÝch chuét ph¶i 

vµo mét file cña Autodesk Inventor (.iam,.ipt,.idw,.ipn) sau ®ã 

chän Pack and Go 

- Sö dông Pack and Go cña Autodesk Inventor : KÝch chuét vµo  

File-> Design Assistant. Trong cöa sæ duyÖt cña Design Assistant 

kÝch chuét ph¶i vµ chän Pack and Go. 

6.4. C¸c c«ng cô l¾p r¸p: 

Khi t¹o hoÆc chØnh söa mét chi tiÕt trong l¾p r¸p, thanh c«ng 

cô l¾p r¸p kh«ng ®îc kÝch ho¹t trong khi thanh c«ng cô Part Model 

®îc kÝch ho¹t.  

 

T

T 

Nót 

lÖnh 
C«ng cô Chøc n¨ng 

1 
 

Place 

Component 

ChÌn mét chi tiÕt hoÆc mét côm 

l¾p cã s½n  

2 
 

Create 

Component 

T¹o mét côm l¾p hoÆc mét chi 

tiÕt míi trong m«i trêng l¾p r¸p 

3 
 

Pattern 

Component 
T¹o m¶ng c¸c chi tiÕt l¾p r¸p 

4 
 

Place 

Constraint 

G¸n rµng buéc gi÷a c¸c mÆt, c¸c 

c¹nh hoÆc c¸c Work Feature. 

C¸c rµng buéc cã thÓ ®îc thÝch 

nghi.   
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5 
 

Replace 

Component 

Thay mét chi tiÕt trong mét 

l¾p r¸p b»ng mét chi tiÕt kh¸c. 

6 
 

Replace All 
Thay nhiÒu chi tiÕt trong l¾p r¸p 

b»ng mét chi tiÕt kh¸c. 

7 
 

Move 

Component 

Cho phÐp dÞch chuyÓn t¹m thêi 

mét thµnh phÇn l¾p r¸p ®· ®îc 

rµng buéc. Thµnh phÇn l¾p r¸p 

nµy sÏ trë l¹i vÞ trÝ cò khi ta 

Update.   

8 
 

Rotate 

Component 

Cho phÐp quay t¹m thêi mét 

thµnh phÇn l¾p r¸p ®· ®îc rµng 

buéc. Thµnh phÇn l¾p r¸p sÏ trë 

l¹i vÞ trÝ cò khi ta Update.  

9 
 

Section Views 
HiÓn thÞ mét phÇn mÆt quan s¸t 

cña chi tiÕt 

     

MÑo:  

Sö dông c¸c kü thuËt díi ®©y ®Ó t¹o vµ qu¶n lý c¸c l¾p r¸p hiÖu 

qu¶ h¬n. 

- N¹p vµ cËp nhËt c¸c thµnh phÇn l¾p r¸p nhanh h¬n: 

+ T¾t chÕ ®é nh×n thÊy cña c¸c thµnh phÇn l¾p r¸p kh«ng cÇn 

thiÕt. 

Ta cã thÓ truy cËp tíi c¸c chi tiÕt dÔ h¬n vµ cËp nhËt ®å ho¹ 

nhanh h¬n. 

+ Dïng c¸c quan s¸t thiÕt kÕ (design view). 

T¹o c¸c quan s¸t thiÕt kÕ, lµm næi bËt c¸c vÊn ®Ó thiÕt kÕ ®Æc 

trng hoÆc c¸c hÖ thèng con trong l¾p r¸p vµ g¸n cho chóng khi më 

m« h×nh l¾p r¸p. 

+ T¾t thÝch nghi chi tiÕt: 

Sau khi ®Þnh kÝch cì thµnh phÇn l¾p r¸p, t¾t thÝch nghi ®Ó t¨ng 

tèc ®é tÝnh to¸n vµ tr¸nh c¸c thay ®æi bÊt ngê. 
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- Qu¶n lý c¸c thµnh phÇn l¾p r¸p: 

+ G¸n c¸c mµu kh¸c nhau cho c¸c thµnh phÇn l¾p r¸p kh¸c 

nhau. 

Chän c¸c mµu kh¸c nhau trong danh s¸ch mµu trªn thanh c«ng 

cô.                  

+ Dïng cöa sæ duyÖt ®Ó t×m thµnh phÇn l¾p r¸p. 

Di chuét ®Õn mét thµnh phÇn l¾p r¸p trong cöa sæ duyÖt ®Ó ®æi 

mµu nã trong cöa sæ ®å ho¹. 

+ Dïng mµu ®Ó nhËn ra c¸c nhãm thµnh phÇn l¾p r¸p. 

Sö dông c¸c thuéc tÝnh ®Ó t×m c¸c thµnh phÇn l¾p r¸p trong c¸c 

hÖ thèng con  riªng biÖt hoÆc tõ nhµ cung cÊp riªng vµ m· mµu cña 

chóng trong quan s¸t thiÕt kÕ ®îc ®Æt tªn. 

- Sö dông c¸c cÊu tróc file cã hiÖu qu¶: 

+ LËp kÕ ho¹ch lµm viÖc. 

X¸c ®Þnh l¾p r¸p chÝnh vµ c¸c côm l¾p con cña nã tríc khi t¹o 

c¸c chi tiÕt. 

+ Sö dông c¸c côm l¾p. 

T¹o c¸c côm l¾p nhá vµ ghÐp chóng thµnh côm l¾p lín h¬n. 

+ Sö dông c¸c ®Ò ¸n hîp lý. 

V¹ch râ vµ sö dông c¸c ®Ò ¸n ®Ó ®¬n gi¶n ho¸ ®Ò ¸n thiÕt kÕ. 

+ Sö dông c¸c th môc dïng chung. 

Sö dông c¸c th  viÖn dïng chung cho c¶ thiÕt kÕ vµ hoµn thiÖn 

c¸c chi tiÕt ®Ó thuËn tiÖn cho viÖc dïng chung d÷ liÖu cña c¸c ®Ò ¸n 

vµ trong nhãm thiÕt kÕ. 

- Qu¶n lý c¸c rµng buéc l¾p r¸p. 

+ B¾t ®Çu rµng buéc c¸c thµnh phÇn l¾p r¸p b»ng c¸ch mate 

c¸c mÆt ph¼ng. 

Sau ®ã bæ sung c¸c rµng buéc flush, tangent vµ angular. 

+ G¸n c¸c rµng buéc sau khi c¸c faeture ®· hoµn thiÖn. 

§Ó tr¸nh rµng buéc gi÷a c¸c feature mµ sau ®ã cã thÓ bÞ lo¹i bá 

trong qu¸ tr×nh thiÕt kÕ. 
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+ KÐo rª c¸c thµnh phÇn l¾p r¸p ®Ó kiÓm tra sù dÞch chuyÓn 

cña c¸c bËc tù do. 

Ta cã thÓ dÔ dµng thÊy mét thµnh phÇn l¾p r¸p ®îc rµng buéc 

nh thÕ nµo. 

+ §iÒu chØnh sù thÝch nghi feature b»ng c¸ch t¹o ph¸c th¶o 

hoÆc feature thÝch nghi. 

KÝch chuét ph¶i vµo feature trong cöa sæ duyÖt vµ chän 

Properties. Ta cã thÓ chän Feature, Sketch hoÆc c¶ hai ®Ó thÝch nghi. 

G¸n c¶ hai lµ thÝch nghi th× t¬ng ®¬ng víi chän Adaptive tõ menu 

ng÷ c¶nh. 

+ T¹o c¸c giao diÖn thµnh phÇn l¾p r¸p cho viÖc lÆp l¹i sö 

dông: 

+ Sö dông c¸c giao diÖn thµnh phÇn l¾p r¸p gäi lµ iMate. Ta cã 

thÓ chØ râ c¸c th«ng tin vÒ s¾p xÕp trªn c¸c chi tiÕt vµ l¾p r¸p ®Ó 

dïng l¹i.    

 

§iÒu híng b»ng cöa sæ duyÖt 

- ChuyÓn ®æi gi÷a c¸c quan s¸t thiÕt kÕ:  

KÝch vµo mòi tªn bªn c¹nh Design Views ®Ó chän quan s¸t thiÕt kÕ 

ho¹t ®éng hoÆc ®Ó trë l¹i quan s¸t mÆc ®Þnh. 

 

- Bé läc c¸c phÇn tö cña c¸c thµnh phÇn l¾p r¸p:  

KÝch vµo Filter trªn thanh c«ng cô cña cöa sæ duyÖt ®Ó Èn c¸c 

phÇn tö cña c¸c thµnh phÇn l¾p r¸p trong cÊu tróc. §iÒu nµy lµm 

®¬n gi¶n ®¸ng kÓ sù thÓ hiÖn cña cÊu tróc trong c¸c l¾p r¸p lín. 

- ChuyÓn ®æi cÊu tróc gi÷a c¸c c«ng viÖc l¾p r¸p vµ c¸c c«ng viÖc 

m« h×nh. 

KÝch vµo Filter vµ chän Assembly Tasks or Modeling Tasks. 

Assembly Tasks hiÓn thÞ c¸c rµng buéc díi mçi phÇn tö. Modeling 

Tasks hiÓn thÞ  cÊu tróc m« h×nh díi mçi phÇn tö vµ tÊt c¶ c¸c rµng 

buéc l¾p r¸p mét folder. 
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CHƯƠNG 8 

C¸c phÇn tö thiÕt kÕ  

(Design Elements) 

 

 

C¸c phÇn tö thiÕt kÕ lµ nh÷ng Feature mµ ta cã thÓ t¹o, lÊy ra vµ sö dông l¹i 

trong c¸c thiÕt kÕ cña ta. Ch¬ng nµy sÏ tr×nh bµy tæng quan vÒ c¸ch lµm viÖc cña 

c¸c phÇn tö thiÕt kÕ vµ c¸ch sö dông chóng trong m«i trêng Part Model. Ta sÏ t×m 

hiÓu t¹i sao c¸c c«ng cô Design Element lµ nh÷ng c«ng cô m¹nh nhÊt cña Autodesk 

Inventor. Cã thÓ tham kh¶o thªm vÒ c¸c vÝ dô tr×nh diÔn, híng dÉn tõng bíc trªn 

online Help vµ Tutorials.     

7.1. Giíi thiÖu chung: 

C¸c phÇn tö thiÕt kÕ lµ c¸c Feature hoÆc tËp hîp c¸c Feature mµ ta cã thÓ lÊy 

ra tõ c¸c chi tiÕt vµ g¸n cho c¸c chi tiÕt kh¸c. Sö dông c¸c kh¶ n¨ng quan hÖ cña c¸c 

chi tiÕt, tÊt c¶ nh÷ng thµnh viªn trong qu¸ tr×nh hîp t¸c thiÕt kÕ cã thÓ chi sÎ môc 

®Ých thiÕt kÕ vµ c¸c th«ng tin thiÕt kÕ. 

- PhÇn tö thiÕt kÕ lµ g×? 

C¸c phÇn tö thiÕt kÕ ®îc lu tr÷ trong c¸c file cã phÇn më réng lµ (.ide). Mét 

phÇn tö thiÕt kÕ lµm viÖc gièng nh mét biÓu mÉu (Template), sao chÐp  c¸c Feature 

tõ mét chi tiÕt vµ g¸n chóng vµo c¸c chi tiÕt kh¸c. C¸c phÇn tö thiÕt kÕ kh«ng ®îc 

liªn kÕt víi nhau. V× vËy mçi mét c¸ thÓ lµ ®éc lËp. C¸c phÇn tö thiÕt kÕ cã thÓ lµ c¸c 

chi tiÕt chuÈn mµ yªu cÇu kh«ng thay ®æi  hoÆc c¸c chi tiÕt tuú chän mµ cã thÓ ®îc 

thay ®æi tríc khi chÌn. 

- T¹i sao ta dïng c¸c phÇn tö thiÕt kÕ? 

RÊt nhiÒu c«ng ty khi thiÕt kÕ c¸c chi tiÕt mµ ph¶i dïng ®i dïng l¹i nhiÒu lÇn. 

Víi Autodesk Inventor ta cã thÓ lÊy ra vµ sö dông l¹i c¸c Feature.   

- Ta cã thÓ dïng c¸c phÇn tö thiÕt kÕ ë ®©u? 

C¸c phÇn tö thiÕt kÕ ®îc sö dông trong m«i trêng Part Model. PhÇn tö thiÕt 

kÕ cã thÓ lµ mét Feature c¬ së khi nã kh«ng phô thuéc trªn c¸c Feature kh¸c. 

7.2. C¸c tiÖn Ých: 

Díi ®©y lµ mét sè tiÖn Ých næi bËt gióp ta t¹o phÇn tö thiÕt kÕ cã hiÖu qu¶: 

- Design Element dialog: T¹o c¸c phÇn tö thiÕt kÕ tõ mét hép tho¹i hçn hîp. 

- Design Element Catalogs: T¹o vµ dïng chung c¸c phÇn tö thiÕt kÕ phøc 

t¹p ®Ó xóc tiÕn “ c¸c thñ thuËt tèt nhÊt”  cïng víi nhãm thiÕt kÕ. 
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- Design reuse: Sö dông l¹i nh÷ng thiÕt kÕ cã s½n ®· ®îc kiÓm nghiÖm 

®Ó t¨ng tèc ®é thiÕt kÕ vµ n©ng cao chÊt lîng. 

- Company Standards: T¹o danh môc c¸c feature mµ ph¶n ¸nh c¸c 

chuÈn thiÕt kÕ vµ qu¸ tr×nh chÕ t¹o. 

7.3. Tr×nh tù lµm viÖc: 

PhÇn nµy sÏ nªu tæng quan vÒ c¸c thñ tôc khi sö dông c¸c phÇn tö thiÕt kÕ. Cã 

thÓ tham kh¶o thªm trªn online Help vµ Tutorial. 

 

 

7.3.1. LËp kÕ ho¹ch lµm viÖc: 

Sau khi t¹o c¸c Feature cho mét chi tiÕt ta cã thÓ lÊy chóng ra ®Ó t¹o c¸c phÇn 

tö thiÕt kÕ. Khi t¹o mét phÇn tö thiÕt kÕ cÇn x¸c ®Þnh kÝch thíc nµo cã thÓ bÞ thay 

®æi khi nã ®îc sö dông trong chi tiÕt kh¸c. Ta còng cã thÓ ®Æt nh÷ng giíi h¹n thay 

®æi kÝch thíc. C¸c phÇn tö thiÕt kÕ ®îc ghi víi file cã phÇn më réng lµ(.ide). 

Sö dông c«ng cô Parameters trªn thanh c«ng cô chuÈn ®Ó g¸n nh÷ng tham sè 

mµ ta dù kiÕn ®a vµo phÇn tö thiÕt kÕ víi c¸c tªn diÔn t¶ tham sè ®ã. C¸c tªn tham 

sè tuú chän ®îc dïng tù ®éng trong danh s¸ch Parameters trong hép tho¹i Design 

Element. Ta cã thÓ t¹o c¸c phÇn tö thiÕt kÕ tõ c¸c Sketch cha sö dông cho c¸c cÊu 

tróc h×nh d¹ng vµ c¸c Feature mµ thÝch nghi tíi c¸c Feature kh¸c trong thiÕt kÕ cña 

ta vµ kÓ c¶ c¸c Sketch trong l¾p r¸p khi ph¸c th¶o s¬ ®å thiÕt kÕ.   

Sau khi ta t¹o mét phÇn tö thiÕt kÕ ta lu nã vµo trong danh môc. Dïng Win

 dows Explorer ta cã thÓ kÐo rª phÇn tö thiÕt kÕ tõ danh môc vµo trong file chi 

tiÕt hoÆc ta cã thÓ sö dông c«ng cô Insert Design Element. 

 

7.3.2. T¹o c¸c phÇn tö thiÕt kÕ: 

 C¸c nót Design Element cã s½n trªn thanh c«ng cô Feature khi ta më réng 

nót View Catalog.  

 

 

 

 

 

 

 

Khi ta kÝch chuét vµo nót Create Design Element hép tho¹i Design Element 

®îc hiÓn thÞ víi nh÷ng hép díi ®©y: 

- Selected Features : Chän c¸c Feature ®îc gép trong phÇn tö thiÕt kÕ 
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míi   

- Size Parameters: ChuyÓn tham sè kÝch cì vµo trong hép Size Parameters  

®Ó ®iÒu chØnh chóng theo phÇn tö thiÕt kÕ míi. 

- Position Geometry: ChuyÓn c¸c Work Feature cña m« h×nh h×nh häc ®îc  

dïng ®Ó ®Þnh vÞ vµo trong hép Position Geometry ®Ó ®iÒu chØnh chóng theo 

phÇn tö thiÕt kÕ míi. 

- T¹o mét phÇn tö thiÕt kÕ: 

 Më mét file Part kÝch chuét vµo nót Create Design Element. Trong hép tho¹i 

Create Design Element. Chän mét Feature ®Ó t¹o phÇn tö thiÕt kÕ míi. §Ó thay ®æi 

tªn gäi, nhËp vµo mét gi¸ trÞ, g¸n giíi h¹n hoÆc thay ®æi mét dßng nh¾c cho mét 

tham sè, chän vµ chuyÓn nã vµo trong hép Size Parameters. §Ó thay ®æi vÞ trÝ h×nh 

häc, chän vµ chuyÓn nã vµo trong hép Position Geometry. KÝch vµo Save ®Ó t¹o mét 

phÇn tö thiÕt kÕ míi.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                              Hép tho¹i khi t¹o mét phÇn tö thiÕt kÕ 

 

7.3.3. Quan s¸t c¸c Catalog cña c¸c phÇn tö thiÕt kÕ: 

C¸c file chøa c¸c phÇn tö thiÕt kÕ ®îc chøa trong th môc Catalog. Nót View 

Catalog ®îc ®Æt trong thanh c«ng cô Feature. 

 



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 97 

- Quan s¸t phÇn tö thiÕt kÕ: kÝch chuét vµo nót View Catalog. Windows  

Explorer sÏ më th môc catalog.  KÝch ®óp chuét vµo phÇn tö thiÕt kÕ 

Autodesk Inventor sÏ më nã. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- ChØnh söa phÇn tö thiÕt kÕ: kÝch chuét vµo nót View Catalog më mét phÇn tö 

thiÕt kÕ. KÝch chuét vµo c«ng cô Create Design Element. Trong hép tho¹i 

Create Design Element ®Þnh nghÜa l¹i phÇn tö thiÕt kÕ. 

 

7.3.4. ChÌn c¸c phÇn tö thiÕt kÕ: 

Nót Design Element ®· cã s½n trªn thanh c«ng cô Feature khi ta më réng nót 

View catalog. C¸c phÇn tö thiÕt kÕ kh«ng ®îc liªn kÕt, v× vËy ta cã thÓ chÌn nhiÒu 

c¸ thÓ trong mét chi tiÕt vµ bæ sung mçi mét c¸ thÓ mét c¸ch ®éc lËp. 

- ChÌn mét phÇn tö thiÕt kÕ: 

KÝch chuét vµo nót Insert Design Element vµ t×m mét phÇn tö thiÕt kÕ (Browser) 

hoÆc tõ catalog kÐo mét phÇn tö vµo trong cöa sæ lµm viÖc. NÕu ta ®ang trong m«i 

trêng l¾p r¸p th× mét chi tiÕt ph¶i ®îc kÝch ho¹t. Trong hép tho¹i Insert Design 

Element cÇn chän mét mÆt ph¸c th¶o hoÆc Work Feature. Ta cã thÓ thay ®æi gi¸ trÞ 

cho c¸c tham sè kÝch cì. Trong vïng ®å ho¹ kÝch chuét vµo mét mÆt hoÆc mét Work 

Plane ®Ó ®Þnh vÞ phÇn tö thiÕt kÕ. Ta cã thÓ kÝch ho¹t ngay mÆt ph¸c th¶o ®Ó ®Þnh vÞ 

chÝnh x¸c phÇn tö thiÕt kÕ. 

NÕu phÇn tö thiÕt kÕ cã th«ng tin kÌm theo nã, ta chän nót Information ®Ó xem.   

C«ng cô Insert Design Element híng dÉn qua tõng bíc trong suèt qu¸ tr×nh 

chÌn phÇn tö thiÕt kÕ. Bíc hiÖn hµnh ®îc hiÖn s¸ng trong cöa sæ duyÖt bªn tr¸i. Ta 
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cã thÓ kÝch chuét vµo cöa sæ duyÖt ®Ó chän c¸c bíc hoÆc kÝch chuét vµo nót Next 

hoÆc Back ®Ó thùc hiÖn qua tõng bíc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                  Hép tho¹i khi chÌn mét phÇn tö thiÕt kÕ 

 

- Chän mét phÇn tö thiÕt kÕ: kÝch chuét vµo nót Browse sau ®ã x¸c ®Þnh mét 

file cã phÇn më réng lµ (.ide). KÝch chuét vµo mét mÆt ®Ó ®Þnh vÞ phÇn tö thiÕt 

kÕ. Bá qua bíc nµy nÕu ta kÐo mét  phÇn tö thiÕt kÕ tõ catalog vµo trong cöa 

sæ lµm viÖc.       

 

 

 

 

 

 

 

 

 

 

 

 

- §Þnh vÞ gÇn ®óng mét phÇn tö thiÕt kÕ:  

 

   

Chi tiÕt khi 

cha chÌn phÇn tö 

thiÕt kÕ 

Chi tiÕt khi 

®· chÌn phÇn tö 

thiÕt kÕ 

PhÇn tö 

thiÕt kÕ khi 

chÌn 
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KÝch chuét vµo biÓu tîng dÞch chuyÓn vµ biÓu tîng quay t¹i mÆt c¬ së cña 

phÇn tö thiÕt kÕ. Di chuyÓn con trá vµ kÝch chuét khi phÇn tö thiÕt kÕ ®· ®Æt 

®óng vÞ trÝ. 

 

 

 

 

 

 

 

 

 

            BiÓu tîng dÞch chuyÓn (mµu ®á)                  BiÓu tîng quay(mÇu ®á) 

 

- §Æt kÝch cì phÇn tö thiÕt kÕ:  

KÝch chuét vµo value vµ nhËp mét gi¸ trÞ míi. NÕu gi¸ trÞ míi nhËp lín h¬n 

ph¹m vi cho phÐp th× Autodesk Inventor sÏ hiÖn dßng th«ng b¸o lçi vµ tho¸t khái 

trêng Edit. NÕu cã mét mòi tªn bªn c¹nh trêng Edit, kich chuét vµo mòi tªn vµ 

chän gi¸ trÞ tõ danh s¸ch. 
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- §Þnh vÞ chÝnh x¸c mét phÇn tö thiÕt kÕ:  

Chän Activate Sketch Edit Immediately. Autodesk Inventor kÝch ho¹t ph¸c th¶o 

khi ta kÝch vµo Finish.  Sau ®ã ta cã thÓ bæ sung c¸c rµng buéc tíi phÇn tö thiÕt kÕ.     

Sau khi ta ®· chÌn mét phÇn tö thiÕt kÕ, chØnh söa vÞ trÝ cña nã b»ng c¸ch kÝch 

chuét ph¶i vµo phÇn tö trong cöa sæ duyÖt vµ chän Edit Sketch.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MÑo:  

- Sö dông c«ng cô Equations ®Ó ®Þnh râ c¸c kÝch thíc trong ph¸c th¶o chi tiÕt. 

Khi ta t¹o mét phÇn tö thiÕt kÕ tõ mét chi tiÕt, Autodesk Inventor tù ®éng 

chän c¸c kÝch thíc ®· ®îc ®Æt tªn  nh lµ c¸c Size Parameter. Cã thÓ chÌn mét 

phÇn tö thiÕt kÕ mét c¸ch dÔ dµng h¬n khi Size Parameter cã c¸c tªn cã ý nghÜa râ 

rµng.  

- Tªn vÞ trÝ ®èi tîng h×nh häc. 

Ta cã thÓ ®¬n gi¶n ho¸ viÖc ®Æt phÇn tö thiÕt kÕ b»ng c¸ch ®a ra c¸c tªn diÔn t¶ 

c¸c vÞ trÝ h×nh häc. 

- Bæ sung c¸c th«ng tin cho phÇn tö thiÕt kÕ  

Më mét phÇn tö thiÕt kÕ trong Autodesk Inventor vµ kÐo rª mét file vÝ dô nh file 

Word hoÆc file HTML tõ Windows Explorer vµo trong Autodesk Inventor. §Ó kÝch 

ho¹t nót Infomation trong hép tho¹i Insert Design Element më réng Party thø 3 

trong cöa sæ duyÖt, kÝch chuét ph¶i vµo th«ng tin vµ chän Placement Help.   
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CHƯƠNG 9 

C¸c Quan s¸t Tr×nh diÔn   

( Presentation Views) 

 
C¸c quan s¸t tr×nh diÔn lµ c¸c quan s¸t thiÕt kÕ mµ ta t¹o ra tõ l¾p r¸p. 

Ch¬ng nµy sÏ tr×nh bµy tæng quan vÒ c¸c c«ng cô vµ tr×nh tù lµm viÖc dïng ®Ó t¹o 

c¸c quan s¸t khi l¾p r¸p vµ khi th¸o c¸c l¾p r¸p. Cã thÓ tham kh¶o thªm trªn online 

Help vµ Tutorial. 

8.1. Giíi thiÖu chung: 

Trªn c¬ së c¸c t liÖu tr×nh diÔn, ta cã thÓ t¹o ra c¸c quan s¸t th¸o l¾p vµ ®Þnh 

vÞ c¸c thµnh phÇn l¾p r¸p. Ta còng cã thÓ t¹o ra ho¹t h×nh cña c¸c quan s¸t qu¸ 

tr×nh th¸o l¾p. 

- T liÖu tr×nh diÔn lµ g×:  

T liÖu tr×nh diÔn gièng nh lµ mét l¾p r¸p kh«ng cã c¸c rµng buéc. Khi  

t¹o mét quan s¸t tr×nh diÔn míi Autodesk Inventor sÏ sö dông c¸c th«ng tin ®å 

ho¹ vµ c¸c vÞ trÝ t¬ng quan cña c¸c thµnh phÇn l¾p r¸p. Khi mét thµnh phÇn trong 

l¾p r¸p bÞ chØnh söa th× c¸c th«ng tin ®å ho¹ sÏ ®îc cËp nhËt. 

- Ta cã thÓ cã bao  nhiªu quan s¸t: 

Ta cã thÓ t¹o ®ñ sè lîng quan s¸t cÇn thiÕt. T liÖu tr×nh diÔn ®îc liªn  

kÕt tíi l¾p r¸p, v× vËy ta cã thÓ t¹o tÊt c¶ c¸c quan s¸t yªu cÇu trong t liÖu. 

- Ta cã thÓ biÓu diÓn c¸c côm l¾p riªng nh thÕ nµo: 

T¹o mét quan s¸t thiÕt kÕ mµ chØ thÓ hiÖn c¸c thµnh phÇn ta cÇn biÓu diÔn. Ta 

cã thÓ chØ ®Þnh quan s¸t thiÕt kÕ ®ã khi ta t¹o mét quan s¸t tr×nh diÔn míi. 

 - Ta cã thÓ t¹o ho¹t h×nh cho quan s¸t th¸o, l¾p nh thÕ nµo: 

Sau khi ta th¸o l¾p c¸c thµnh phÇn l¾p r¸p ®Ó t¹o quan s¸t th¸o l¾p, ta cã 

thÓ t¹o tr×nh diÔn sö dông tr×nh tù cña c¸c th¸o l¾p. 

8.2. C¸c tiÖn Ých: 

- Automatic Explode: Tù ®éng th¸o bung c¸c l¾p r¸p vµ c¸c côm l¾p. 

- Tweaks and Trails: ChØnh söa c¸c thao t¸c th¸o l¾p vµ ®êng th¸o l¾p ®Ó 

chØnh l¹i c¸c quan s¸t th¸o l¾p. 

- Animation: Ghi ho¹t h×nh cña c¸c thao t¸c th¸o l¾p. 

8.3. Tr×nh tù lµm viÖc:   

PhÇn nµy sÏ nªu tæng quan cña qu¸ tr×nh t¹o c¸c quan s¸t th¸o vµ c¸c quan 

s¸t l¾p r¸p kh¸c.     

8.3.1. T¹o c¸c quan s¸t tr×nh diÔn: 
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T liÖu tr×nh diÔn cã thÓ chøa nhiÒu quan s¸t cña mét l¾p r¸p. Khi më mét file 

míi ta chän l¾p r¸p ®Ó t¹o quan s¸t tr×nh diÔn ®Çu tiªn. Khi ta t¹o c¸c quan s¸t tr×nh 

diÔn tiÕp theo ta cã thÓ chän c¸c quan s¸t thiÕt kÕ kh¸c cña l¾p r¸p. 

Kh¶ n¨ng chän c¸c quan s¸t thiÕt kÕ kh¸c lµ rÊt m¹nh. VÝ dô, NÕu ta cung cÊp 

t liÖu vÒ c¸c thao t¸c l¾p r¸p mét chiÖc « t«, ta cã thÓ cã mét l¾p r¸p « t« hoµn chØnh 

vµ c¸c phô tïng cña nã. Quan s¸t qu¸ tr×nh th¸o l¾p chóng sÏ cho ta thÊy toµn bé l¾p 

r¸p. Khi ta cung cÊp t liÖu cµi ®Æt hÖ thèng ®iÒu chØnh ®ai, ta cã thÓ t¹o c¸c quan 

s¸t thiÕt kÕ l¾p r¸p trong ®ã Èn ®i c¸c phô tïng. C¸c chi tiÕt th©n van vµ c¸c chi tiÕt 

kh¸c bÞ mê ®i trong quan s¸t. Ta sÏ chän quan s¸t thiÕt kÕ ®ã khi ta t¹o quan s¸t 

tr×nh diÔn ®iÒu chØnh ®ai.  

Ta cã thÓ t¹o c¸c quan s¸t mµ thÓ hiÖn mét c¬ cÊu m¸y trong mét vÞ trÝ nµo 

®ã. VÝ dô, nÕu ta cã mét con R«bèt ®Ó nhÊc vµ ®Æt chi tiÕt, ta sÏ t¹o quan s¸t thÓ hiÖn 

vïng chuyÓn ®éng cña nã.    

- T¹o quan s¸t tr×nh diÔn: 

Trªn thanh c«ng cô chuÈn (Standard) më réng nót New vµ kÝch chuét vµo 

Presentation. Trong thanh c«ng cô cña Presentation kÝch chuét vµo Create View. 

Chän mét file l¾p r¸p vµ mét quan s¸t thiÕt kÕ. Chän chÕ ®é th¸o tù ®éng hoÆc th¸o 

b»ng tay. NÕu ta chän th¸o rêi b»ng tay, ta cã thÓ di chuyÓn mçi phÇn tö tíi vÞ trÝ 

®Þnh tríc. NÕu ta chän th¸o rêi tù ®éng, hÖ thèng th¸o l¾p mçi thµnh phÇn l¾p r¸p 

ra xa thµnh phÇn l¾p r¸p cè ®Þnh theo quan hÖ víi c¸c rµng buéc ®îc g¸n.   
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8.3.2. Thay ®æi c¸c vect¬ quan s¸t: 

Khi t¹o hoÆc më mét quan s¸t tr×nh diÔn, c¸c vÐc t¬ quan s¸t mÆc ®Þnh lµ 

isometric. Ta cã thÓ quay vÐc t¬ quan s¸t t¬ng ®èi theo mét trôc cña hÖ trôc to¹ ®é 

b»ng c¸ch sö dông c«ng cô Precise View Rotation.  Ta cã thÓ ghi vÐc t¬ quan s¸t ®Ó 

sö dông sau nµy. 

 

 

 

 

 

 

 

 

 

 

- Ghi mét vÐc t¬ quan s¸t: 

KÝch chuét ph¶i vµ chän Save Camera. Híng nh×n vµ tû lÖ phãng to thu nhá 

sÏ ®îc ghi.  

 

 

 

 

 

 

 

 

 

 

 

 

 

- Trë l¹i vÐc t¬ quan s¸t ®· ®îc ghi: 

KÝch chuét ph¶i vµo cöa sæ ®å ho¹ vµ chän Restore Camera. Quan s¸t ®Æt l¹i ®Ó 

ghi híng quan s¸t vµ tû lÖ phãng to thu nhá.  
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8.3.3. Th¸o l¾p thµnh phÇn l¾p r¸p: 

Khi ta th¸o l¾p b»ng tay mét thµnh phÇn, ta cã thÓ di chuyÓn nã mét kho¶ng 

c¸ch nhÊt ®Þnh theo mét vec t¬. Ta cã thÓ di chuyÓn thµnh phÇn l¾p r¸p mét vµi lÇn 

®Ó di chuyÓn nã vµo ®óng vÞ trÝ. MÆc dï c¸c chuyÓn dÞch vu«ng gãc theo c¸c trôc, 

nhng ta cã thÓ di chuyÓn theo mét gãc hoÆc quay c¸c thµnh phÇn l¾p r¸p. Mçi thao 

t¸c th¸o l¾p sÏ xuÊt hiÖn mét biÓu tîng trong cöa sæ duyÖt díi thµnh phÇn l¾p r¸p. 

Ta cã thÓ th¸o l¾p mét hoÆc mét vµi thµnh phÇn l¾p r¸p mét lóc. VÝ dô, ta cã thÓ 

th¸o l¾p mét nhãm c¸c chi tiÕt trªn mét hÖ khung sau ®ã th¸o l¾p tõng chi tiÕt riªng. 

Mét quan s¸t th¸o l¾p thêng cã c¸c ®êng th¸o l¾p cña c¸c thµnh phÇn l¾p  r¸p tíi 

thµnh phÇn c¬ së. HÖ thèng sÏ t¹o c¸c ®êng th¸o l¾p khi ta th¸o l¾p thµnh phÇn l¾p 

r¸p. Ta cã thÓ t¾t hiÓn thÞ ®êng th¸o l¾p. Ta còng cã thÓ xo¸ c¸c ®êng th¸o l¾p vµ 

bæ sung c¸c ®êng th¸o l¾p míi. Th¸o l¾p tù ®éng ®îc dïng ®Ó th¸o 4 èng lãt ra 

khái chi tiÕt ®ßn g¸nh nh minh ho¹ díi ®©y.  

- §Ó th¸o l¾p mét chi tiÕt: 

  Trong thanh c«ng cô Presentation kÝch chuét vµo nót Tweak Component. 

Trong vïng ®å ho¹, chän mét híng ®Ó th¸o, sau ®ã chän c¸c thµnh phÇn cÇn th¸o. 

Trong hép tho¹i Tweak Component nhËp vµ x¸c nhËn c¸c tuú chän ®Ó ®Þnh nghÜa  

®êng th¸o l¾p. 

  

 

 

 

 

 

 

 

 

 

 

 

8.3.4. ChØnh söa c¸c thao t¸c th¸o l¾p: 

Ta cã thÓ cÇn  ph¶i ®iÒu chØnh vÞ trÝ cña c¸c thµnh phÇn l¾p r¸p ®· ®îc th¸o ®Ó 

t¹o quan s¸t th¸o l¾p. Ta cã thÓ céng thªm mét ®êng th¸o l¾p míi tíi thµnh phÇn 

l¾p r¸p hoÆc chØnh söa c¸c gi¸ trÞ cña ®êng th¸o l¾p cã s½n. C¸c chi tiÕt cã thÓ ®îc 

bæ sung vµo c¸c ®êng th¸o l¾p cã s½n. Ta cã thÓ chØnh söa c¸c ®êng th¸o l¾p b¼ng 

c¸ch dïng hép tho¹i Tweak Component hoÆc trong cöa sæ duyÖt dïng bé läc Tweak 

View .  
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- ChØnh söa th¸o l¾p tõ hép tho¹i Tweak Component:  

Trong thanh c«ng cô Presentation kÝch chuét vµo nót Tweak Component. Trong 

hép tho¹i Tweak Component kÝch chuét vµo Edit Existing Trail sau ®ã sö dông c¸c 

tuú chän ®Ó ®Þnh nghÜa l¹i c¸c ®êng th¸o l¾p. KÝch chuét vµo nót Apply ®Ó ®Æt l¹i 

c¸c yÕu tè cña ®êng th¸o l¾p. 

- Bæ sung chi tiÕt vµo thao t¸c th¸o l¾p cã s½n:  

Trong thanh c«ng cô cña cöa sæ duyÖt kÝch chuét vµo nót Filter vµ chän Tweak 

View. Trong danh s¸ch cöa sæ duyÖt  kÐo rª mét chi tiÕt tíi vÞ trÝ díi cña ®êng 

th¸o l¾p. 

 

 

 

 

 

 

 

     Nót Filter më réng           ChÌn mét chi tiÕt vµo mét thao t¸c th¸o l¾p cã s½n 

 

8.3.5. ChØnh söa c¸c ®êng m« t¶ th¸o l¾p:  

Sau khi ta th¸o mét thµnh phÇn l¾p r¸p tíi mét vÞ trÝ ta cã thÓ chØnh söa ®êng 

m« t¶ th¸o l¾p ®Ó hoµn thiÖn sù hiÓn thÞ khi m« t¶. Nh khi chØnh söa, xo¸ mét 

®êng m« t¶ th¸o l¾p, còng cã nghÜa lµ chØnh söa hoÆc xo¸ mét thao t¸c th¸o l¾p. 

Khi kÝch chuét vµo mét ®êng m« t¶ th¸o l¾p, mét ®iÓm nót sÏ hiÓn thÞ t¹i cuèi cña 

®êng m« t¶ th¸o l¾p. Khi mét ®o¹n cña ®êng m« t¶ th¸o l¾p ®æi mµu ta cã thÓ kÐo 

rª ®o¹n ®ã ®Õn vÞ trÝ míi. Ta cã thÓ bæ sung hoÆc xo¸ c¸c ®êng m« t¶ th¸o l¾p nÕu 

cÇn thiÕt. 

 

 

 

 

 

 

 

 

 

               ChØnh söa th¸o l¾p                                        Xo¸ th¸o l¾p 

 

 
 

  



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 106 

- ChØnh söa vÞ trÝ ®êng m« t¶ th¸o l¾p:  

KÝch chuét vµo ®êng m« t¶ th¸o l¾p cÇn chØnh söa biÓu tîng chØnh söa sÏ 

®îc hiÓn thÞ. Chän kiÓu biÓu tîng phï hîp ®Ó ®Þnh nghÜa l¹i c¸c gi¸ trÞ cña th¸o 

l¾p. 

- §Æt l¹i mét th¸o l¾p vÒ vÞ trÝ ®Çu:  

Chän mét ®êng m« t¶ th¸o l¾p vµ thu mét trong c¸c thµnh phÇn cña ®êng 

m« t¶ th¸o l¾p vÒ vÞ trÝ  ban ®Çu. Khi th¸o l¾p trë l¹i ®Õn vÞ trÝ cã sai sè x¸c ®Þnh , 

th¸o l¾p sÏ ®îc b¾t dÝnh vÒ vÞ trÝ ®Çu.  

- Èn ®êng m« t¶ th¸o l¾p:  

 KÝch chuét ph¶i vµo th¸o l¾p  trong cöa sæ ®å ho¹ hoÆc cöa sæ duyÖt sau ®ã xo¸ 

Visibility. 

 

 

 

 

 

 

 

 

 

- Xo¸ ®êng m« t¶ th¸o l¾p: 

KÝch chuét ph¶i vµo ®êng m« t¶ th¸o l¾p vµ chän Delete tõ menu ng÷ c¶nh.  

  - Bæ sung mét ®êng m« t¶ th¸o l¾p: 

KÝch chuét ph¶i vµo mét thµnh phÇn l¾p r¸p trong cöa sæ ®å ho¹ hoÆc trong 

cöa sæ duyÖt sau ®ã chän Add Trail. KÝch vµo thµnh phÇn l¾p r¸p vµ chän ®iÓm 

b¾t ®Çu sau ®ã kÝch chuét ph¶i vµ chän Done. HÖ thèng sÏ t¹o mét ®êng m« t¶ 

l¾p r¸p míi song song víi ®êng m« t¶ l¾p r¸p gèc. 
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8.3.6. M« pháng c¸c l¾p r¸p: 

Autodesk Inventor cã thÓ t¹o ho¹t h×nh mét quan s¸t l¾p r¸p dùa trªn tr×nh tù 

l¾p r¸p. Ta cã thÓ chØnh söa tr×nh tù l¾p r¸p ®Ó thay ®æi thø tù hoÆc tËp hîp c¸c l¾p 

r¸p. Ta còng cã thÓ t¹o file AVI hoÆc ho¹t h×nh dïng cho chÕ t¹o, c¸c dÞch vô hoÆc 

c¸c tµi liÖu b¸n hµng.  

- S¾p xÕp c¸c thao t¸c th¸o l¾p liªn tôc cho c¸c ho¹t h×nh: 

KÝch chuét vµo nót Filter trong thanh c«ng cô cña cöa sæ duyÖt sau ®ã chän  

Sequence View. T¹i ®Ønh cña cöa sæ duyÖt c¸c nhiÖm vô cña qu¸ tr×nh th¸o l¾p 

®îc liÖt kª.  Díi mçi nhiÖm vô c¸c thao t¸c th¸o l¾p ®îc liÖt kª trong c¸c c¶nh. Ta 

cã thÓ kÐo rª ®Ó s¾p xÕp l¹i c¸c thao t¸c th¸o l¾p, thay ®æi c¸c c¶nh ®Ó t¹o c¸c ho¹t 

h×nh  kh¸c. 
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                                       Thay ®æi thø tù c¸c c¶nh  

                                      trong qu¸ tr×nh m« pháng 

 

- T¹o ho¹t c¶nh c¸c thao t¸c th¸o l¾p: 

KÝch chuét vµo nót Animation. Hép tho¹i Animation ®îc më. §Æt kho¶ng 

c¸ch gi÷a c¸c bíc vµ sè lÇn lÆp l¹i. KÝch chuét vµo nót(>>) ®Ó chØnh söa tr×nh tù c¸c 

thao t¸c th¸o l¾p. Mçi mét c¶nh trong ho¹t c¶nh chøa ®ùng mét th môc bÞ Èn. §Ó 

Èn mét thµnh phÇn sao cho nã sÏ kh«ng xuÊt hiÖn trong ho¹t h×nh kÐo rª thµnh phÇn 

®ã vµo trong th môc Èn. 

 

 

 

 

 

 

 

 

 

 

 

- Ghi ho¹t h×nh: 

KÝch chuét vµo nót Animation vµ sau ®ã kÝch chuét vµo nót Record nhËp vµo 

tªn file trong hép tho¹i Save as sau ®ã kÝch chuét µo nót Save. Chän ph¬ng ¸n 

nÐn file Video vµ kÝch OK. KÝch chuét vµo Play Forward, Play Reverse hoÆc 

AutoReverse trong hép tho¹i Animation. Autodesk Inventor ghi ra file AVI. 
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8.4. C¸c c«ng cô tr×nh diÔn qu¸ tr×nh th¸o l¾p: 

Trong quan s¸t tr×nh diÔn, nót Filter trong thanh c«ng cô cöa sæ duyÖt cung 

cÊp menu cña c¸c bé läc ®Ó hiÓn thÞ cöa sæ duyªtj, bao gåm Tweak Components vµ 

Tweak Sequences. Thanh c«ng cô Presentation chøa c¸c c«ng cô ®Ó lµm viÖc trong 

quan s¸t tr×nh diÔn. 

 

T

T 

Nót 

lÖnh 
C«ng cô Chøc n¨ng Ghi chó 

1 

 

Create 

Presentation 

View 

T¹o quan s¸t tr×nh diÔn 

míi cña mét qu¸ tr×nh 

th¸o l¾p 

 

2 

 

Tweak 

Component 

Th¸o l¾p c¸c thµnh phÇn 

th¸o l¾p ®Ó t¹o c¸c quan 

s¸t th¸o rêi. 

NhËp vµo gi¸ trÞ 

th¸o l¾p hoÆc 

chän híng vµ 

kÐo rª thµnh phÇn 

th¸o l¾p trong cöa 

sæ ®å ho¹ 

3 

 

Precise View 

Rotation 

Quay vect¬ quan s¸t 

quanh c¸c trôc X,Y,Z  
 

4 

 

Animation T¹o ho¹t h×nh th¸o l¾p  
Ghi ho¹t h×nh 

trong file AVI 
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   MÑo: 

Ta cã thÓ dïng c¸c kü thuËt díi ®©y ®Ó t¹o c¸c t liÖu tr×nh diÔn mét c¸ch nhanh 

h¬n vµ cã hiÖu qu¶ h¬n. 

 

- Sö dông cöa sæ duyÖt ®Ó thay ®æi tËp hîp c¸c lùa chän th¸o l¾p: 

KÝch vµo thµnh phÇn l¾p r¸p trong cöa sæ duyÖt ®Ó bæ sung nã hoÆc xo¸ bá nã 

khái tËp hîp c¸c lùa chän. 

- Sö dông nhãm ®Ó s¾p xÕp l¹i c¸c thao t¸c th¸o l¾p trong hép tho¹i ho¹t h×nh: 

Khi ta ®ang s¾p xÕp mét sè thao t¸c th¸o l¾p, tríc tiªn nhãm chóng l¹i vµ sau 

®ã di chuyÓn chóng víi nhau. 

- Thao t¸c th¸o l¾p c¸c thµnh phÇn l¾p r¸p b»ng c¸ch kÐo rª Direction triad: 

KÐo rª mét mòi tªn trªn Direction triad ®Ó th¸o l¾p theo híng ®ã.     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Hướng dẫn học INVENTOR 

 

Cogioihoa.com Page 111 

CHƯƠNG 10 

LËp b¶n vÏ 

 
B¶n vÏ lµ tµi liÖu ®Ó phæ biÕn c¸c chi tiÕt vµ côm l¾p. Ch¬ng nµy giíi thiÖu c¸c 

c«ng cô t¹o vµ tr×nh tù t¹o lËp b¶n vÏ trong Autodesk Inventor. B¹n cã thÓ t×m c¸c 

th«ng tin h÷u dông h¬n, c¸c vÝ dô cã ho¹t h×nh minh häa vµ híng dÉn tõng bíc 

trong trî gióp trùc tuyÕn vµ Tutorial. 

9.1. Më ®Çu 

Autodesk Inventor liªn kÕt m« h×nh chi tiÕt vµ côm l¾p víi b¶n vÏ. Mäi thay ®æi 

cña m« h×nh sÏ ®îc cËp nhËt vµo b¶n vÏ. Ngîc l¹i, b¹n cã thÓ thay ®æi m« h×nh chi 

tiÕt vµ côm l¾p b»ng c¸ch söa kÝch thíc m« h×nh ngay trong b¶n vÏ. Mèi liªn hÖ 2 

chiÒu nµy ®¶m b¶o cho b¶n vÏ lu«n lu«n ph¶n ¸nh c¸c th«ng sè thiÕt kÕ míi nhÊt cña 

m« h×nh. 

9.1.1. Khi nµo th× cÇn t¹o b¶n vÏ? 

V× Autodesk Inventor duy tr× mèi liªn hÖ 2 chiÒu gi÷a m« h×nh vµ b¶n vÏ nªn 

b¹n cã thÓ lËp b¶n vÏ bÊt cø lóc nµo sau khi cã m« h×nh. Tuy nhiªn, nªn t¹o b¶n vÏ 

sau khi ®· cã m« h×nh hoµn chØnh ®Ó b¹n ®ì mÊt c«ng sang söa c¸c chi tiÕt cña b¶n 

vÏ, nh thªm hoÆc xãa bít kÝch thíc, thay ®æi vÞ trÝ c¸c chó thÝch hay sè hiÖu chi 

tiÕt. 

§«i khi viÖc t¹o nhanh b¶n vÏ 2D cã lîi h¬n mét m« h×nh solid 3D. Autodesk 

Inventor cho phÐp t¹o c¸c ®çi tîng tham sè 2D. Chóng cã thÓ ®îc dïng ®Ó t¹o 

ph¸c th¶o cho m« h×nh 3D. 

9.1.2. Khi nµo th× dïng m«i trêng vÏ? 

M«i trêng vÏ ®îc kÝch ho¹t mçi khi b¹n dïng mét template ®Ó t¹o file .idw. 

B¹n lËp b¶n vÏ ®Ó lu chuyÓn biÓu diÔn mét chi tiÕt cÇn chÕ t¹o. B¹n cã thÓ thay ®æi 

thiÕt kÕ chi tiÕt b»ng c¸ch söa b¶n vÏ hoÆc m« h×nh. Autodesk Inventor sÏ tù ®éng 

cËp nhËt mäi b¶n sao cña chi tiÕt. Mçi khi söa mét chi tiÕt trong m«i trêng vÏ, b¹n 

cÇn kiÓm tra l¹i côm l¾p cã dïng chi tiÕt ®ã xem cã m©u thuÉn trong kÕt cÊu hay 

kh«ng. 

9.1.3. Lµm thÕ nµo ®Ó söa chi tiÕt tõ b¶n vÏ? 

B¹n cã thÓ xem vµ söa kÝch thíc m« h×nh4 tõ trong b¶n vÏ. Autodesk Inventor 

sÏ tù ®éng cËp nhËt kÝch thíc míi cho mäi b¶n sao cña chi tiÕt. NÕu b¹n söa ®æi gi¸ 

                                            
4 KÝch thíc m« h×nh (model dimension) lµ kÝch thíc tham sè, dïng khi t¹o m« h×nh tham sè. 

Nã kh¸c víi kÝch thíc b¶n vÏ (drawing dimension) lµ kÝch thíc tham kh¶o. 
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trÞ kÝch thíc b¶n vÏ th× Autodesk Inventor kh«ng cËp nhËt vµo m« h×nh. Gi¸ trÞ 

danh ®Þnh xuÊt hiÖn trªn b¶n vÏ nhng kh«ng g©y nªn sù thay ®æi h×nh häc. 

9.2. C¸c tiÖn Ých 

Field text NhËp th«ng tin, nh sè hiÖu chi tiÕt, møc truy cËp, vËt liÖu 

trong hép tho¹i Properties. NÕu b¹n thªm mét thÎ field text 

vµo block khung tªn (title block) th× Autodesk Inventor sÏ 

hiÖn text hiÖn t¹i. 

Cursor Cues Con trá thay ®æi h×nh d¹ng ®Ó b¸o hiÖu sù tån t¹i nhiÒu kh¶ 

n¨ng lùa chän theo bèi c¶nh cô thÓ. 

Memory 

Management 

ChØ n¹p vµo bé nhí c¸c trang b¶n vÏ theo yªu cÇu chø kh«ng 

ph¶i tÊt c¶. 

Drawing 

Standard 

Dïng c¸c tiªu chuÈn b¶n vÏ ANSI, BSI, DIN, GB, ISO vµ 

JIS. Còng cã thÓ söa ®æi c¸c tiªu chuÈn ®Ó thÝch øng víi tiªu 

chuÈn riªng cña h·ng. 

Bidirectional 

Associativity 

CËp nhËt b¶n vÏ ®Ó ph¶n ¸nh sù thay ®æi cña m« h×nh. Thay 

®æi m« h×nh tõ m«i trêng vÏ b»ng c¸ch söa kÝch thíc m« 

h×nh. 

General 

Dimension 

Tool  

Dïng ®Ó t¹o kÝch thíc b¶n vÏ mét c¸ch trùc gi¸c. 

Design 

Doctor 

Gióp xö lý sù cè mÊt liªn kÕt cña kÝch thíc vµ chó gi¶i. 

9.3. Tr×nh tù thùc hiÖn 

Sau ®©y lµ híng dÉn chung vÒ t¹o b¶n vÏ. B¹n cã thÓ t×m c¸c th«ng tin h÷u 

dông h¬n, c¸c vÝ dô cã ho¹t h×nh minh häa vµ híng dÉn tõng bíc trong trî gióp 

trùc tuyÕn, Tutorial, Visual Syllabus. 

9.3.1. Khëi t¹o b¶n vÏ míi 

File b¶n vÏ míi sÏ ®îc khëi t¹o khi b¹n chän menu File -> New hoÆc kÝch 

phÝm New trªn thanh c«ng cô Standard, chän Drawing template tõ mét trong c¸c thÎ 

Default, English hoÆc Metric. Default Drawing lµ mét trang giÊy trèng cã viÒn vµ 

khung tªn. B¹n cã thÓ söa ®æi chóng nÕu cÇn. C¸c thÎ English hoÆc Metric chøa c¸c 

b¶n vÏ mÉu theo ®¬n vÞ ®o t¬ng øng. 

9.3.2. C¸ biÖt b¶n vÏ 

Autodesk Inventor cung cÊp c¸c template (b¶n mÉu chuÈn) ®Ó khëi t¹o b¶n vÏ 

míi. B¹n cã thÓ söa ®æi khung viÒn vµ khung tªn cho phï hîp yªu cÇu riªng cña c¬ 

quan m×nh. B¹n còng cã thÓ chØnh söa ®æi tiªu chuÈn biÓu diÔn b¶n vÏ. C¸c chØnh 
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söa c¸ biÖt nªu trªn chØ cã gi¸ trÞ ®èi víi b¶n vÏ hiÖn dïng, trõ khi b¹n ghi chóng vµo 

file template. 

§Ó gäi mét tiªu chuÈn vÏ, chän menu Format -> Standards. Chän tiªu chuÈn 

thÝch hîp trong danh s¸ch c¸c tiªu chuÈn. 

§Ó chØnh söa mét tiªu chuÈn vÏ, chän menu Format -> Standards. KÝch nót 

More ®Ó hiÓn thÞ menu c¸c tïy chän. 

§Ó khëi t¹o mét tiªu chuÈn b¶n vÏ míi, chän menu Format -> Standards. KÝch 

vµo dßng nh¾c "Click to add new Standard" ë cuèi « chän "Select Standard" ®Ó më 

hép tho¹i New Standard vµ ®Þnh nghÜa tiªu chuÈn míi. 

§Ó t¹o khung viÒn, chän menu Format -> Define New Border. Mét líi täa ®é 

hiÖn lªn vµ thanh c«ng cô Sketch ®îc kÝch ho¹t. Sau khi vÏ khung viÒn, chän menu 

Format -> Save Border. Khung viÒn míi ®îc bæ sung vµo th môc Drawing 

Resources trong browser. Mçi khæ giÊy cÇn mét khung viÒn. 

§Ó t¹o khung tªn, chän menu Format -> Define New Title Block. Mét líi täa ®é 

hiÖn lªn vµ thanh c«ng cô Sketch ®îc kÝch ho¹t. Sau khi vÏ khung tªn, chän menu 

Format -> Save Title Block. Khung tªn míi ®îc bæ sung vµo th môc Drawing 

Resources trong browser. Mçi khæ giÊy cÇn mét khung viÒn. 

§Ó söa khung tªn, më réng Drawing Resources vµ th môc Title Blocks trong 

browser. KÝch phÝm ph¶i chuét vµo Title Blocks, chän Edit. Sau khi söa, kÝch phÝm 

ph¶i chuét vµ chän Save Title Block trong menu võa xuÊt hiÖn. C¸c néi dung chØnh 

söa sÏ ®îc ghi vµo template. 

§Ó t¹o mét ký hiÖu, chän menu Format -> Define New Symbol. Mét cöa sæ 

Sketch xuÊt hiÖn. Dïng c«ng cô vÏ ®Ó t¹o ký hiÖu, trong ®ã cã thÓ chøa c¶ c¸c ®èi 

tîng h×nh häc lÉn ch÷. Chän menu Format -> Save Sketch Symbol. §Ó hoµn tÊt c«ng 

viÖc, nhËp tªn cña ký hiÖu trong hép tho¹i. 

§Ó t¹o mét file template, ghi file b¶n vÏ cã chøa c¸c quy ®Þnh riªng vµo th môc 

Autodesk/Inventor4/Templates. File template cã phÇn më réng lµ .idw. Autodesk 

Inventor sÏ nhËn biÕt c¸c file trong th môc nµy lµ template5. 

9.3.3. T¹o c¸c h×nh chiÕu 

Autodesk Inventor cho phÐp t¹o vµ xö lý nhiÒu h×nh chiÕu. Drawing Manager 

cã c¸c c«ng cô hiÖu dông, kÓ c¶ kh¶ n¨ng kÐo, th¶ ®Ó chuyÓn h×nh chiÕu gi÷a c¸c 

trang b¶n vÏ. 

§Ó t¹o mét h×nh chiÕu, kÝch phÝm Create View trªn thanh c«ng cô Drawing 

Management, dïng chøc n¨ng Explore Directories trong hép tho¹i Create View ®Ó t×m 

file m« h×nh chi tiÕt hoÆc côm l¾p cÇn xuÊt ra b¶n vÏ, chän lo¹i h×nh chiÕu trong 

danh s¸ch View vµ x¸c ®Þnh tû lÖ (scale). §a con trá ®Õn vÞ trÝ thÝch hîp trªn giÊy vÏ 

                                            
5 Khi b¹n chän môc Drawing trong menu bu«ng xuèng c¹nh nót New, Autodesk Inventor sÏ 

t×m file cã tªn Standard.idw trong th môc Autodesk/Inventor/Templates. 
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®Ó ®Æt h×nh chiÕu ®Çu tiªn. Muèn hiÖn kÝch thíc m« h×nh trªn h×nh chiÕu th× ®¸nh 

dÊu vµo môc Get Model Dimentions trong phÇn më réng cña hép tho¹i Create View. 

§Ó t¹o mét Design View6, kÝch phÝm Create View trªn thanh c«ng cô Drawing 

Management, chän file l¾p r¸p (.ipm). Chän mét Design View trong danh s¸ch. 

§Ó t¹o mét h×nh chiÕu, kÝch phÝm Projected View. Chän mét h×nh chiÕu vµ di 

chuét. NÕu di chuét theo ph¬ng n»m ngang hay th¼ng ®øng th× sÏ t¹o ®îc mét 

h×nh chiÕu vu«ng gãc. NÕu di theo mét gãc th× t¹o ®îc mét h×nh chiÕu trôc ®o. Mçi 

khi chän ®îc vÞ trÝ võa ý th× nhÊn phÝm tr¸i chuét ®Ó x¸c nhËn. Sau khi ®Æt ®ñ h×nh 

chiÕu cÇn thiÕt th× nhÊn phÝm ph¶i, chän Create trong menu. 

§Ó t¹o mét h×nh chiÕu phô: V× h×nh chiÕu phô ®îc t¹o tõ mét h×nh chiÕu chÝnh 

nªn tríc hÕt ph¶i t¹o ra h×nh chiÕu chÝnh. KÝch phÝm Auxiliary View trªn thanh 

c«ng cô Drawing Management. Trong hép tho¹i Auxiliary View, nhËp tªn (label), tû lÖ 

cho h×nh chiÕu nhng cha nhÊn OK. Chän mét ®êng th¼ng trªn h×nh chiÕu chÝnh, 

di chuét theo ph¬ng song song hoÆc vu«ng gãc víi ®êng th¼ng ®Ó ®Þnh vÞ h×nh 

chiÕu phô, sau ®ã nhÊn phÝm tr¸i chuét ®Ó kÕt thóc lÖnh. 

§Ó t¹o mét h×nh c¾t, chän Section View, chän mét h×nh chiÕu vµ vÏ trªn ®ã mét 

®êng c¾t. Khi vÏ xong, nhÊn phÝm ph¶i ®Ó hiÖn menu vµ chän Continue. NhËp tªn 

(Label) vµ tû lÖ trong hép tho¹i Section View. Di con trá theo ph¬ng chiÕu ®Ó chän 

vÞ trÝ vµ nhÊn phÝm tr¸i chuét. Autodesk Inventor tù ®éng ghi nh·n cho ®êng c¾t, 

g¹ch mÆt c¾t vµ ghi nh·n cho h×nh c¾t. 

§Ó t¹o mét h×nh chiÕu riªng phÇn, chän Detail View, chän mét h×nh chiÕu lµm 

h×nh chiÕu chÝnh. Mét hép tho¹i xuÊt hiÖn ®Ó nhËp nh·n (Label), tû lÖ (Scale) vµ kiÓu 

(Style) vïng chiÕu. KiÓu mÆc ®Þnh lµ vßng trßn. NÕu muèn dïng khiÓu ch÷ nhËt th× 

kÝch phÝm ph¶i vµ chän Rectangular Fence. NhÊn chuét ®Ó chän vÞ trÝ t©m vßng trßn, 

xong di chuét ®Ó x¸c ®Þnh kÝch thíc. Chän vÞ trÝ ®Æt h×nh chiÕu. H×nh chiÕu vµ vïng 

chän ®îc tù ®éng t¹o ra vµ g¾n nh·n. 

§Ó t¹o mét Draft View7, chän Draft View. NhËp nh·n vµ tû lÖ, xong nhÊn OK. 

M«i trêng vÏ ®îc kÝch ho¹t, cho phÐp vÏ thªm c¸c ®èi tîng. Sau khi hoµn tÊt, cã 

thÓ copy vµ d¸n lªn b¶n vÏ hiÖn thêi hoÆc lªn b¶n vÏ kh¸c. 

9.3.4. Quay h×nh chiÕu 

B¹n cã thÓ quay h×nh chiÕu theo c¹nh hay theo gãc. Khi quay h×nh chiÕu, quan 

hÖ h×nh häc gi÷a c¸c ®èi tîng trªn ®ã ®îc duy tr×. Tïy theo tiªu chuÈn hiÖn dïng, 

Autodesk Inventor cã thÓ bæ sung th«ng tin ®Ó ghi chó r»ng h×nh chiÕu ®· ®îc quay 

khái vÞ trÝ bi b×nh thêng cña nã. 

                                            
6 Design View: Mét lo¹i h×nh chiÕu trong b¶n vÏ l¾p, cho phÐp Èn hay hiÖn, cã mÆt hay kh«ng 

cña c¸c bé phËn, gióp cho viÖc xö lý c¸c m« h×nh l¾p r¸p lín ®îc thuËn tiÖn. 
7 Draft View: Mét lo¹i h×nh chiÕu ®îc t¹o ra b»ng c«ng cô vÏ ®Ó bæ sung vµo b¶n vÏ. 
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§Ó quay h×nh chiÕu, chän h×nh chiÕu cÇn quay, xong nhÊn phÝm ph¶i vµ chän 

Rotate View trong menu võa hiÖn ra. Chän ph¬ng ph¸p quay theo c¹nh hay theo 

gãc, nhËp c¸c th«ng tin cÇn thiÕt. NhÊn OK ®Ó cËp nhËt h×nh chiÕu8. 

9.3.5. Thªm tê giÊy vÏ 

Mét file b¶n vÏ (Drawing) cã thÓ chøa nhiÒu tê giÊy vÏ (Sheet)9. B¹n cã thÓ thªm 

mét hay nhiÒu tê giÊy vÏ vµo file. T¹i mçi thêi ®iÓm chØ cã mét tê giÊy vÏ ho¹t ®éng, 

nghÜa lµ cã thÓ ®iÒu khiÓn ®îc. C¸c tê giÊy vÏ kh¸c kh«ng ho¹t ®éng vµ bÞ b«i x¸m. 

Th môc Drawing Resources lu«n lu«n ho¹t ®éng. 

§Ó thªm mét tê giÊy vÏ, kÝch phÝm New Sheet trªn thanh c«ng cô Drawing 

Management. 

§Ó t¹o mét tê giÊy vÏ víi d¹ng ®Æc biÖt, më réng Drawing Resources -> Sheet 

Formats trong Browser. KÝch ph¶i vµo mét trong nh÷ng Sheet Format vµ chän New 

Sheet. Dïng Drawing Resources ®Ó chÌn khung viÒn vµ khung tªn. 

§Ó kÝch ho¹t mét tê giÊy vÏ, kÝch ®óp vµo tªn nã trong Browser. Tê giÊy vÏ ®ã 

®îc kÝch ho¹t, c¸c tê kh¸c bÞ mê ®i. 

§Ó chuyÓn mét h×nh chiÕu gi÷a c¸c tê giÊy vÏ, kÝch ho¹t tê giÊy vÏ nguån (chøa 

h×nh chiÕu cÇn chuyÓn ®i). Chän tªn hoÆc biÓu tîng h×nh chiÕu, kÐo nã sang tê ®Ých. 

Con trá ph¶i hiÖn trªn tªn hoÆc biÓu tîng cña tê ®Ých míi th¶ h×nh chiÕu vµo ®îc. 

§Ó copy mét h×nh chiÕu sang tê giÊy vÏ kh¸c, kÝch ho¹t tê giÊy vÏ nguån (chøa 

h×nh chiÕu cÇn chuyÓn ®i). KÝch ph¶i tªn hoÆc biÓu tîng h×nh chiÕu, chän Copy 

trong menu. KÝch ph¶i tªn hoÆc biÓu tîng cña tê ®Ých, chän Past trong menu. Tê 

giÊy ®Ých sÏ tù kÝch ho¹t vµ b¹n sÏ thÊy h×nh chiÕu xuÊt hiÖn trªn ®ã. 

9.3.6. Sö dông kÝch thíc m« h×nh 

B¹n cã thÓ cho hiÖn kÝch thíc m« h×nh trong b¶n vÏ. ChØ kÝch thíc nµo song 

song víi mÆt ph¼ng chiÕu míi ®îc hiÖn lªn. NÕu b¹n cµi ®Æt Autodesk Inventor víi 

tïy chän, cho phÐp söa ®æi m« h×nh tõ trong b¶n vÏ th× b¹n cã thÓ söa m« h×nh b»ng 

c¸ch söa kÝch thíc m« h×nh trong b¶n vÏ. B¹n cã thÓ thay ®æi kiÓu kÝch thíc m« 

h×nh nh víi kÝch thíc b¶n vÏ. 

§Ó hiÖn kÝch thíc m« h×nh trong b¶n vÏ, kÝch ph¶i mét h×nh chiÕu vµ chän Get 

Model Dimensions trong menu võa hiÖn lªn. C¸c kÝch thíc m« h×nh song song víi 

mÆt ph¼ng chiÕu sÏ hiÖn lªn trong h×nh chiÕu10. 

                                            
8 Sau khi quay h×nh chiÕu, nÕu cã ®êng c¾t cña h×nh c¾t nµo ®ã kh«ng ®îc cËp nhËt th× cã 

thÓ edit nã nh víi sketch th«ng thêng, kÓ c¶ c¸c rµng buéc. 
9 Trong c¸c tµi liÖu tiÕng ViÖt thêng dïng thuËt ng÷ "b¶n vÏ" ®Ó chØ Drawing, "tê giÊy vÏ" 

®Ó chØ Sheet, "trang" ®Ó chØ Page. Tuy nhiªn "tê giÊy vÏ" ë ®©y kh«ng ph¶i tê giÊy thËt khi in. 
10 NÕu ®¸nh dÊu môc Get Model Dimensions trong hép tho¹i Create View th× sau khi t¹o h×nh 

chiÕu, c¸c kÝch thíc m« h×nh sÏ tù hiÖn ra. 
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§Ó xãa kÝch thíc m« h×nh khái h×nh chiÕu, kÝch ph¶i lªn kÝch thíc cÇn xãa råi 

chän Delete trong menu võa hiÖn lªn. 

§Ó chuyÓn kÝch thíc m« h×nh sang h×nh chiÕu kh¸c, xãa kÝch thíc trong h×nh 

chiÕu nguån, xong kÝch ph¶i lªn h×nh chiÕu ®Ých vµ chän Get Model Dimensions trong 

menu võa hiÖn lªn. 

§Ó söa mét kÝch thíc m« h×nh, kÝch ph¶i lªn kÝch thíc cÇn söa, chän Edit 

Model Dimension trong menu võa hiÖn lªn. NhËp gi¸ trÞ míi vµo hép tho¹i Edit 

Dimension, xong kÝch vµo dÊu check ®Ó thùc hiÖn. 

9.3.7. T¹o kÝch thíc trong b¶n vÏ 

Muèn ghi kÝch thíc b¶n vÏ ph¶i chuyÓn sang m«i trêng Drawing Annotation. 

Mäi thñ tôc ghi kÝch thíc vÒ c¬ b¶n gièng nh trong m«i trêng thiÕt kÕ. Khi b¹n 

chän mét ®èi tîng hay c¸c ®èi tîng quan hÖ th× Autodesk Inventor sÏ t¹o kÝch 

thíc n»m ngang, th¼ng ®øng, hoÆc nghiªng tïy theo ph¬ng di chuyÓn con trá. ChÕ 

®é Snap gióp ph©n bè c¸c kÝch thíc theo tiªu chuÈn. Cã thÓ ®iÒu khiÓn sù hiÓn thÞ 

kÝch thíc theo c¸c kiÓu kh¸c nhau. 

§Ó t¹o kÝch thíc míi, chän c«ng cô General Diminsion. Chän ®èi tîng vµ di 

chuét ®Ó t¹o kÝch thíc. Khi chuyÓn con trá, t¹i mçi vÞ trÝ phï hîp víi kho¶ng c¸ch 

(Offset) quy ®Þnh th× ®êng kÝch thíc vµ ®êng giãng chuyÓn tõ nÐt liÒn sang nÐt 

®øt, gîi ý ngêi dïng chän vÞ trÝ ®Æt ®êng kÝch thíc. 

§Ó giãng mét kÝch thíc míi theo kÝch thíc cã tríc, gi÷ phÝm chuét, di con 

trá qua kÝch thíc cã tríc th× dÊu Snap hiÖn lªn khi hai kÝch thíc ®· ®îc giãng 

víi nhau. 

9.3.8. Thay ®æi kÝch thíc 

Autodesk Inventor cho phÐp thay ®æi kiÓu dung sai, gi¸ trÞ danh ®Þnh, dung sai 

vµ l¾p ghÐp. Khi chän kiÓu dung sai, b¹n cã thÓ xem tríc kÝch thíc víi kiÓu ghi 

dung sai míi. 

§Ó thay ®æi kÝch thíc, kÝch ®óp lªn kÝch thíc cÇn söa ®Ó më hép tho¹i 

Dimension Tolerance. NhËp gi¸ trÞ danh ®Þnh míi vµ x¸c ®Þnh cÊp chÝnh x¸c11. 

§Ó thay ®æi kiÓu mòi tªn, chän kÝch thíc, di con trá lªn mét trong c¸c mòi tªn, 

kÝch ®óp ®Ó më hép tho¹i Change Arrowhead vµ chän kiÓu mòi tªn trong danh s¸ch. 

9.3.9. Ghi chó trong b¶n vÏ 

Autodesk Inventor cung cÊp ®ñ c¸c lo¹i ký hiÖu ghi trªn b¶n vÏ phï hîp víi 

tiªu chuÈn hiÖn dïng. Ngoµi ra, khi cÇn vÉn cã thÓ t¹o c¸c ký hiÖu theo môc ®Ých 

riªng. 

                                            
11 Khi thay ®æi gi¸ trÞ danh ®Þnh cña kÝch thíc m« h×nh hay kÝch thíc b¶n vÏ th× Autodesk 

Inventor thay ®æi gi¸ trÞ trªn b¶n vÏ nhng kh«ng cËp nhËt vµo m« h×nh chi tiÕt hoÆc côm l¾p. 
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§Ó hiÖn thanh c«ng cô Drawing Annotation, chän menu View -> Toolbar  -> 

Drawing Annotation hoÆc më réng Panel Drawing Management vµ chän Drawing 

Annotation. 

§Ó t¹o mét chó thÝch, chän phÝm Text hoÆc Leader Text. Chän vÞ trÝ ®Æt chó thÝch 

trong vïng vÏ vµ nhËp néi dung cña nã. C«ng cô text cña Autodesk Inventor dïng bé 

xö lý ký tù ®¬n gi¶n nªn b¹n cã thÓ ®Þnh d¹ng text, nh font, bold, c¸c ký tù ®Æc biÖt. 

Leader text ®îc g¾n lªn ®èi tîng h×nh häc vµ sÏ di chuyÓn theo h×nh chiÕu. 

§Ó t¹o mét ký hiÖu, chän ký hiÖu cÇn thiÕt trong menu. Chän ®èi tîng h×nh 

häc cÇn g¾n ký hiÖu, kÝch chuét ®Ó t¹o leader. KÝch ph¶i vµ chän Continue ®Ó hiÖn 

hép tho¹i vµ ®iÒn c¸c th«ng sè cÇn thiÕt cho ký hiÖu. 

§Ó t¹o dÊu t©m, chän phÝm Center Mark trªn thanh c«ng cô Drawing 

Annotation. Chän cung trßn hay vßng trßn, dÊu t©m ®îc tù ®éng t¹o ra. 

§Ó t¹o ®êng t©m hay ®êng ®èi xøng, kÝch mòi tªn bªn c¹nh phÝm Center 

Mark, chän Center Line. Autodesk Inventor cung cÊp 3 kiÓu ghi ®êng t©m: theo 

ph©n gi¸c (Center Line Bisector), theo chuçi vßng trßn (Centered Pattern) vµ theo 2 

®iÓm (Center Line). Chän kiÓu ghi thÝch hîp råi chän ®èi tîng ®Ó ghi. §èi víi kiÓu 

Centered Pattern, sau khi chän kiÓu ghi ph¶i chän t©m chung cña chuçi, sau ®ã chän 

mçi vßng trßn trong d·y mét lÇn, nhÊn ph¶i chuét, chän Create. §Õn ®©y, vßng trßn 

t©m cha kÝn. Ph¶i kÕt thóc lÖnh, sau ®ã kÐo ®iÓm cuèi vßng trßn ®Õn ®iÓm ®Çu ®Ó 

®ãng kÝn vßng trßn. 

9.3.10. T¹o danh môc chi tiÕt 

Trong Autodesk Inventor, b¹n cã thÓ t¹o danh môc chi tiÕt trong côm l¾p. 

Trong d÷ liÖu cã chøa tÝnh chÊt chñ yÕu cña c¸c chi tiÕt, nh sè hiÖu, tªn, vËt liÖu, sè 

lîng,... B¹n cã thÓ x¸c ®Þnh th«ng sè nµo cÇn ®a vµo danh môc. 

§Ó t¹o danh môc, nhÊn phÝm Parts List, sau ®ã chän mét h×nh chiÕu ®Ó chän 

côm l¾p. Trong hép tho¹i Parts List - Item Numburing, cã thÓ cho hiÖn toµn bé chi 

tiÕt (All) hay mét sè (Items) trong danh môc. Khi chän Items, b¹n ph¶i chän tõng chi 

tiÕt trong h×nh chiÕu. Sè hiÖu c¸c chi tiÕt ®îc chän sÏ hiÖn lªn khung trong hép 

tho¹i. Xong nhÊn OK ®Ó kÕt thóc vµ x¸c ®Þnh vÞ trÝ ®Æt b¶n danh môc. 

§Ó söa danh môc, kÝch ®óp vµo ®ã (hoÆc kÝch ph¶i råi chän Edit Parts List 

trong menu) ®Ó më hép tho¹i Edit Parts List. Cã thÓ thªm bít c¸c cét (Column 

Chooser), s¾p xÕp (Sort), xuÊt d÷ liÖu (Export) ra c¸c form kh¸c nhau, nh Exel, 

Access, dBASE, file Text12,... 

§Ó ®¸nh sè chi tiÕt, kÝch vµo phÝm Balloon (®Ó ®¸nh sè tõng chi tiÕt) hoÆc 

Balloon All (®Ó tù ®éng ®¸nh sè toµn bé). Khi ®¸nh sè tõng chi tiÕt, tríc hÕt chän 

®iÓm ®Çu (lµ mét ®iÓm trªn chi tiÕt), råi ®iÓm cuèi ®Ó ®Æt qu¶ bãng. 

                                            
12 Cã thÓ ®Æt Font tiÕng viÖt: Format -> Standard (më hép tho¹i Drafting Standards) -> 

Common -> Text. 
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9.3.11. VÏ thªm vµo b¶n vÏ 

B¹n cã thÓ dïng chøc n¨ng Sketch Overlay ®Ó vÏ thªm ®èi tîng h×nh häc, text 

vµo b¶n vÏ mµ kh«ng g©y ¶nh hëng ®Õn c¸c h×nh chiÕu. Muèn vËy, nhÊn phÝm 

Sketch Overlay. Líi Sketch xuÊt hiÖn vµ thanh c«ng cô Sketch ®îc kÝch ho¹t, cho 

phÐp vÏ nh b×nh thêng. 

9.3.12. In b¶n vÏ 

Drawing Manager cña Autodesk Inventor sö dông hép tho¹i ®iÒu khiÓn m¸y in 

vµ m¸y vÏ t¬ng tù c¸c ch¬ng tr×nh øng dông kh¸c cña Windows. B¹n cã thÓ chän 

m¸y in, tû lÖ, sè b¶n in, hoÆc chän tê ®Ó in. 

Muèn in, chän menu File -> Print (hoÆc nhÊn CTRL + P). X¸c ®Þnh vïng in, tû 

lÖ, sè b¶n in,... Cã thÓ chän c¸c tê (Sheet) ®Ó kh«ng in. KÝch ph¶i vµo Sheet trong 

Browser, chän Edit Sheet trong menu -> chän Exclude Sheet from Printing. 

9.4. Bé c«ng cô vÏ 

Bé c«ng cô vÏ gåm c¸c thanh c«ng cô Drawing Management (Qu¶n lý b¶n vÏ), 

Drawing Annotation (Chó gi¶i) vµ Sketch (vÏ). 

9.4.1. Thanh c«ng cô Drawing Management 

Thanh nµy chøa c¸c c«ng cô t¹o c¸c h×nh chiÕu vµ thªm tê giÊy vÏ míi. 

Drawing Management 

PhÝm Tªn C«ng dông Ghi chó 

 
Create View Liªn kÕt mét m« h×nh chi tiÕt 

víi b¶n vÏ vµ t¹o h×nh chiÕu 

®Çu tiªn 

 

 
Projected View T¹o mét h×nh chiÕu vu«ng gãc  

 
Auxiliary View T¹o h×nh chiÕu phô Chän mét c¹nh 

lµm ph¬ng 

chiÕu 

 
Section View T¹o h×nh c¾t VÏ vÕt c¾t 

 
Detail View T¹o h×nh chiÕu riªng phÇn  

 
New Sheet Thªm tê giÊy vÏ  

 
Draft View T¹o Draft View  
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9.4.2. Thanh c«ng cô Drawing Annotation 

 Thanh nµy chøa c¸c c«ng cô ®Ó ®iÒn kÝch thíc, ký hiÖu, sè hiÖu chi tiÕt vµ 

danh môc chi tiÕt. 

Drawing Annotation 

PhÝm Tªn C«ng dông Ghi chó 

 
General 

Dimension 

Ghi kÝch thíc gi÷a 2 ®iÓm, 

®êng th¼ng hoÆc ®êng cong 

KÝch ®óp lªn 

kÝch thíc ®Ó 

chän kiÓu ghi 

dung sai vµ cÊp 

chÝnh x¸c 

 
Ordinate 

Dimension 

Ghi kÝch thíc theo täa ®é  

 
Hole/Thread 

Notes 

Ghi chó lç, ren víi ®êng dÉn ChØ cã gi¸ trÞ víi 

lç ®îc t¹o bëi 

c«ng cô Hole 

trong Parts 

 
Center Mark T¹o dÊu t©m  

 
 T¹o ®êng t©m  

 
 T¹o ph©n gi¸c cña gãc  

 
 T¹o ®êng t©m cho chuçi 

®êng trßn 

 

 
Surface 

Texture 

Symbol 

Ghi ký hiÖu ®é nh¸m bÒ mÆt  

 
Weld Symbol Ghi ký hiÖu mèi hµn  

 
Feature 

Control Frame 

Ghi ký hiÖu dung sai h×nh häc  

 
Feature 

Identifier 

Symbol 

Ghi ký hiÖu x¸c ®Þnh ®èi tîng Tiªu chuÈn 

ANSI kh«ng cã 

 
Datum 

Identifier 

Symbol 

Ghi ký hiÖu ®èi tîng c¬ së  
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Datum Targets ChØ ®èi tîng c¬ së b»ng 

®êng dÉn 

 

 
 ChØ ®èi tîng c¬ së b»ng 

®êng th¼ng 

 

 
 ChØ ®èi tîng c¬ së b»ng 

®êng vïng ch÷ nhËt 

 

 
 ChØ ®èi tîng c¬ së b»ng h×nh 

trßn 

 

 
 ChØ ®èi tîng c¬ së b»ng mét 

®iÓm 

 

 
Text T¹o khèi ch÷  

 
Leader Text T¹o ch÷ víi ®êng dÉn  

 
Balloon Ghi sè hiÖu chi tiÕt Autodesk 

Inventor tù x¸c 

®Þnh sè hiÖu chi 

tiÕt 

 
Balloon All Tù ®éng ghi sè hiÖu cho tÊt c¶ 

chi tiÕt trong côm l¾p 

 

 
Parts List T¹o b¶ng danh môc chi tiÕt  

 

 9.4.3. Thanh c«ng cô Sketch 

Sketch 

PhÝm Tªn C«ng dông Ghi chó 

 
Property Field T¹o « ®Ó hiÖn text tõ menu 

properties hoÆc text nhËp tõ 

bµn phÝm 

Chän nguån d÷ 

liÖu text. ChØ 

®Þnh d¹ng text 

trong khung tªn 

 
Text NhËp text §Þnh d¹ng text 

 
Line T¹o ®o¹n th¼ng Chän Linetype 

tõ menu style 

 
Spline T¹o Spline  

 
Circle T¹o vßng trßn víi t©m vµ b¸n 

kÝnh 

Chän Linetype 

tõ menu style 
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 T¹o vßng trßn tiÕp xóc víi 3 

®êng th¼ng vµ cung trßn 

 

 
 T¹o ellipse  

 
Arc T¹o cung trßn qua 3 ®iÓm  

 
 T¹o cung trßn víi t©m vµ 2 

®iÓm ®Çu 

Chän Linetype 

tõ menu style 

 
 T¹o cung trßn tiÕp xóc víi 

®êng th¼ng vµ ®êng cong ë 

2 ®Çu 

 

 
Rectangle T¹o h×nh ch÷ nhËt víi c¸c 

®iÓm trªn ®êng chÐo 

Chän Linetype 

tõ menu style 

 
 T¹o ch÷ nhËt víi 3 ®iÓm trªn 

c¸c ®êng vu«ng gãc 

 

 
Fillet Vª gãc víi b¸n kÝnh vµ 2 

®êng th¼ng hoÆc ®êng cong 

NhËp b¸n kÝnh 

trong hép tho¹i 

 
Chamfer T¹o mÐp v¸t hoÆc c¹nh g·y  

 
Point, Hole 

Center 

T¹o ®iÓm  

 
Mirror T¹o h×nh ®èi xøng c¸c ®èi 

tîng 

LÊy ®èi xøng ®èi 

tîng sketch 

qua ®êng t©m 

 
Offset T¹o ®êng th¼ng hoÆc ®êng 

cong song song theo kho¶ng 

c¸ch x¸c ®Þnh 

 

 
General 

Dimension 

Ghi kÝch thíc cho ®èi tîng 

sketch 

 

 
Auto 

Dimension 

Tù ®éng ghi kÝch thíc c¸c ®èi 

tîng 

 

 
Extend KÐo dµi c¸c ®êng tíi mét 

®êng x¸c ®Þnh 

 

 
Trim XÐn ®êng th¼ng hoÆc ®êng 

cong 

Gi÷ phÝm 

SHIFT bËt t¹m 

thêi chøc n¨ng 

trim; NhÊn 

phÝm ph¶i, chän 

TRIM ®Ó gäi 
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chøc n¨ng trim 

 
Move ChuyÓn chç c¸c ®èi tîng  

 
Rotate Quay ®èi tîng  

 
Add Constraint Buéc 2 ®êng vu«ng gãc víi 

nhau 

 

 
 Buéc mét ®êng th¼ng tiÕp 

xóc víi mét ®êng cong 

 

 
 Buéc 2 ®êng trßn ®ång t©m 

nhau 

 

 
 Buéc mét ®êng th¼ng n»m 

ngang; dãng c¸c ®iÓm 

 

 
 Buéc 2 ®o¹n th¼ng hoÆc 2 b¸n 

kÝnh b»ng nhau 

 

 
 Buéc 2 ®êng th¼ng song song 

víi nhau 

 

 
 Buéc c¸c ®iÓm, ®êng trïng 

nhau 

 

 
 Buéc 2 ®êng th¼ng trïng 

nhau 

 

 
 Buéc ®êng th¼ng dùng ®øng; 

dãng c¸c ®iÓm 

 

 
 Buéc ®iÓm, ®êng, ®êng cong 

cè ®Þnh so víi hÖ täa ®é sketch 

 

 
Show/Delete 

Constraint 

HiÖn c¸c rµng buéc Muèn xãa, di 

chuét lªn ký 

hiÖu vµ nhÊn 

DELETE 

 
Fill/Hatch 

Sketch Region 

T« hoÆc g¹ch mÆt c¾t c¸c vïng 

trong b¶n vÏ 

Dïng ®Ó hiÓn thÞ 

mÆt giao nhau 

 
Insert 

AutoCAD File 
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9.5. MÑo 

 Dïng b¶n vÏ mÉu 

NÕu b¹n t¹o mét h×nh chiÕu trong b¶n vÏ mÉu (Drawing Template), Autodesk 

Inventor sÏ nh¾c b¹n t×m file m« h×nh cÇn sö dông. Sau ®ã, nã sÏ tù ®éng ®a m« 

h×nh vµo b¶n vÏ. 

 Dïng läc 

Cïng víi Edge, Feature, Part Filter b¹n cã thÓ chän c¸c ®èi tîng kh¸c nhau 

cho Select Filter. 

 §Þnh d¹ng chung cña b¶n vÏ override ®¬n vÞ ®o 

NÕu c¸c bé phËn trong côm l¾p dïng ®¬n vÞ ®o kh¸c nhau th× ®Þnh d¹ng chung 

cña b¶n vÏ sÏ override chóng. C¸c kÝch thíc m« h×nh sÏ trïng víi ®¬n vÞ trong m«i 

trêng vÏ. 

 T¹o h×nh chiÕu trong c¸c tê kh¸c nhau 

Khi b¹n t¹o h×nh chiÕu míi, chän h×nh chiÕu mÑ, xong nhÊn phÝm New Sheet ®Ó 

më tê vÏ míi. H×nh chiÕu ®îc xem tríc ®Ó dêi chç. 

 T¹o c¸c h×nh c¾t kh«ng dãng 

NhÊn vµ gi÷ phÝm CTRL khi ®Æt h×nh c¾t sÏ lµm mÊt quan hÖ dãng víi h×nh 

chiÕu mÑ. 

 ChuyÓn h×nh chiÕu gi÷a c¸c tê vÏ 

Nh¾p lªn tªn h×nh chiÕu vµ kÐo nã sang tê kh¸c. Ph¶i di con trá lªn tªn tê ®Ých 

míi th¶ ra. 

 Copy h×nh chiÕu hoÆc tê vÏ sang b¶n vÏ kh¸c 

NhÊp phÝm ph¶i lªn h×nh chiÕu hoÆc tê vÏ vµ chän Copy, xong d¸n (past) nã vµo 

b¶n vÏ kh¸c. 

 §¸nh dÊu b¶n vÏ 

Dïng chøc n¨ng Sketch Overlay ®Ó ®¸nh dÊu b¶n vÏ mµ kh«ng g©y ¶nh hëng 

®Õn h×nh chiÕu vµ chó gi¶i. 

 Xem cÊu tróc m« h×nh côm l¾p 

NhÊp phÝm ph¶i lªn h×nh chiÕu vµ chän Show Contents. CÊu tróc côm l¾p xuÊt 

hiÖn trong cöa sæ Browser, bªn díi cÊu tróc tê vÏ. Muèn Èn nã ®i, nhÊp ph¶i vµ 

chän Hide Contents. 

 


